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What’s New in Woodlot 4  
Woodlot for Windows (Woodlot) is a timber supply analysis software program used for woodlots 
and small woodlands in BC.   

Woodlot 4 was developed in 2013 as a reprogramming project utilizing the best features of 
Woodlot 3.2.  It provides an updated interface and programming language, adds important 
timber supply modeling upgrades and provides for future expansion.  Since then the following 
updates have been made: 

 Updated to Woodlot 4.1 in March 2014.  Powerful new analysis features were added in 
the Polygon View, Tabular View, Map View, as well as general enhancements and the 
User Guide update in response to needs identified by Ministry staff and woodlot owners.   

 Updated to Woodlot 4.2 in March 2016.  The update added the latest versions of TIPSY 
and VDYP7 yield functions, updated graphing features, provided a new shapefile import 
feature and provided general improvements to other features in the software. 

 Updated to Woodlot 4.3 in July 2018.  Updates included updating Growth and Yield 
models, Column filtering, LRSY and MAI displayed on the Calculate AAC panel, 
improvements on setting project default parameters, adding more graphs, updating the 
report, map features and other improvements.  Refer to the “What’s New? Woodlot for 
Windows 4.3” included in the Help menu. 

 Updated to Woodlot 4.4 in April 2019.  Updates included adding more report screen 
toggles in the Harvest Schedule heading, updates to Shapefile importing, updates to the 
Map toolbar, updates for Stands vs Resultants and other improvements.  Refer to the 
“What’s New? Woodlot for Windows 4.4” included in the Help menu. 

The objectives in developing Woodlot 4 were to: 

 Update the software platform to run on current Windows based operating systems and to 
take advantage of current technology used in timber supply. 

 Incorporate VDYP7 and TIPSY 4.3, the latest timber growth and yield functions. 

 Provide usability upgrades identified in a 2012 study (e.g. remove area and polygon 
limits, import custom yield tables, partial cutting methods, etc.) 

 Maintain the general workflow, concepts and interface as much as possible; not a “re-think”. 

 Allow for upgrades to meet future needs (e.g. mapping). 

Refer to Appendix 9 “Woodlot for Windows What’s New” for a synopsis of updates.  Some new 
or improved features of Woodlot 4 include: 

 Runs on Windows 7 & 8 operating systems; compatible with Windows XP.  Woodlot 4 is 
programmed in VB.Net and compatible with framework 4.0. 

 Removed upper limits for number of polygons and maximum area. 

 Incorporates VDYP7 and TIPSY 4.3. 

 Updated interface, navigating with tabs. 

 Import Woodlot 3.2 “. lot” files. 

 Import VRI data and shp files directly. 

 Project tab, which is now used to adjust default values. 

 Polygon View tab, which is an updated version of Polygon Data. 

 Users can sort polygons. 
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 New Map View (partially interactive) tab to display a map if the user imports a shp file. 

 Uses VRI data or FIP data. 

 Partial cutting: scoped out new method (multi-age) + current method (lowered even age). 

 Import custom yield tables. 

 Improved harvest sort order; improved constraints; improved harvest flow calculations. 

 Graphing upgraded to use FLNROD’s “Plotsy”, which provides expanded features. 

 Updated Woodlot Harvest Report. 

 New User Guide. 
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1. Introduction 

Woodlot for Windows (Woodlot) is a timber supply software program used to calculate harvest 
rates on Woodlot Licences in BC’s Woodlot Licence Program.  For industry users, the software 
and user guide are available at no charge from the Ministry of Forests, Lands and Natural 
Resource Operations (FLNROD) website.  For Ministry staff, the software is no longer available 
on a Citrix server. 

Woodlot was originally developed in 1996 and has undergone a number of updates since then.  
The previous update of Woodlot, Version 3.2, was created in 2007. 

Woodlot 4 was developed and released in August 2013.  FLNROD and Federation of BC 
Woodlot Associations (Federation) undertook the project jointly.  The objectives in developing 
Woodlot 4 were to ensure it would meet current and anticipated timber supply needs on 
woodlots, to run on current operating systems, and to take advantage of the latest inventory and 
timber supply technology.  The project included reprogramming Woodlot using a newer 
programming language (VB.Net) to avoid software redundancy issues. 

Woodlot 4 was updated to Woodlot version 4.1 in March 2014 and to Woodlot version 4.2 in 
March 2016, Woodlot version 4.3 in July 2018 and Woodlot version 4.4 in April 2019.  Updates 
added powerful new analysis features in the Polygon View, Tabular View, Map View, as well as 
general enhancements and the User Guide update in response to needs identified by Ministry 
staff and woodlot owners. 

All information, timber growth and yields, mapping conventions and formats are applicable to 
forests in British Columbia, Canada. 

This user guide is organized as follows: 

 What’s New in Woodlot 4 
 Installation of Woodlot software 
 Software components 
 Description of key features in Woodlot 4 
 Appendices with information for users 

 

For more information, please contact: 

Ministry of Forests, Lands, Natural Resource 
Operations and Rural Development, Forest 
Tenures Branch 
Victoria, BC, V8W 9C2 
 
Website: 
https://www2.gov.bc.ca/gov/content/industry/fore
stry/forest-tenures/timber-harvesting-
rights/woodlot-licence/allowable-annual-cut-
calculator-tool  

Federation of BC Woodlot Associations 
Brian McNaughton, General Manager 
381 Pheasant Road 
Williams Lake, BC, V2G 5A9 
 
Tel: 1- 866-345-8733 
Email: gen_manager@woodlot.bc.ca 
Website: https://woodlot.bc.ca/  
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1.1 User Support 

 
Woodlot licensees may contact the following for user support questions: 

Mike Bandstra, RPF 
Email: mbandstra@forsite.ca 
Tel: (250) 847-4822. 
 
 
Ministry staff and other users may contact the following for user support questions: 
 

For Woodlot usability support questions, please call Resource Tenures Branch, Victoria. 

For Woodlot timber supply analysis questions:  

Doug Beckett, RPF 
Forest Analysis Section,  
Ministry of Forests, Lands, Natural Resource Operations and Rural Development 
Prince George 
Email: Doug.Beckett@gov.bc.ca 
Tel: (250) 565-6265 
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2.  Installation of Woodlot for Windows Software 

This chapter describes the installation of Woodlot for Windows 4 and all later versions of 
Woodlot for Windows software. 

Woodlot for Windows software is available at no charge as follows. 

2.1 BC Government Users 

For Government users, Woodlot for Windows software, version 4.2 and later, can be 
downloaded and installed from the website listed under 2.2 Industry and Non-Government 
Users.  Woodlot 4.2 is not available on the Citrix server. 

2.2 Industry and Non-Government Users 

Woodlot for Windows software is available for download and install from the Ministry of Forests, 
Lands, Natural Resource Operations and Rural Development Woodlot for Windows AAC 
Program webpage located at:  https://www2.gov.bc.ca/gov/content/industry/forestry/forest-
tenures/timber-harvesting-rights/woodlot-licence/allowable-annual-cut-calculator-tool 
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Please select the version and applications you wish to download from the menu items provided.  
Follow the prompts to have Woodlot self-install in your computer.   

Users are advised to check the FLNROD Woodlot website regularly for updates and the latest 
version of Woodlot for Windows. 

Note: The Woodlot 4 install will check that your computer has the correct version of Microsoft 
.Net framework.  Woodlot requires the .Net framework version 4; most systems have this 
already.  If you do not have the latest version, a free upgrade is available as follows: 

 If you have the correct version of the .Net framework, Woodlot will continue to install on your 
computer. 

 If you require an upgrade to .Net framework version 4, you will be prompted.  An updating 
feature will activate for your convenience, connecting you to the Microsoft website for the 
update.  Please follow the self-updating steps provided.  You will be able to continue installing 
Woodlot after updating the .Net framework. 

If you require an upgrade to .Net framework version 4 but do not have a fast internet connection 
for an update, a copy of the .Net update is available from the FLNROD Woodlot website as a 
.Net framework redistributable file.  The file name is dotNetFx40_Full_x86_x64.exe.  Woodlot 
licensees can contact the Federation User Support (see above) for a CD copy and 
assistance.2.3 Computer System Requirements 

Any computer capable of running Windows should run Woodlot 4.  You will require: 

Hard Drive space: 150MB free storage space 

Operating Systems: Windows XP, Windows Vista, Windows 7, Windows 8+ 

Microsoft .Net Framework: version 4.0 

(Note: if the Microsoft .Net framework version 4.0 is not available on your system, you 
can upgrade at no cost by navigating to https://www.microsoft.com/en-
ca/download/details.aspx?id=17851  to install the upgrade, or see your system 
administrator.) 

Woodlot operates on 32-bit operating systems and therefore will not run on Windows 3.1 or 
older operating systems (16-bit).  (For this same reason, Woodlot 4 does not use older versions 
of VDYP, such as VDYP6 used in Woodlot 3.) 

Sample files are generally stored in C:\Program Files (x86)\Woodlot for Windows 4\Sample 
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2.4 Software Requirements 

Woodlot comes with most of the software required to run timber supply calculations and create 
reports.  This includes the parent Woodlot 4 application, and its dependent applications VDYP7, 
TIPSY4.3, and Plotsy (refer to Section 3). 

Other software packages that are not provided with Woodlot but are recommended for 
preparing data, formatting reports and printing include: 

Word Processing: Word for Windows for final formatting of your woodlot timber 
supply reports. 

Spreadsheet: Excel for creating and/or editing CSV data files, which can be 
imported into Woodlot. 

GIS: ArcMap or similar mapping software for assembling and preparing 
VRI inventory data and .shp graphics files and/or CSV files, which 
can be imported into Woodlot. 

Note:  Woodlot for Windows Version 3 and Version 4x can be installed on the same computer.  
This can be useful during transition work to move old data files to Version 4. 

2.5 Forward Compatible Files 

Files created in Woodlot 4 are forward compatible and can be used in Woodlot 4.0 or later 
versions.  They will not run in Woodlot 3.1. 

The Woodlot 4.1 update in 2014 resulted in several changes to the file formats, and so files 
created in Woodlot 4.1 may only be used in Woodlot 4.1, 4.2, or later versions.   

If you have any questions about compatibility, check with your Woodlot support contact. 
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3. Software Components 

This chapter describes the main software components in Woodlot 4. 

Woodlot 4.4 incorporates the following suite of timber supply software 
components, each being the most recent version available in 2016.  
Software version numbers are provided on the About screen.  Please 
refer to the About screen (located in the Help menu or when you start 
Woodlot) for the latest version numbers in use.   

 

Supporting Software 
used in Woodlot 4.4 

Functionality in Woodlot 4 

Woodlot 4.4 The parent application used for timber supply analysis. 

VDYP7 Console: 
7.14b:7.14.2.61 

Used to predict timber yields for natural (unmanaged) stands and for partially cut 
stands. 

BatchTIPSY: 4.4.2.0 Used to predict timber yields for managed stands. 

Plotsy: 1.28.0.0 Used to generate reference heights for a given reference age and site index. 

Sindex: 1.52 Used to graph results. 

 

All software is owned and managed by the Ministry of Forests, Lands and Natural Resource 
Operations.   

The Woodlot 4.4 Help feature includes information on both VDYP7 and TIPSY 4.3.  For more 
information on VDYP, TIPSY, Sindex and Plotsy please contact the Forest Analysis and 
Inventory Branch and Appendix 3. 

3.1 Updating Woodlot for Windows 

From time to time, it may be necessary for FLNROD to update Woodlot for Windows or its 
dependent software VDYP7, TIPSY4.3, Sindex and Plotsy.  The FLNROD is responsible for 
software updates.  If there is an update posted, you should update Woodlot for Windows on 
your computer. 

Please check the Woodlot for Windows AAC Program website located at 
https://www2.gov.bc.ca/gov/content/industry/forestry/forest-tenures/timber-harvesting-
rights/woodlot-licence/allowable-annual-cut-calculator-tool  Searching for “Woodlot for Windows” 
will find an appropriate web link to the software.  If you have a different version, then you should 
uninstall your program and re-install the latest version of software from this webpage. 
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4. Woodlot Overview 

This chapter provides an overview of main features in Woodlot 4. 

Woodlot 4 is a timber supply analysis program for use on woodlots and small woodlands in BC.  
In addition, Woodlot 4 now includes the ability to determine harvest rates on larger forest 
tenures such as Community Forest Agreements and First Nations Woodland Licences. It uses 
the timber inventory and timber management information you provide, estimates the growth and 
yield on your woodlot, and calculates the best possible sustainable harvest rate for the planning 
period.  Woodlot calculates a non-declining even flow (flat-line) harvest rate over a 250-year 
planning horizon. 

Woodlot 4 retains the same general workflow as Woodlot 3.2, while taking advantage of the 
latest technologies, data sources and timber yield functions.  User-friendly features have been 
provided to assist you with your analysis. 

Like any software program, the results are as good as the information that you provide.  You will 
be rewarded if you are diligent in preparing complete and accurate data. 

Experienced users may wish to skip to Appendix 6, which provides a summary of the steps to 
using Woodlot 4, Getting Acquainted with Woodlot 4, Key Features, How Woodlot Calculates 
the Harvest Rate and Tips and Tricks. 

4.05 Caution - Woodlot 4 and Legacy Data 

If you are using data imported from an earlier version of Woodlot in Woodlot 4, (i.e. older lot files 
or csv files), please be advised that you will need to review and likely adjust the crown closure 
values in the imported data prior to recalculating the yields in Woodlot 4.   

Earlier versions of Woodlot used VDYP 6, which uses estimated crown closure at rotation age 
to predict stand volumes.  The crown closure data required in the old lot or csv file was intended 
to be measured or estimated crown closure at rotation age. 

Woodlot 4 uses the VDYP 7 FIPSTART method to predict stand volumes when using old format 
data.  This method requires crown closure at stand reference age, which is generally crown 
closure at current stand age.  (See Section 7.9.3 for more details.) 

The difference in crown closure values and in resulting predicted VDYP 7 yield will be small for 
older stands near rotation age, but can be very significant for younger stands. 

The user should be prepared to document and support any required changes to crown closure 
values on a polygon by polygon basis, and expect to provide a rationale supporting the revised 
values in their Management Plan. 

Note:  Woodlot 4 will import the VDYP 6 yield predictions when you import an old version lot file, 
and will use the VDYP 6 yield predictions to calculate an AAC until such time as the user 
explicitly chooses to overwrite the VDYP6 values with VDYP7 values.  Woodlot 4 does not 
import the VDYP 6 yield predictions when you import an old version csv file. 
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4.1 Woodlot 4 Windows and Tabs 

There are six main work areas in Woodlot that you navigate to using the tabs at the top of the 
workspace.  Each operates with sub-windows of information and data summarized below and 
discussed in the following Sections. 

 

Window or Tab Title What it does

 

About Screen 

The About screen shows the 
version and date of Woodlot 4.  
Use this information to verify that 
you are using the most up to 
data version of Woodlot before 
completing the final runs for your 
Management Plan. 
 
The screen also includes 
information on the versions of 
VDYP7, TIPSY 4.3 and Plotsy 
used in Woodlot 4 

   

Project Tab 

The Project tab is used to enter 
basic woodlot project information 
and to adjust default analysis 
settings.   
 
These include default Harvest 
Parameters, Partial Cut defaults, 
TIPSY defaults, etc.   
 
You can view the species and 
utilization levels used in VRI, 
VDYP and TIPSY. 
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Polygon View 
 
 
 

The Polygon View tab is used to 
manage the forest inventory data 
and management assumptions 
specific to each forest polygon 
and to calculate yields.   
 
The polygon view tab can be 
used to directly enter inventory 
information about a forest type, 
or the information can be 
prepared outside of Woodlot and 
imported into the program.  As a 
general rule, it is more efficient 
to prepare the data outside of 
Woodlot in a GIS system and/or 
spreadsheet or data manager 
and import the results into 
woodlot.   
 
Preparing the data in a GIS 
system allows you to import a 
SHP file set which enables the 
mapping tools within Woodlot 4.  
Woodlot for Windows lets you 
also link the SHP file set with 
data prepared in a spreadsheet. 
This is the most important data 
screen in Woodlot 4 as your final 
calculations are only as good as 
your input data.  You should 
spend an appropriate amount of 
time collecting and ensuring this 
screen is filled correctly.

   

Tabular View 

The Tabular View tab is used to 
display basic polygon 
information for a quick check, 
and to edit your polygon data in 
a tabular format.   
 
Polygon data can be filtered to 
display the data in a variety of 
ways. 
 
If you change any timber yield 
data in the Tabular View, such 
as Silviculture System, the 
polygon icon will change to “?” 
and you will need to re-calculate 
the yield for those polygons 
when you return to the Polygon 
View.   
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Map View 

The Map View tab can display a 
map of your forest inventory data 
if you import a shapefile.  You 
are required to load a map shp 
file to display in the Map View, 
otherwise this tab display will be 
blank. 
 
Note that Map view can display a 
map for use with a Woodlot 3.2 
*.lot file if you import a *.shp file 
of spatial information that you 
can then link to the Woodlot 3.2 
data. 

   

Calculations 

The Calculations tab is used to 
conduct harvest rate 
calculations.  A non-declining 
even flow harvest rate is 
calculated over the 250-year 
planning horizon. 
 
In this screen you can set the 
harvest priority, harvest order, 
constraints, and calculate the 
AAC. 
 
You can view results in the 
harvest schedule section and 
produce graphs.  Graphs are 
generated in the FLNROD 
plotting module Plotsy. 
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4.2 Sequence of Work in Woodlot 4  

The general sequence of timber supply work in Woodlot 4 is suggested as follows: 

 For a new woodlot calculation, or to use new inventory data on an existing woodlot, you will 
need to identify your woodlot area and assemble the forest inventory for your woodlot.  VRI 
data for most woodlots is available from FLNROD via DataBC (refer to Section 4.7).  
However, woodlot specific inventories are no longer added to the provincial VRI data set.  The 
user should ascertain whether the VRI data is the most recent inventory data for the woodlot, 
and/or if updating for recent disturbance is required.  If you are not familiar with GIS 
applications or access to on-line spatial data, you should contact a GIS forester to arrange for 
the data file.   

You will need to identify sustainable forest management assumptions including any 
constraints on timber supply.  Use “Classifiers” to do this when you prepare your data.   

For details on constraints commonly used in your Timber Supply Area (TSA), refer to the 
Timber Supply Review for the TSA adjacent to your woodlot from this website: 
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/timber-
supply-review-and-allowable-annual-cut 

 For updating an existing woodlot calculation, you will need your Woodlot 3.2 lot file, the 
updates if any to your forest inventory, and updates if any to your forest management 
assumptions. 

Most users will want to import their data into Woodlot, although you can also manually enter 
your data.  To import, prepare a CSV file or SHP file based on the parameters described in 
the following sections of this guide.   

Alternatively, import your old. lot file and update it manually once in Woodlot 4.  Carefully 
review the data you have imported, looking for missing data items or mistakes.   

Data from Woodlot 3.2, regardless of import format used, will be missing some key 
information: basal area, stems per hectare, and Biogeoclimatic zone.  You can edit flawed or 
incomplete data in the Project View tab and Polygon View tab in Woodlot, or edit the source 
data and import it again. 

 Growth and Yield.  For new woodlot projects, Woodlot 4 will generate yields from VDYP7 or 
TIPSY 4.3 based on growth and yield assumptions for each of your forest polygons.  Click the 
Calculate Yields menu item to generate new or updated yields.   

Alternatively, you can import and use a custom yield curve using the features in Existing 
Forest or Reforest, under the “Yield Settings” window, which is activated by clicking on the 
yield type section.   

When you import data created in Woodlot 3.2, Woodlot 4 will load the existing yield 
information from your old lot file and will use this yield information to run your harvest 
calculations.  To update the old yields using the new VDYP7 and TIPSY 4.3, you can either 
open the “Yield Settings” window for a specific polygon and uncheck the “Imported from Lot 
File” checkbox, or use the "Edit", "Remove all "Imported .LOT Yields" tool.   

 Timber supply constraints.  You can reflect constraints on your timber supply for non-timber 
management uses of your woodlot.  Typically, these might include area reductions for future 
roads or timber reserves, forest cover age or height requirements for wildlife, environmental or 
social concerns (e.g. Visual Quality).  Use the Constraints section on the Calculation screen to 
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Tabs 
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Toolbar 
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Information 
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select these.  You can also add an area netdown and a road netdown for each polygon on the 
Polygon View tab if required. 

 Calculate non-declining even flow harvest rate over a 250-year planning horizon.  From the 
Calculations tab, select your harvest priority, harvest order and constraints.  Click on 
“Calculate” to generate your harvest rate.  This will create a harvest schedule with details of 
the calculation, and the green Standing Volume/Time graph.  You can test your harvest rate 
by adjusting the priority and order, or by forcing a higher or lower harvest rate. 

 Produce woodlot harvest planning report.  From the main menu, select Reports, “Woodlot 
Report” and one of the graphs.  This will provide you key details on your calculated harvest rate. 

4.3 Basic Functionality and Workspace 

Woodlot 4 is a Windows based application with standard conventions and functionality, including: 

 Menu (e.g. File, Edit, View, Reports, Help). 

 Toolbar (New, Open, Save, Calculate Yields, etc.).   

On some Tabs such as the Polygon View Tab, additional toolbar items are provided. 

 Tabs located under the menus to navigate around Woodlot 4 (Project, Polygon View, Tabular 
View, Map View, Calculations). 

 Workspace with: 

 standard text boxes for manual data entry,  

 drop down list boxes, check boxes and radio buttons for selecting options. 

 Status and Information bar at the bottom of the screen. 

 The Information bar provides a log of recent actions and can be used to help 
troubleshoot if you are having any issues. 
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4.4 Menu Items 

Woodlot 4 has five main menu items listed along the top of your window, including File, Edit, 
View, Reports and Help, which are displayed at all times.   

 

 

 

 

 

 

 

 

 

 

 

4.4.1	File	

 New – to begin creating a new Woodlot project, and to clear out old data if you have an active 
project in Woodlot 4. 

 Open – used to open a Woodlot 4 .wlt file.  Note that the .wlt file is the new Woodlot 4 file 
format, replacing the previous Woodlot 3.2 .lot file.  Refer also to the “Save” and “Save As” 
commands below. 

 Import (shp) – used to import a standard ESRI Shapefile so that you can display a map in 
Woodlot.  This feature replaces the “Import VRI (shp)” feature in Woodlot 4.0.  See section 
4.6 below for more on importing Shapefiles. 

 Import (csv, txt) – used if you want to import data from a Comma Separate Values (csv) file, 
text (txt) file.   

Only fields with names recognized by Woodlot 4 will be imported.  Other data will be ignored.  
Refer to Section 4.8 and Appendix 5 for more on the required file formats. 

 Export (csv, txt) - used if you want to export your Woodlot data to a Comma Separate Values 
(csv) file, text (txt) file.  The files created will have the required Woodlot 4 file format and 
column headers, and will be populated with results from your analysis. 

 Import Woodlot 3 (lot) – used if you want to import an old Woodlot 3.2 “.lot” file.  This will 
import all the data, yield information, harvest priorities and previous calculated AAC.  Refer to 
section 7.11 for more information on importing old Woodlot 3.2 “.lot” files. 
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Woodlot 4 will convert and use as much of the old data as is available.  Woodlot 4 requires 
some additional fields of data (for example to run VDYP7) which will be evident when you 
view polygons in the Polygon View tab or try to recalculate yields.  You will need to update the 
data, recalculate yields and re-run your harvest calculations if you wish to take advantage of 
the advances in Woodlot 4. 

 Import Woodlot 3 (csv) – used if you want to import a Woodlot 3.2 .csv file.  This will import 
all the data, yield information, harvest priorities and previous calculated AAC. 

Woodlot 4 will convert and use as much of the old data as is available.  Woodlot 4 requires 
some additional fields of data (for example basal area, stems per hectare, and Biogeoclimatic 
zone, which are required to run VDYP7).  The missing fields will be evident when you view 
polygons in the Polygon View tab or try to recalculate yields.  You will need to add the missing 
information, recalculate yields and re-run your harvest calculations if you wish to take 
advantage of the advances in Woodlot 4. 

 Save – used to re-save your “.wlt” file. 

 Save As – used to save your “.wlt” file as a new file. 

 Recent – used to access recent files that you saved for importing or opening a woodlot file.  
Recent will track the last 10 files used. 

 Exit – to close Woodlot.  You will be prompted to save your changes before Woodlot shuts 
down. 

Default directory location:  When you save or open a file for the first time, Woodlot will 
attempt to use your “My Documents” directory.  If you use another directory, Woodlot will 
remember this and will save or open a file from the last directory location you use. 

 

4.4.2	Edit	

The Edit menu provides access to the following features: 

 Copy Species List – to get a list of all species and 
codes available in Woodlot. 

 Select None – click this to batch clear the polygons 
selected in the Polygon View tab, Tabular View tab, 
and Map View tab. 

 Remove all “Imported .LOT Yields” – click this to batch clear the volume and batch un-
check the imported yields for polygons imported from an old lot file.  See 7.11.2 on using this 
feature.  This allows you to recalculate yields with the current version of TIPSY and VDYP. 

 Remove all Yields – a new feature in Woodlot 4.2, 
which you can use to remove all yields if you wish to 
do a full refresh on your yields. 

 Delete Selected Polygons – used to delete the 
polygons you have selected in the Polygon View tab or 
on the map. 
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 Convert Dead Stands to Non-Commercial – a new utility used to change groups of forest 
polygons from VDYP modeled stands with a high component of dead timber to Non-
Commercial stands that will be regenerated per user specifications following a stand 
conversion.  Works with VRI data sets only.  For details on the use of this feature, see Section 
7.9.5 Yield Type and Yield Settings. 

4.4.3	View	

The View menu is used to turn on or turn off the display of 
detailed items in the Polygon View tab.  Most viewable 
items now have their own display buttons on each 
window. 

 Hide non-FMLB – by default, Woodlot will hide the non-FMLB polygons in the navigation tree.  
These can be displayed by simply navigating to the tree and clicking on the + button, or by un-
checking this feature in the View menu.  This is simply a shortcut feature. 

 See also Section 7.2 for view items in the Polygon View tab, including the Small Map, 
Comments, VRI and Yield Graphs buttons. 

4.4.4	Reports	and	Graphs	

Reports and graphics can be produced in 
Woodlot 4 from the Reports menu.  You will 
be required to first run a calculation to 
produce or update a report or graph.   

Items include:  

 Woodlot Report – to generate the standard Woodlot Licence Harvest Planning Report. 

 Age Distribution Graph – to generate a standard age class distribution graph (uses Plotsy). 

 Standing Volume/Time Graph – to generate the green graph that displays on the 
Calculations tab (uses Plotsy). 

Refer also to Section 11 Reports and Graphs for more details on creating reports and graphs in 
Woodlot 4. 

4.4.5	Help	

The Help menu item provides access to key 
documentation, the Woodlot User Guide and 
various other Help items.  

 About – used to access the “About” 
screen, which has program details. 

 What’s New – includes a summary of the 
latest updates in Woodlot for Windows.   

 User Guide – used to open a pdf copy of 
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Polygon 
Toolbar

the Woodlot User Guide (i.e. this document). 

 Download Latest User Guide from MOF – to seek and download the latest version of the 
Woodlot 4 User Guide from the FLNROD website. 

 TIPSY Help – used to access the Help file from TIPSY. 

 VDYP Help – used to access the Help file from VDYP7 Console. 

 

4.5 Toolbars 

The toolbar provides common commands used in Woodlot 4.   

It is split into two sections.  The first half is used on all tabs and includes general functions that 
can be accessed anywhere in Woodlot 4.  The second half is used only in the Polygon View tab 
to activate features there. 

 

 

 

 

 

 

 

 

 

 

The first half of the toolbar includes the following features, shown as icons: 

 New – used to create a new Woodlot project file. 

 Open – used to open an existing .wlt file from Woodlot 4. 

 Save – saves your project to the existing Woodlot 4 .wlt file you are working on. 

 Calculate Yields – used to calculate new yields from any Tab.  Shows the number of 
polygons that have not been calculated yet (you can check which ones are not calculated in 
the Polygon View tree.) 

A second half of the toolbar is displayed only when you navigate to the Polygon View tab.  For 
information on this toolbar, please refer to Section 7. 
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4.6 Importing Shapefiles – Import (shp) 

The Import (shp) file menu item is a new feature in Woodlot 4.1, which allows you to import an 
ESRI Shapefile, so that you can display a map of the inventory polygons in the woodlot and 
import the data file.  This process can also import the attribute data linked to each polygon.  
Refer to below and Section 6.8 for more on linking data. 

Note: to minimize the chance of error, if you propose to import shapefiles into Woodlot 4 it is 
highly recommended that you engage or consult with a GIS technician experienced with 
shapefile importing features. 

To import VRI data for your woodlot, please refer to Section 4.6 “Downloading Data from 
DataBC for Import Into Woodlot for Windows”. 

The two files read by Woodlot are the .shp and .dbf.  The shape type must be a polygon, 
(including polygon, polygon M, and Polygon Z).  For more information on ESRI Shapefiles, refer 
also to https://en.wikipedia.org/wiki/Shapefile. 

The Import (shp) feature is also used to import a standard Vegetation Resource Inventory (VRI) 
shapefile of forest inventory data (polygon shapes and attribute data).  VRI data is available at no 
charge from the FLNROD from https://www2.gov.bc.ca/gov/content/industry/forestry/managing-
our-forest-resources/forest-inventory/data-management-and-access or https://data.gov.bc.ca/ .  
Woodlot will import all fields of data but will only use and allow edits to the fields required to run 
Woodlot. 

Each shp file is georeferenced in a mapping coordinate system.  We recommend you use BC 
Albers, as this is that standard Ministry georeferencing format and there are not multiple zones 
within BC, as with UTM.  However, UTM data will also work properly. 

To import a Shapefile, click on File, “Import (shp)” and follow the prompts.  This will open a 
standard Windows "browse for a file" window.  Navigate to where your Shapefile is located, 
select it and click “Open”.  The Import window, will display with information on your shapefile for 
importing to Woodlot.  If you are satisfied with the shapefile, click the “Import” button to 
complete the importing process and return to Woodlot for your analysis.  Otherwise, click 
“Cancel” to return to where you were prior to importing. 

The Import Window 

The Import window has two tabs of 
information about your shapefile for your 
consideration prior to importing, as 
described below. 

The “Basic” Tab 

The Basic tab is a summary of results of 
your file.  Cells in green shading indicate 
a successful import.  Cells in red shading 
indicate potential issues, with a 
suggestion to overcome the issue.   
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Descriptors on the Basic tab include: 

 Shape – if the caption is shown in green and displays “Shape file found”, this simply 
acknowledges that Woodlot has found a shapefile ready to import.  

 VRI Columns – indicates if you have imported a complete VRI dataset or not shape and 
attribute data). 

 Woodlot Columns – indicates if any old Woodlot format columns have been imported.  If you 
are importing a VRI shp file, there will be no Woodlot old columns to import. 

 Classifier Columns – indicates if you have imported any Woodlot Classifiers, and the classifier 
field names. 

 Rows (polygons) – indicates the number of polygons and how they are being processed. 

If you have any red shaded sections, click on the “Advanced Tab” to adjust your import. 

The “Advanced” Tab 

The advanced tab is a tool which provides details on and control over how your data has 
imported.  This is an advanced feature intended for error checking if you are having trouble 
importing data.  You might also wish to consult a GIS technician if you are having trouble 
importing your files. 

 

 

 

 

 

 

 

 

 

 

 

The Advanced tab has the following sections: 

 Linkage to existing Resultants (polygons) via – indicates the main linkage to the row of data 
you imported.  The default importing setting used by Woodlot is to import a file by 
Mapsheet/Polygon/Subpolygon since this is used in Woodlot 3.1.  If you have duplicated 
polygons that may be in pieces, you can import them by row number as the unique identifier.   
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This setting in the Advanced Tab provides you the option to override the default linkage 
setting shown in the Project tab.  Refer to Section 6.8 for more information on the default 
linkage settings. 

 Shape File – indicates if you have imported Shapefile graphics. 

 VRI Columns – indicates if you have imported VRI columns. (e.g. BEC, Feature id, etc.) 

 Woodlot Columns – indicates if you have imported woodlot columns of data. (e.g. Harvest 
Age, Silviculture system, etc.) 

 Classifiers – indicates if you have imported classifier columns of data. (e.g. Crown, private, top 
up, etc.) 

 Columns / Fields – provides a cross reference of the data imported to fields used in Woodlot. 

 File Headers to Columns – shows the database field name on the left and how they are 
linked to the Woodlot variable friendly name on the right. 

Green text indicates fields that have been imported.  Red text indicates fields that were not 
imported. 

 File Headers not Imported – lists the database fields that were not imported. 

 VRI Columns to File Headers – lists the VRI data Woodlot variable names on the left and 
how they are linked to the database field name you imported. 

 Woodlot Columns to File Headers – lists the Woodlot only variable names and how they 
are linked to the database field name you imported.  This does not include the VRI 
variables of classifiers. 

 Classifiers to File Headers – lists the Woodlot Classifiers and how they are linked to the 
Database field names. 

 Rows / Resultants (Polygons) – describes the polygons by row depending on how you are 
importing them as indicated in the “Linkage to existing Resultants (polygons) via: “section: 

 Mapsheet/Polygon/Sub Polygon – shows the polygons that have tried to import.  Duplicated 
polygons are shown in green text. 

 Row Number – shows each polygon by row number from your database.  This is useful if 
you wish to import pieces of polygons with the same name. 

 

4.6.1	Scenarios	for	Merging	Spatial	Data	and	Tabular	Data	

Woodlot was designed to import ESRI shape files.  Only the .shp and .dbf files are accessed by 
Woodlot. 

Woodlot cannot project data from one coordinate system to another.  We recommend using 
NAD_1983_BC_Environment_Albers.  It is possible to use UTM NAD 83 or 27 data, as long as 
you are not mixing multiple projections in one project. 

Woodlot was designed to import standard VRI (layer 1) shape files from the MOF or custom 
Woodlot shape files.  If you are creating your own inventory the preferred method would be to 
use Woodlot formatted data in your shape files.  If Woodlot detects all the VRI columns it will 
automatically generate the Woodlot data from the VRI data. 
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Spatial data cannot be edited in Woodlot, so all mapping work must be completed in your GIS 
before importing to Woodlot. 

4.6.2	Shapefile	Import	Updates	in	Woodlot	4	

When importing polygons from a shapefile, Classifiers can now be used to uniquely identify sub 
polygons.  Shapefiles with duplicate stand identifiers (usually splinters from geo processing) will 
now be combined into a single resultant, in previous versions each duplicate shape replaced the 
previous one. 

The following features are important to note when importing shapefiles in Woodlot 4. 

4.6.2.1	Importing	

The “Use Classifiers” checkbox in the Advanced panel is a new option for importing forest cover 
shape files that have been combined with other layers in a GIS.  Woodlot was also updated to 
combine shapes while importing shapefiles, if values in all the linkage fields match.   

4.6.2.2	Classifiers	

Fields starting with c_ or class_ will 
automatically import as a classifier.  
Starting in Woodlot 4.4, you can now 
select other fields (columns) as 
classifiers.  Double click on the item 
in the ‘Column / Fields’ list.  The item 
will change from red to green and the 
word classifier will be displayed to 
the right. 

If you double click on a classifier it 
will be reset back to a column that 
will be skipped during the import 
process. 

4.6.2.3	Use	Classifiers	

The “Use Classifiers” check box removes the requirement of having a “Sub Polygon” field. 

4.6.2.4	Overwrite	

The “Overwrite” checkbox has been modified slightly.  In previous versions of Woodlot, if a 
duplicate polygon was in the shape file, the second polygon would overwrite the first.  Now all 
duplicate pieces will be combined into a single polygon.  The overwrite checkbox is used to 
specify if polygons already in the program are replaced. 
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4.7 Downloading Data from DataBC for Import Into Woodlot 4 

Forest inventory shapefiles and related coverages can be assembled and downloaded from 
DataBC for importing directly into Woodlot for Windows.  Please refer to the following link for a 
suggested step by step description of the process to follow: 

https://www.for.gov.bc.ca/ftp/HTH/external/!publish/web/timber-tenures/woodlots/woodlot-for-
windows/Download_VRI_Data_for_Woodlot_for_Windows4.2_20160824.pdf 

Shapefiles can be assembled for most Woodlot Licences and area-based tenures in BC using 
this procedure. 
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4.8 Growth and Yield Models Used in Woodlot 4 

Timber volume estimates and related statistics are generated in Woodlot 4 using the Ministry 
growth and yield models Variable Density Yield Projection (VDYP) and Table Interpolation 
Program of Stand Yields (TIPSY), or from custom yield tables you provide.  Yield model input 
parameters are based on the polygon data you supply.  VDYP and TIPSY are the yield models 
generally accepted for timber supply analysis in BC. 

The choice of yield model is left to the user, and is usually based on the type of forest 
management for the stand as discussed below.  The yield model is chosen in the Polygon View 
tab for each polygon.  If you are not sure which management type you have, it is likely that the 
stand is naturally occurring and therefore you should use VDYP in the absence of better 
information.  You may wish to discuss the matter with your Woodlot Forester.  Refer to Section 
7 for more on using VDYP and TIPSY in Woodlot, and for importing custom yields in the 
Polygon View tab. 

The yield options include: 

 Variable Density Yield Projection (VDYP).  VDYP7 has replaced VDYP 6.  VDYP7 is more 
sensitive to changes in stand density such as basal area and trees per hectare.  VDYP7 
Console is used in Woodlot 4, and is developed and owned by FLNROD. 

VDYP is an empirical yield prediction system intended for use in unmanaged, natural stands 
of pure or mixed species composition.  It is also used in Woodlot to model yields in partially 
cut stands. 

Effective July 2018, Woodlot 4 uses the latest official version VDYP7 Console 7.14b; 7, 14, 2, 61. 

For more information on VDYP, refer to  
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/forest-
inventory/growth-and-yield-modelling/variable-density-yield-projection-vdyp 

 Table Interpolation Program of Stand Yields (TIPSY).  TIPSY 4 is used in Woodlot 4.  
TIPSY is used typically for planted stands with managed stand density.  It is also used for 
naturally regenerated stands that are managed to full stocking. 

TIPSY is a growth and yield program that provides access to the managed stand yield tables 
generated by the models Tree and Stand Simulator (TASS) and the Silviculture on Yield, 
Lumber Value, and Economic Return (SYLVER). TIPSY retrieves and interpolates yield tables 
from its database, customizes the information and displays summaries for a specific site, 
species and management regime. Yield tables are available for various even-aged coniferous 
species, as well as trembling aspen and red alder, growing on the coast and in the interior of 
British Columbia.  TIPSY is developed and owned by FLNROD. 

TIPSY also provides a growth benefit through genetic worth for planting, includes features for 
pre-commercial thinning (also known as spacing) and fertilization.  These features can be 
toggled on and adjusted in Woodlot 4 in the Yield Settings window in the Polygon View tab. 

Effective July 2018, Woodlot 4 uses TIPSY v4.4.2.0.  This enhancement provides the 
following additional functionality: 

 Allows blending between Conifer and Deciduous. 
 New BTP file includes all VRI species codes. 
 Updated TIPSY Species list in Woodlot. 
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 Updated VRI species list with Latin and defined common species. 
 Removed DWB feature from Woodlot as no longer part of TIPSY. 
 TIPSY 4.3 was giving overly optimistic results for White Spruce (Sw) and was corrected in 

TIPSY 4.4.  The correction in TIPSY may result in future AAC calculation reductions. 

For more information on TIPSY, refer to 
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/forest-
inventory/field-forms-and-software/software-download 

 Custom Yields.  Woodlot 4 allows users to import their own yield tables generated 
elsewhere, such as from TASS.  A rationale should be provided to support the use of custom 
yield tables in a woodlot licence AAC determination. 

 Sindex.  Effective July 2018, VDYP and TIPSY use Sindex version 1.52.  Sindex is used for 
making Site index (SI) calculations for many commercial tree species in British Columbia, 
recommended by the BC Ministry of Forests, Lands and Natural Resource Operations for use 
in silviculture and forest planning. 

Site Index is one of the most common measures of forest Site Productivity.  In BC, Site Index 
is defined as the Site Height attained by a stand at 50 years Breast Height age.  Site index is 
a key attribute within forest inventories and silviculture surveys, and a key input and growth 
driver within BC's principle suite of growth and yield models TASS, TIPSY, and VDYP.   

For more information on Site Index tools available from FLNROD, refer to: 
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/forest-
inventory/growth-and-yield-modelling/site-index-tools-sitetools 

For information on choosing VDYP versus TIPSY, refer to growth and yield modeling 
information within Appendices 3 and 4, or contact the FLNROD Forest Analysis and Inventory 
Branch, Growth and Yield Section (contact information within section 12).  Refer to Appendix 4 
for information on species supported by VDYP and TIPSY.  Refer also to the complete species 
listing on the bottom of the Project View tab. 

4.9 Silviculture Systems and Yields used – Clearcut & Partial Cut 

Two silviculture systems are available in Woodlot 4, clearcut or partial cut.   

Clearcut’s are considered even-aged stands.  TIPSY yields are generally recommended for use 
on even aged stands with managed stocking densities that have been regenerated following 
clearcutting or clearcutting with reserves, as well as naturally regenerated stands that have had 
forest management activities applied to bring the stand to full stocking.  Generally, TIPSY 
stands are even aged, managed second growth stands. 

Partially cut stands in Woodlot for Windows are considered uneven aged management.  
Typically, harvests in these stands have used group selection, single-tree selection, variable 
retention, or another system in which the residual stand that remains following harvest presents 
the next harvest opportunity.   

Yield curves are not widely available for uneven-aged/partially cut stands in BC.  Therefore, an 
approximation has been used in BC timber supply modeling and in Woodlot 4 to estimate yields 
from partially cut stands.  This is the same general method used in Woodlot 3.2, referred to as 
the “average age” partial cut method.  The method has been updated in Woodlot 4 to start the 
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harvest at the older of the current age or your target harvest age.  It will then harvest down to 
the % removal from that age. 

A partial cut stand is assumed to be growing initially as a natural stand using a VDYP yield 
curve for the stand attributes.  The stand is harvested down to a residual volume (set by the 
user) and the corresponding stand age for a natural stand with the post-harvest volume is 
determined from the VDYP yield curve.  Stand age is reset to the younger age, and the stand is 
“grown” until the next partial cut harvest.  The cycle repeats over the planning horizon.  Since 
VDYP is based on natural stands that are fully stocked and not partially harvested, the partial 
cut adjustment factor (PCAF) was introduced to simulate re-growth at a lesser density and to 
reflect any rebound delay effects.  The default PCAF used in Woodlot 4 is a 20% reduction in 
VDYP predicted stand yield.  The use of the “average age” method is a reasonable first 
approximation of partial cut yields.   

Inappropriate combinations of (a) the interval between partial cut harvests and (b) the percent of 
stand volume removed at each harvest can lead to unintended results.  Harvesting too much/too 
soon will drive net stand volume towards zero, and lead to underestimation of AAC.  Cutting too 
little/too infrequently will result in accumulation of unharvested volume, and lead to 
underestimation of AAC.  Review of the detailed harvest records (tell them where it is 
discussed) and fine tuning of harvest parameters for stands managed under a partial cut regime 
is recommended. 

Another partial cutting simulation technique also considered for Woodlot 4 was the “multi-age” 
method.  This method would simulate partial cutting as a series of smaller patch cuts, resulting 
in groups of patches with multiple ages across the polygon.  This feature will be considered for 
inclusion in a future version of Woodlot. 

For information on default settings used by Woodlot for partial cutting, please refer to Section 
6.4 Partial Cut Defaults.  Refer to Section 6.3, 7.9.1 and Appendix 1 for more on silviculture 
systems and partial cutting in Woodlot 4. 

4.10 File Types used in Woodlot 4 

Woodlot 4 is designed to work with any of the following file types.  Files are imported and 
exported from Woodlot from the File menu item.  Refer to section 4.41 and Appendix 5 for more 
detailed information including the required field names used in the csv import file.  The order of 
fields does not matter. 

 wlt – A .wlt file is the new file type you create when saving your file from Woodlot 4.  This is 
the replacement for the previous versions .lot file.   

To load a .wlt file in Woodlot 4, use the File, Open menu item. 

 lot – Woodlot 4 can import a Woodlot 3.2 lot file.  This will bring in data, yield information, 
harvest priorities and the calculated AAC from previous versions of Woodlot.  If you plan to 
update or refresh your AAC, some fields will need to be filled in or updated in Woodlot 4, 
particularly the data in Polygon View.  A .lot file is loaded into Woodlot using the File, Import 
Woodlot 3 (lot) menu item.  Refer to section 7.11 for more detailed information on imported lot 
files. 
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 shp – Woodlot 4 will accept any standard ESRI Shapefile so that you can display a map in 
Woodlot.  This includes standard FLNROD VRI Shapefiles.  Refer to Section 4.6 above on 
importing Shapefiles. 

 CSV (Woodlot 3) – Woodlot 4 can import a Woodlot 3 
Comma Separate Values (CSV) file.  If you import a csv file, 
only fields with names recognized by Woodlot 4 will be 
accepted.  A csv file is imported into Woodlot using the File, 
Import Woodlot 3 (CSV) menu item. 

 CSV (Woodlot 4) – Woodlot 4 can import a new CSV file, and 
export to a new CSV file.  Only fields with names recognized 
by Woodlot 4 will be imported.  This file type is loaded into 
Woodlot using the File, Import (csv, txt) menu item. 

 txt - Woodlot 4 can import a new .txt file, and export to a new 
txt file.  Only fields with names recognized by Woodlot 4 will 
be imported.  This file type is loaded into Woodlot using the 
File, Import (csv, txt) menu item. 

Hint:  If you are not using standard VRI data, a good way to ensure you have the correct data 
and field formats for use in Woodlot 4 is to export a sample project file from Woodlot 4 in the file 
type you plan to use to import your data.  Use this as a template.  Either modify your data to 
match the template format, or populate the template with your data based on the column header 
field names.  For example, if you plan to use a CSV file, export a sample project in CSV format, 
keep the column headers, delete the sample data, fill the template with your woodlot data and 
import the result into Woodlot 4. 

Note that sample files are provided in C:\Program Files (x86)\Woodlot for Windows 4\Sample. 
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5. The About Screen 

The About screen shows important information on Woodlot 4 including: 

 Woodlot software name. 

 Woodlot version number and version date. 

 Ownership and copyright – Forest Tenures Branch, Ministry of Forests, Lands and Natural 
Resource Operations. 

 The software developer. 

 

The About screen also includes important versioning information on the dependent software 
used in Woodlot 4, including: 

 VDYP7 Console. 

 Batch TIPSY (bTIPSY). 

 Sindex. 

 Plotsy. 

When you start Woodlot, the About screen will appear for a few seconds and then close.  You 
can always access the About screen through the Help menu.  
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6. Project Tab 

The Project tab is used: 

 to enter project information for your woodlot,  

 to adjust default settings that will apply globally to the entire woodlot, and  

 to view basic information inventory and yield assumptions.   

You can edit the default values as required.  You can also change or override these default 
values on a polygon specific basis in the Polygon View tab.    

It is important to check that the default settings reflect conditions on and assumptions applicable 
to your woodlot, as the defaults will be used in the absence any polygon specific information 
that you may provide.   

This is a substantially updated version of the old Project screen in Woodlot 3.2, which only 
included basic information on the woodlot.  The main sections in the Project Tab include: 

 Project Information. 

 Harvest Parameter Defaults. 

 Partial Cut Defaults. 

 TIPSY Defaults. 

 Species - information used in VRI, VDYP and TIPSY and utilization levels. 

 Linkage – to existing Resultants (polygons) 
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Note: Important new global defaults are present in Woodlot 4.2.  These will affect your woodlot 
calculations, and include: 

 Coast/Interior for your woodlot. 

 BEC zone for your woodlot. 

 Base Year for your timber inventory. 

 VDYP Utilization level options. 

 

6.1 Project Information and Default Parameters 

The Project Information tab is used to enter basic information about your woodlot, as well as 
some important new default values required in Woodlot 4.  See also 6.1.1 Setting Project 
Defaults. 

The basic information is optional, for your reference and use in the report.  It can be text or 
numbers, and includes: 

 Tenure – enter your woodlot licence number. 

 Company Name – enter your company name. 

 User name – enter your name. 

 Scenario number – enter the scenario name or number. 

 Forest District – enter the forest district your woodlot is in. 

 Created on – will be populated by Woodlot 4, which is the date you first started your work. 

 Last Modified – the date you last saved the file, + the number of changes made since you last 
saved the wlt file. 

Ensure you have selected the following four global default values for your woodlot in the Project 
Information screen, as they will influence the yields generated from VDYP and TIPSY.: 

 Coast/Interior region of BC - Indicate if your woodlot is on the Coast or Interior.  This will 
affect results in TIPSY and VDYP.  It cannot be changed by polygon. 

 BEC Zone – indicate the default Biogeoclimatic Ecological Classification (BEC) Zone your 
woodlot is in.  BEC can be changed for each polygon in the Polygon View tab.  BEC is now 
required for VDYP7.   

 Base Year– The Base Year is: 

  year that polygon ages are identified for, and reported on the Polygon tab for the Existing 
Forest, and 

  the starting year used for your timber supply simulation in the Calculation tab.   
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Woodlot uses the Base Year to determine the age of each polygon at the start of your 
timber supply simulation.  Woodlot subtracts the year of establishment from the Base Year 
to arrive at the current age for that year.   

For example, if you set your Base Year to 2016 and your polygon was established in 1920, 
the age of the polygon will be 2016-1920 = 96 years in 2016.  And, 2016 will be the first 
year for your timber supply simulation.  (This also means to bring forward and update older 
analyses, or check Implications of deferring your analysis.) 

You will be required in Woodlot 4 to set the Base Year if you import data with an “Age”, 
since Woodlot 4 does not store the age directly.  It stores the established year and shows 
the calculated age from that date to the Base Year.   

When you import a lot file, you will be prompted to select the Base Year, which you will 
need to enter if you have not done so already. 

If your woodlot inventory has different base years, you can address this in three ways in 
Woodlot. 

a) Multiple Import – For each set of data you are importing, set the base year in the 
Project tab, import that group of polygons.  Repeat for each set of inventories, changing 
the base year each time for each set of data.  Once you have finished, remember to 
reset the base year to year the want to start your analysis, which is usually the current 
year. 

b) Adjust Current Age – Alternately, you can import all polygons, then set one base year 
in the Project tab, then go back to each polygon and adjust the current age to the age at 
the base year that you just set. 

c) Adjust stand ages to a uniform base year in GIS system prior to import. 

d) Create and add an Established Year field to the dataset you wish to import – 
create and add a field called YearEstab, and populate it for each polygon with the year 
that the stand was established.  Woodlot will then automatically display the current age.  
Current Age = Base Year - Established Year. 

If you have any questions on the use of Base Year in Woodlot for Windows, please consult 
your support contact. 

 VDYP Utilization level – the VDYP utilization level needs to be set for your woodlot.  TIPSY 
utilization is always set to 12.5 cm diameter at breast height (dbh).  See below. 

6.1.1	Setting	Project	Defaults	

Once you have created your woodlot default parameters in the Project tab, to save your 
default parameters, from the main “File” menu, select “Save Project Defaults”.  (Project 
defaults will be saved to the registry file.)   

As of July 2018, Woodlot users need to set the project default parameters before importing 
files, editing forest or calculating yields.  Woodlot no longer always defaults to the Coast.  
Instead, Woodlot now defaults to a blank region until you set your region.   
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6.2 Description 

The large workspace on the top right of the window is provided to allow you to help you keep notes 
and provide documentation as you do work.   

Click on the description to start typing.  Text will wrap and the box will scroll, allowing for many rows 
of text.  Right click in the Description box to bring up a standard Windows menu for editing items. 

 

6.3 Harvest Parameter Defaults 

The harvest parameters used in Woodlot 4 are the same as in Woodlot 3.2.  They are used to 
establish economic rotation parameters for the woodlot.  These include: 

 Minimum Age (yrs) – the youngest age needed to harvest a forest polygon. 

 Minimum DBH (cm) – the minimum stand diameter at breast height needed to harvest a forest 
polygon. 

 Minimum volume (m³/ha) – the minimum merchantable volume per hectare needed to harvest 
a forest polygon. 

 Regen Delay (yrs) – include your expected default regeneration delay.  Typically, this is the 
number of years after harvest until you have a fully stocked planted or naturally regenerated 
stand.  A regen delay of 0 yrs assumes you will have a fully stocked, growing, new stand in 
the same year that you harvest. 

 

6.4 Partial Cut Defaults 

The Partial Cut defaults in this section are used in the “average age” partial cut method only, 
and are the same partial cut defaults used in Woodlot 3.2.  For more on partial cut methodology 
in Woodlot 4, please refer to Section 4.7 and Appendix 1. 

The partial cut defaults include: 

 Partial Cut Percent (%) – the targeted percent volume to be harvested on the first entry.  For 
example, a 25% Partial Cut Percent removal when a stand reaches 400 m³/ha will result in a 
harvest of 100 m³/ha.  It will assume that the new stand is 300 m³/ha and begin the yield curve 
for the next entry as if the residual stand is at the age when a normal natural stand reaches 
this volume.  On the harvest entry, Woodlot will again harvest the stand down to this volume 
level, and re-grow up from there.  Acceptable values 1-50%. 

 Min. Re-entry period (yrs) – this is the number of years you wish to allow the forest in the 
polygon to grow until you harvest again.  Woodlot will grow the forest for that number of years, 
and then at the re-entry, will harvest the in-growth down to the same residual level as was set 
on the first entry.  In the example above, this would harvest ingrowth down to 300 m³/ha.  
Acceptable values 10-999 years. 

 Adjustment Factor (PCAF) – the Partial Cut Adjustment Factor (PCAF) is normally defaulted 
to 80% and should not be adjusted unless you have information to support a change.  Partial 
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cut yield curves are not widely available in BC, and so Woodlot uses VDYP with a PCAF to 
offset any overestimate of growth response from the base fully stocked stand.  It is assumed 
that a stand that is partially cut results in a lower stand density and will respond at a slower 
growth rate than the natural average density stands that VDYP uses to calibrate growth.  
Since VDYP assumes a fully stocked stand of the full range of diameter classes is growing, on 
partial cut stands, the default PCAF of 80% is used to model the stand growth at the lower 
stand density to avoid overestimating growth rate. 

 Woodlot now defaults to require a minimum 50 m3/ha before re-entry on partial cut stands.  
This will avoid a user accidentally specifying a re-entry % where the resulting re-entry volume 
is unreasonably low (e.g. 2 m3/ha).  Woodlot will defer harvesting a polygon until the new 
minimum is reached.  Users can over-ride the default by entering their own minimum re-entry 
volume. 

Please note that inappropriate combinations of (a) the interval between partial cut harvests and 
(b) the percent of stand volume removed at each harvest can lead to unintended results.  
Harvesting too much/too soon will drive net stand volume towards zero, and lead to 
underestimation of AAC.  Cutting too little/too infrequently will result in accumulation of 
unharvested volume, and lead to underestimation of AAC.  Review of the detailed harvest 
records (tell them where it is discussed) and fine tuning of harvest parameters for stands 
managed under a partial cut regime is recommended.  Refer also to Section 4.9, Silviculture 
Systems and Yields used – Clearcut & Partial Cut. 

6.5 TIPSY Defaults 

TIPSY Operational Adjustment Factor (OAF) defaults can be adjusted in the Project Tab.  (In 
Woodlot 3.2, this setting was on the Polygon Data screen.) 

OAFs are used by TIPSY to mimic operational conditions, to adjust ideal research forest 
conditions to operational forest situations.  The default and recommended OAF settings are: 

 OAF 1 accounts for the reduction of physical growing space due to non-forested openings 
created by non-mapped rock outcrops, swamps and non-commercial tree cover. 

OAF1: 0.85.  This is the same as a 15% OAF1 in previous versions of TIPSY. 

 OAF 2 is used to account for decay, waste, and breakage, and some pest damage that 
increases towards maturity. 

OAF2: 0.95.  This is the same as a 5% OAF2 in previous versions of TIPSY. 

(Alternately, for OAF2 in TIPSY 4.3 you can use the DWB feature based on your BEC 
zone.  However, Forest Analysis and Inventory Branch have advised that the DWB setting 
is not recommended for use because it is partially based on old growth loss factors used in 
VDYP7 that may not be appropriate for second growth stands.  This feature is under review 
by FAIB).   

TIPSY 4.3 Help defines decay, waste and breakage as: 

 Decay “is caused by wood-rotting fungi, which produce soundwood losses due to physical and 
chemical processes”.   
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 Waste is the “soundwood portion of a tree or log which has more than 50% decay, considered 
non-recoverable under current utilization standards”.  

 Breakage “represents all soundwood losses due to felling and yarding. The broken pieces are 
considered too small to be merchantable”.   

For more information on OAFs and what is appropriate for use, see TIPSY Help 
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6.6 Tree Species 

The Species section provides you with two important new capabilities: 

 View tree species and related inventory and modeling information used in Woodlot 4. 

 Select default utilization levels for your woodlot. 

 

 

Note: To copy the species list, navigate to the Edit menu and select Copy Species.  This will 
copy the table listed in the Species window. 

The species information used in Woodlot 4, including cross references and utilization levels, is 
derived from VRI standards, VDYP documentation and TIPSY documentation.  The Forest 
Analysis and Inventory Branch of FLNROD have reviewed it; please contact FAIB if any 
questions.  Refer also to Appendix 4 “Tree Species Used in Woodlot 4”. 

All tree species supported by the FLNROD Vegetation Resources Inventory (VRI), VDYP7 and 
TIPSY 4.3 are available for use in Woodlot 4, and have been cross-linked.  This is a complex 
and important information source in timber supply modeling, important for users to be aware of 
so they understand modeling limitations.  Hence, the listing has been provided in the Project 
Tab with defaults. 

Selecting on the radio buttons will display the listing for each data source and model, as follows. 

Note: As a caution, TIPSY will not work with all deciduous species.  If a user accepts the TIPSY 
offer to use VDYP species and there is a deciduous species other than AT or DR then they will 
have to adjust the species and percentage order after the data import is done. 
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6.6.1	VRI	Species	

For Vegetation Resources Inventory 
(VRI) data, this list describes the 
species code, common names, 
species code used in VDYP, species 
code used in TIPSY and whether it is 
considered deciduous or non-
commercial.   

Only the species that show under the 
VDYP and TIPSY headers will have yield information calculated for them.  Unlisted species can 
be imported for completeness but will not have yields calculated in Woodlot.  

 

6.6.2	VDYP	Species	

For VDYP, this list describes the 
species code, common name, 
default utilization level (which is set 
above), species grouping, site index 
species used and the yield curve 
reference. 

 

 

 

6.6.3	TIPSY	Species	

For TIPSY, this list describes the 
species code, common name, 
default utilization level (which is set 
above), default Genetic Worth (%), 
volume curve used, site index 
species used and the yield curve 
reference. 

Genetic Worth defaults cannot be 
set in this version of Woodlot.  
Instead, Genetic Worth values are 
entered for each polygon in the 
Polygon View tab, Yield Settings, or 
via an export to CSV and edit in Excel. 
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6.7 Utilization Levels 

The timber utilization levels available in 
Woodlot 4 are based on utilization 
levels used by FLNROD in timber 
supply analyses in BC.   

Utilization generally depends on 
whether the stand is an existing natural 
stand, existing managed stand, a future 
managed stand, second growth or old 
growth, on the coast or interior. The 
following default options were 
developed for Woodlot 4.   

You can change the utilization level for all polygons from the Polygon View tab if the default 
settings are turned on for those polygons.  To do this, navigate to each polygon and check that 
the “[ ]” are selected in the utilization section of the VDYP and TIPSY screens. 

TIPSY yields are generally calculated to a default 12.5 cm dbh utilization, while VDYP yields are 
calculated to 12.5 or 17.5 cm depending on location and species. 

 

If you wish to use other than the default 12.5 cm dbh utilization in TIPSY: 

1) Make a backup copy of C:\Program Files\Woodlot for Windows 4\Woodlot\Species.dat  
(One editing mistake could render Woodlot inoperable until you get a clean copy of this 
file.  A backup copy ensures this will not be an issue.) 

2) Open C:\Program Files\Woodlot for Windows 4\Woodlot\Species.dat in Notepad. 

Yield 
Type 

Utilization Default 
Option Species Typical Application

Min. dbh 
(cm)

Max. 
Stump 
Height 
(cm) 

Min. Top 
Diameter 

(cm)

TIPSY All cases All species 

Existing managed stands 

Future managed stands 12.5 30 10 

VDYP 2G-Second Growth All species
Existing natural second 
growth stands 12.5 30 10

VDYP HG-Haida Gwaii All species 
Applies only to Haida 
Gwaii, all ages, all species 12.5 30 10 

VDYP OG-Old Growth 
Varies by 
species 

Existing natural old growth 
stands 

17.5 or 
12.5 30 10 

VDYP 12.5 - All Species 12.5 All species
Existing natural second 
growth stands 12.5 30 10

VDYP 17.5 - All Species 17.5 All species
Existing natural old growth 
stands 17.5 30 10
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3) Scroll down to the TIPSY section at Line 146. 

4) Replace the 12.5 values for the species of concern (e.g. with 17.5 values).  Do not alter 
the file formatting or spacing, just change the numbers. 

5) Save, exit.  TIPSY yields will now use the changed utilization standards. 

Important Note: If you make the utilization level change after you have run Calculate Yields 
once, Woodlot will not understand that the TIPSY yield parameters have changed and that 
yields should be recalculated.  If you start again with freshly imported data, your TIPSY yields 
will calculate with the new utilization standards.  This is not an attractive option if you have 
invested time in editing your data set.  In that case: 

1) Export your data to CSV.  

2) Load the CSV into Excel. 

3) Go to the bottom of the data set where you will find a set of rows with no polygon 
number, BEC, area, or age information, but which do have a "YieldMeth" entry of 
"TIPSY"(in Excel Column AG).  These are the TIPSY "Reforest To" scenario definitions.  
Note which row numbers these scenarios occupy.  Or change the font or color to clearly 
identify the rows. 

4) Navigate many columns to the right to Excel Column BV which contains the "Density" 
entry.  This is the plantation establishment density. Add 1 to the value shown.  For 
example, 1600 becomes 1601.  Do this for all the TIPSY "Reforest To" scenarios.  

5) Save the CSV, unload it from Excel 

6) Go back to Woodlot, import the CSV.  Be sure to choose 'Yes - Update' when prompted! 

7) Woodlot will now identify that the TIPSY scenario information has changed, as the initial 
establishment density is higher, and will re-calculate yields for the polygons using the 
modified utilization standards.  The increase of 1 seedling per hectare has no 
measurable effect on yields. 

 

6.8 Linkage to existing Resultants (polygons) via… 

An advancement to Woodlot 4.1 was to add an identifier for users that import data files.  
Previous versions of Woodlot identified rows of data by the “Name”.  Now users can select if 
they would prefer to use “Mapsheet/Polygon/SubPolygon”, “Unique ID” or “Row Number” from 
their data file.  The setting shown in the Project tab is the universal default setting that will be 
used when importing your files.   

You can also override these default linkages when importing a shapefile by choosing a new 
setting in the Import window, Advanced tab.  See the Import section 4.6 for more information. 
This feature is helpful for users that wish to import files over existing files.  If you are unsure, 
leave the setting in its default position, which will apply to most users.  The setting should 
change to “Row Number” if you import a shp file. 
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6.9 Stands with more than one Resultant 

A stand can be made up of more than one resultant.  Refer also to Section 7.13 for a detailed 
description on Stands versus Resultants in Woodlot 4.4. 

The stand is linked to the existing forest, harvesting and future 
forest information.  The resultants contain the Classifiers and are 
linked back to the stand.   

In Woodlot 4.4, the polygon list now shows the resultants as 
follows: 

 A resultant that is only part of the stand will be displayed 
with a half-gray bar, and 

 There will either be a sub polygon identifier or a “(piece #)” 
suffix. 

The small map has been updated to display the other resultants 
linked to this stand in gray. 

 

 

Right clicking on a polygon will bring up a context menu that allows 
you to unlink a resultant from the stand so it can be edited 
independently. 

Unlink polygon – Creates a new stand with the same information 
(Existing Forest, Reforest To) as the original stand and moves the 
selected resultant to that new stand.  The polygon can now be managed independently. 

Split Polygon – Splits a resultant into two resultants allowing classifiers to be modified 
independently.  Shapes linked to that resultant will be deleted after the split, because they don’t 
represent the new resultant area.  The unlink feature can be used if the existing or future forest 
needs to be changed on one of the pieces. 

 

 

On the Rename Polygon screen, the top two items 
“Mapsheet” and “Polygon” edit the Stand.  The rest of the 
items are specific to the Resultant. 

To override the default suffix of ‘(piece #)’, a ‘Sub Polygon’ 
can be specified. 

The Unique Identifier field can be used for importing data into 
a specific polygon.  
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Polygon number 

7. Polygon View Tab 

The Polygon View tab is used view, edit, add and delete forest polygon information, set yield 
calculation parameters, and define the conversion of existing forest stands to a reforested forest 
type.  Features of this tab are similar to the Polygon Data screen in Woodlot 3.2, with 
streamlined and new features added.  

 

This tab has the following functional sections: 

 Polygon View Toolbar 

 Navigation tree 

 Summary (when activated) 

 Area 

 Classifiers 

 

 Map 

 Comments/VRI (when activated) 

 Existing Forest 

 Reforest to 

 Yields 
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7.1 Conventions Used in Polygon View 

There are a few helpful conventions used on the Polygon View tab to keep in mind as you work 
in Woodlot 4: 

 Forest Polygon - The forest polygon you are working on is the displayed screen of data.  The 
polygon number is highlighted in the navigation tree, and listed at the top of your workspace 
highlighted in yellow. 

Your polygon number includes the Mapsheet number, polygon number and can include a sub-
polygon number, similar to Woodlot 3.2. 

 Defaults [ ] Square Brackets – As in Woodlot 3.2, square brackets represent a default or 
imported numerical value.   

To override and replace a default or imported value, click on the cell and type over with your 
better information.  Click to another place on the screen to register the change. 

To reset the entry to the default values, type over the value with a [ ] square bracket or any 
text character (e.g. a, b, c, xx, etc.), then click to another polygon on the screen to register the 
change. 

 Adding Data – add data by typing into a cell.   

Use the Add Polygon menu item to manually add polygons.  See below for information on 
manually adding polygons. 

 Imported Lot files – when you import an old lot file, Woodlot imports the base data, timber 
yields and analysis results.  If you wish to recalculate your yields, you will need to uncheck the 
check box in VDYP and TIPSY Yield Settings and enter the missing data.1 

 Viewing Yield Information – you can view yield information for the polygon by clicking 
anywhere in the yield screen. 

 Display Yield Curves – you can view your yield curve by clicking on the Plotsy icon on the 
inset graph at the bottom of the screen. 

 Display Yield Table – you can view your yield table by clicking the inset graph at the bottom of 
the screen. 

 Selecting polygons to view in Map view – you can select multiple polygons to be displayed on 
the map.  In the navigation tree, simply double click them on (hatched) or off (solid). 

7.2 Polygon View Toolbar and Displays 

The toolbar expands when you are on the Polygon View Tab but not on other tabs.  This toolbar 
includes the following features: 

 Add Polygon – used to add a new forest polygon.  (The new polygon is attribute data only and 
will not appear in Map view.) 

 Split Polygon – used to split an existing forest polygon.  (The split is to attribute data only.  
The original extent of the now split polygon will still appear in Map view, and can be selected 

                                                 
1 This task can also be accomplished for an entire project through the Edit menu Remove all "Imported 
.LOT Yields" function 
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Small Map 

Comments section

VRI data section

through the Map view.  However, the split-off poly area cannot be selected through the map 
view interface.) 

 Add Classification – used to add a new classifier for the forest polygon.  

 Rename Polygon – used to rename an existing polygon name.   

7.2.1	Information	Displays	–	Small	Map,	Comments,	VRI,	Yield	Graphs	

The following information display buttons are listed along the top right side of the Polygon View 
tab window, allowing you to toggle on or off various displays of information by clicking them: 

 Small Map - The “Small Map” button is used to turn on or off the individual polygon map 
displayed at the upper right, if you loaded a shp file for forest polygons into Woodlot.  This 
map includes the polygon shape and map label for the forest polygon selected in the 
navigation tree at left.  The grid used is 100m x 100m (= 1ha).  Refer also to section 7.8 Map. 

 Comments - Comments may be added to each polygon in Woodlot.  Click on the “Comments” 
button to display a comments box section, ready for you to type in.  Comments will be saved 
with the polygon.  Unclick the button to hide comments. 

 VRI - Key VRI inventory attributes may be displayed or hidden by clicking the “VRI” button on 
or off.  VRI data is base forest inventory data provided by FLNROD, used as a starting point 
for your timber supply analysis, a reference for updating your polygons, and for other complex 
analysis such as accounting for MPB dead volume. 
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Yield Graph buttons and 
summary yield graph 
results.   
 
Click on the yield graph 
button to display the yield 

Click on the mini graph to 
display the yield table. 

 

 Yield Graphs - The “Yield Graphs” button will display and hide the small yield graph under 
your yield type for that polygon below the “Existing Stand” and “Reforest” stand. 
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7.3 Navigation Tree 

The navigation tree is located along the left side of the Polygon View tab.  As you toggle on the 
list of polygons, the polygon information will display at the right. 

With the navigation tree, you can: 

 Quickly move between polygons.  The selected polygon number will display at the top of the 
workspace. 

 Display your data by Group.  The groups are listed above in the “Group by” list box.  
Generally, this includes the summary by FMLB, Mapsheet, Ownership, and any classifications 
you have added.  Select on the Group to organize your display list. 

 Sort your data.  Select on the “Sort by” list box to sort polygons by Mapsheet/Polygon number, 
Age, or Area, from greatest to least. 

To help your work in the Polygon tab, a colour scheme has been added to the polygon icons to 
describe at a glance the status of yields and polygons in the project.  The following legend applies 
to the icons in the navigation tree.  The same general scheme is carried forward to the Tabular 
View and the Map View tabs. 
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Icon  Yield Status Legend 

 
Green ‐ the polygon is forested and available for harvest (harvest parameters have been met).  
It is part of the FMLB and can contribute to the AAC. 

 

Yellow ‐ the Existing Forest polygon is not satisfactorily restocked (NSR).  This stand will 
contribute to the AAC if a Reforest stand is assigned to it., otherwise it will have no 
contribution to timber supply over time. 

 
? with red background ‐ the polygon is forested but yields need to be calculated or there is an 
issue with the yield information. 

 

Mustard brown ‐ the polygon is forested but will not be harvested and will not contribute to 
the AAC.  It either does not meet minimum harvest parameters or has been set to do not 
harvest.  It will contribute to meeting forest cover constraints. 

This will include NC polygons (or any forest polygons) that have the silviculture system set to 
“Do Not Harvest”.  Note: You will need to change the silviculture system to harvest and 
provide a “Reforest to” regime for the polygon before it will be available for harvest, changing 
to green or yellow. 

 
Grey ‐ the polygon is not forested and does not contribute to the AAC or forest cover 
constraints.  It is not FMLB.  In the FMLB group of polygons, these polygons are denoted with a 
“No (reason)”, meaning it is not FMLB, followed by the reason. 

 

Red hatch – the polygon is selected for viewing in the Tabular View and Map View (if a map is 
available).  To select and de‐select polygons, double click on their icon in the navigation tree, 
or on the small map, or right click on the Map view polygon. 

092G094 
Bold text polygon number – represents the selected polygon you are working on in the 
workspace.  It will also display at the top of the workspace in bold and yellow highlight. 

 

7.4 Summary 

You can generate a quick area/volume summary for your woodlot.  In the navigation tree, click 
on a Folder icon to produce a summary table.  A more detailed summary is produced in the 
Woodlot report. 

To copy the Summary 
table to another 
application such as 
Excel or Word, navigate 
to the Edit menu and 
select “Copy Summary”.  
Paste the table of data 
in the other application. 
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7.5 Area 

The Area section displays the area attributes for the polygon, including: 

 Gross Area (ha) - shown in square 
brackets if it has been imported.  You can 
override the area by typing over it.  (Four 
decimals are used if data is derived from a 
GIS to avoid addition errors.)  

 FMLB – the classifier of Forest 
Management Landbase (FMLB) has been 
included in Woodlot 4, based on VRI 
terminology.   

If the polygon is considered forestland it 
will contribute to the woodlot timber supply, 
and the FMLB code used is “Yes”.   The 
polygon icon will be displayed as green if harvest parameters can be met, yellow if it is NSR, 
or mustard brown if it is forestland but the harvest parameters will not be met.  Polygons with 
forest cover below minimum harvest parameters will not be harvested but will contribute to 
forest cover constraints. 

If the polygon is non-forest it will not contribute to the woodlot timber supply and the FMLB 
code will be “No” with the reason why it is excluded.  The excluded polygon icon will show as 
grey.  These polygons will not contribute to forest cover constraints. 

You can override the contribution by selecting on the drop-down list box to reclassify it from 
Yes to No, or from No to Yes.   

You can edit the classifiers and use your own terms.  Click on the underlined FMLB text to 
bring up the editing dialogue.   

 Reduction – to show an area reduction on your polygon, check the box on .  You can make 
an area reduction (ha) or use a % reduction.  If you use a % reduction, the % value will display 
and be reduced in the Net Area.  Remember to add your reason.  No volume will be harvested 
from the area removed from the polygon. 

 Future Roads (ha or %) reduction - You can make a reduction for future roads as an area 
reduction (ha) or use a % reduction.  If you use a % reduction, the % value will display and be 
reduced in the Net Area.  Timber will be harvested from the future road area on the next 
harvest pass, but after that the road area will not grow trees for future harvests. 

 Net Area (ha) – the Net Area will be the reduced area after exclusions or reductions.  This is 
the area that will be used in long-term timber supply calculations for this polygon. 
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7.6 Classifiers 

Classifiers are used in Woodlot 4 to organize data for later reporting and analysis.  They can 
help in summarizing your data, help in analyzing polygons of similar classification, and help to 
delineate forest cover constraints by polygon.  Classifiers are a new addition to Woodlot for 
Windows software. 

Ownership for each polygon is delineated in Woodlot using Classifiers.    

In addition to ownership, you may want to distinguish forest management constraints on 
polygons classified as VQO or Deer Winter Range.  The list and constraints are added in the 
Polygon View tab and activated in the Calculations tab. 

Your polygons can be sorted by classification in the navigation tree.   

 

 

 

 

 

 

 

 

The Classifier section includes:  

 Ownership – by default, Woodlot includes a classifier for ownership.  You can distinguish 
whether the polygon is Crown, Private, Top-up, Other or none by selecting one from the drop-
down list box. 

 Classifications – to add another classifier for your polygons, 
on the toolbar, click the Add Classification toolbar item and 
follow the prompts.   

To delete the classifier, click on the underlined classifier 
name to bring up the edit dialogue window; check on the 
Delete Classifier checkbox.   

Note: The Ownership classification cannot be deleted, as it is 
used to distinguish ownership. 

 Classifiers – to add, edit or delete a sub classifier for your 
classification, click on the underlined classifier name to open 
an editing window.  For example, if you have a VQO 
classification, you may want to have sub classifiers for Retention or Partial Retention, which 
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you can apply different cover constraints to later in the Calculations Tab.  If you choose the 
“Delete Classifier” checkbox and return to the Polygon View, the classifier will show up as 
“(deleted)” and will be removed permanently once you close Woodlot. 

Once a classifier has been created in any polygon, it can be activated in other polygons in the 
woodlot by selecting the classifier from the drop-down list box.  Leave them listed as “none” if they 
are not to be used. 

Classifiers can be automatically imported by creating fields that start with either c_ or class_ in the 
inventory data set prior to importing it into Woodlot.  A common approach is to use the overlay 
capabilities of a GIS system to add mapped classifiers such as UWR or visual constraints to 
inventory data.  As long as the class ID fields in the new resultant layer are prefixed with c_ or 
class_, the classification scheme will be imported into Woodlot 4 with the inventory data in .shp 
format.  Upper case and lower-case classifier names can be used. 

7.7 BEC Zone 

Another important new addition to Woodlot for Windows software is the addition of the BEC 
Zone.  BEC is now required in VDYP7. 

The BEC Zone is displayed in the classifiers section on the Polygon View tab.   

The default BEC Zone set on the Project parameters tab is displayed in the drop-down list with “[ 
]” square brackets, and will be used if the square brackets are chosen.  Otherwise, you can over-
ride the default by manually selecting a BEC zone. 

Note that the correct BEC for each polygon will be included in a VRI data set, and can be included 
in a CSV file if you are importing data. 

If the woodlot has multiple BEC zones, and you did not use VRI as source data, you will be 
needing to check and possibly update the BEC zone for each polygon.   

7.8 Small Map 

A small map of your forest polygon will display at the far right if you have imported a shp file with 
graphics.  The polygon will be colour coded the same as in the navigation tree.  It will include 
the polygon label.  The map can be displayed or hidden by clicking the “Small Map” button.   
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The map will not be displayed if you have not loaded a shapefile, or have not yet linked a 
shapefile with a non-spatial data set such as a Woodlot 3.2 lot file. 

The grid spacing shown in the map measures 100 m x 100 m (1 ha). 

Double click the polygon in the map to select 
it on the Tabular view and the Map view.  
The polygon and navigation tree icon will 
show hatched.  Double click to unselect the 
polygon in the views.  

7.9 Existing Forest 

The Existing Forest section provides attributes for the existing state of your polygon. This is 
where you: 

 select the intended silviculture system,  

 enter basic timber yield information,  

 select the growth and yield model/type for your polygon, and  

 view results of the yield curve for the current forest.   

This is a merging of forest management information previously included on the Polygon Data 
screen of Woodlot 3.2. 
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7.9.1	Silviculture	System	

Select the Silviculture System for your forest polygon from the drop-down list box.  The choices 
are as follows: 

 Do Not Harvest.  For use if you do not intend to harvest the polygon.  For example, if it is 
intended to be a wildlife habitat, long-term retention area or simply not available for harvest.  
Selecting this will activate the Reforest screen; a “Do Not Harvest” window will display with a 
description box to add your reason if any.  Polygons tagged as Do Not Harvest will still be 
used to offset forest cover requirements/constraints.  (This is a new feature in Woodlot 4; 
Woodlot 3.2 required the user to set the harvest age to 999 yrs if the harvest was deferred). 

 Clearcut (No Change).  For use if you intend to clearcut and manage the polygon as the same 
yield type in subsequent rotations.  Selecting this will activate the Reforest screen.  In the 
Reforest screen, a “Regen Delay (yrs)” window will display.  Enter the number of years for 
regeneration.  This value will auto-populate from the project defaults, but can be changed on a 
polygon by polygon basis.  Year 1 of future stand growth will start at the end of the 
regeneration period.  (Note: Woodlot will default the polygon clearcut volume to 0m3/ha if the 
volume is left blank in a data file.) 

 Clearcut (Reforest To).  For use if you intend to clearcut and manage the polygon in another 
forest type or yield type.  Selecting this will activate the Reforest screen.  See “Reforest” 
section 7.10 on how to enter your reforestation data.  Click the + plus button to display the 
Reforest to details screen and yield types available, which includes VDYP, TIPSY, NC, NSR, 
TASS and custom. 

 Partial Cut.  For use if you intend to do multiple partial removal entries over time to your 
polygon.  Selecting this will activate the Partial Cut window.  Enter the partial cut methodology, 
Removal (%), and Re-entry Period (yrs).  These values will auto-populate from the project 
defaults, but can be changed on a polygon by polygon basis.   

The “Average Age” method is the method used in Woodlot 3.2 whereby a partial cut harvest is 
modeled by reducing average stand age.    

For information on default settings used by Woodlot for partial cutting, please refer to 
Section 6.4 Partial Cut Defaults. 

For more on partial cutting in Woodlot 4 and the variables used, refer to Section 6.3 and 
Appendix 1. 
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7.9.2	Forest	Polygon	Information	

In the upper portion of the Existing Forest quadrant in the Polygon View tab you enter the 
following forest information for the current polygon: 

 Site Index –enter the site index in m (breast height age 50 years) for the leading species.  The 
Site Index displayed in the Existing Forest and Reforest will be used to derive yields. 

 Age (yrs) –age of the leading species of the existing forest polygon at the base year showing 
on the Project tab.  For example, if the base year on the Project tab is 2016 and you know the 
age of the stand is 100 in 2016, enter 100 years for age for your polygon.  

Note that the Base Year entered on the Project tab applies to all polygons in that woodlot.  
The Base Year in Woodlot for Windows is the year the stand age is determined at, and is 
shown next to the polygon age in the Polygon View tab. 

 

 

 

 

 

 

 

 

 

 

If you have any questions on how the Base Year is used, please consult with your Woodlot 
support contact. 

Note: If you are importing data, refer to Section 6.1 for a description of options to deal with 
multiple aged inventory data.  You will want to ensure that the polygon ages displayed in the 
Polygon View tab are for the Base Year displayed on the Project tab. 

 Harvest Age (yrs) – The harvest age will be calculated for you by default as the age at which 
all your harvest parameters are met or culmination age, whichever is greater.  You can 
override the harvest age by typing over this cell.  An age displayed in [ ] square brackets is the 
default harvest age, which will be used unless you manually override it. 

Note: The harvest age is used to set the earliest age the polygon can be harvested in the AAC 
calculations.  If the polygon harvest is delayed in the calculation past the harvest age, the 
calculation will use the volume from the actual, older age at harvest. 
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7.9.3	Calculate	Site	Index	

You can calculate the site index for your forest polygon if you do not know it or wish to calculate 
it for another reason.  Woodlot uses Sindex to derive site index.  Sindex is the site index 
estimating tool used by TIPSY and VDYP7. 

Note that once you change the site index the forest polygon will need to have the yield 
recalculated.   

In the Existing Forest screen, click on the “Calculate SI” button to activate the Calculate Site 
Index dialogue screen.  Enter data for your polygon starting with the Leading Species, then 
either Breast Height Age (yrs) or Total Age (yrs), and the height (m) of the leading species.   

Site index BH50 will be calculated for the polygon (shown in green), and will replace the site 
index in the existing forest.   

The polygon will be marked in the navigation tree icon with a “?” signifying that the yield needs 
to be recalculated for that polygon. 
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7.9.4	Yield	Type	and	Yield	Settings	

To open the Yield Settings window, single-click on the coloured Yield Type section in the 
Polygon View tab.  Likewise, to open the Yield Table, click the yield curve graph. 

 

 

 

 

 

 

 

 

 

 

 

The Yield Setting window and the summary is colour coded by yield.  To edit and update yields, 
you will first need to update the yield settings.   

In the Yield Settings window, select a yield 
type and enter or update the yield data.  
The stand age, site index and BEC are 
displayed at the bottom of the window for 
easy reference.  Click Save Changes when 
you have entered your data and are ready 
to calculate your yields. 

The Yield Types include VDYP, TIPSY, NC, 
NSR, TASS, and Custom as follows. 

To open the Yield 
Settings window, click 
on one of the coloured 
Yield Type sections. 

To open the Yield Table 
window, click on one of 
the yield curve graphs. 
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VDYP	Yields	

VDYP7 is used in Woodlot 4.  VDYP polygons will display as a light brown (see above 
example).  Data required includes:  

 Species - selected from the pick list.  Species % 
composition must add to 100%.  Double click on 
the last species % to auto update to 100%.  
Cells will display in red if they do not add to 
100%. 

 Utilization level - selected at the bottom and 
displayed next to the Include check box by 
species.  Utilization levels include 12.5 cm dbh 
and 17.5 cm dbh, based on FLNROD standard 
utilization levels used in TSRs.  Utilization levels 
can be selected also in the Project tab.  (Note: If 
a custom utilization level or profile is required, 
you can create one by copying, renaming and 
editing one of the utilizations *.dat files found in 
C:\Program Files\Woodlot for Windows 
4\Woodlot) 

 Include species - checked on to harvest them 
and utilize their volume in the harvest calculation; uncheck if you wish to harvest but not utilize 
their volume in the harvest calculation (for example, some locations may cut the deciduous 
species as part of the harvest process but are not expected to utilize the volume). 

 Reference Total Age (yrs) – age of the stand at the reference year.  You will also supply either 
Basal Area and Trees per Hectare, or Crown Closure at this reference year to VDYP 7. 

 Reference Height (m) - Reference height is calculated in Woodlot by default (shown by [ ] 
square brackets) using Sindex.  Sindex is a model, built into Woodlot 4 which is used to 
generate reference heights for a given reference age and site index.  You can override the 
default by typing over the cell if you have better site information. 

 Volume Adjustment Factor (VAF) - Assumed to be 1.00 unless you have better information.  
The VAF scales the volume for all species up or down by that amount.  For example, a VAF of 
1.10 would scale the volumes by 110%. 

 Note: VAF has no impact on volume prediction for some young stands.  If you wish to adjust 
the predicted volume of a currently young stand to align with observed values, you may have 
to change Reference Age and Crown Closure to achieve the desired adjustment.  

 “Estimate Yield Using” – in this section, select the radio button to determine how VDYP should 
calculate your yields.  Two methods are available in VDYP7, either using Basal Area & TPH, 
or using Crown Closure.  Both require data at your stand reference age. 

Basal Area & TPH method (radio button) – Select and use Basal Area (BA) and Trees per 
Hectare (TPH) at the stand reference age if this data is available.  This is the 
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recommended method in VDYP7, as BA and TPH are measures of stand density, which 
are used to estimate yields, and is considered the more accurate method.  Be sure to use 
the BA and TPH at the stand reference age. 

Alternately, if BA and TPH are not available, you can use Crown Closure as follows. 

Crown Closure method (radio button) – If BA & TPH are not available, select and use 
Crown Closure at the stand reference age.  This will trigger the “FIPSTART” function in 
VDYP7 to estimate yields.  Crown closure is used in VDYP7 as a proxy to estimate basal 
area, which is then used to project yields.   

If you select this method and have not entered a Crown Closure, Woodlot will use a 
Ministry default Crown Closure for you, and will display [ ] square brackets; you can 
override the default value by typing over the cell if you have better information.  Default 
Crown Closure is usually based on a mature stand, so if you have a young stand, typically 
< 50 yrs old, you will need to enter the correct Crown Closure or the yield estimate will be 
wrong.  In any case, it is not recommended to use the Ministry default Crown Closure 
unless it is reflective of the stand reference age, such as old growth types. 

Note I: If you are using the Crown Closure method be sure to use the Crown Closure at the 
stand reference age, as VDYP 7 uses the inventory attributes at the reference age.  This 
differs from earlier versions of Woodlot and VDYP 6 wherein the Crown Closure used was 
estimated CC at harvest age.)   

Note II:  The user may wish to review the VDYP 7 predicted volumes at harvest for stands 
currently < 50 years old.  Crown closure of young stands is difficult to estimate or measure, 
and a small change in estimated crown closure for a young stand may have a significant 
impact on predicted harvest age volume.  The user may wish to compare VDYP predicted 
volume at harvest age with known volume at harvest age from cruise or scale records, 
including waste.  

The crown closure at stand reference age can be adjusted to align VDYP predicted volumes 
with known harvest volumes.   

In some cases, adjustment of both stand reference age and crown closure to the values of 
the pre-harvest stand may be required to generate a predicted volume that aligns with 
known harvest volume. 

The user should document and support any such changes from the VRI data set on a 
polygon by polygon basis, and expect to provide a rationale for the changes in their 
Management Plan. 

For more information on VDYP7 and the yield estimating options, please refer to Section 
4.6, to the VDYP7 Help, or contact the Forest Analysis and Inventory Branch, Stand 
Development Modeling section. 
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TIPSY	Yields	

TIPSY 4.3 is used in Woodlot 4 to estimate yields of managed stands.  Managed stands are 
typically planted, spaced or fertilized stands.  They also include naturally regenerated stands that 
have been managed to a free growing state or with stocking control.  Typically, these stands are 
less than 50 years’ age, and generally, they include all recently reforested sites.  TIPSY polygons 
will display as a light green.  Data required includes: 

 Species - selected from the pick list.  Species 
% composition must add to 100%.  Double 
click on the last species % to auto update to 
100%.  Cells will display in red if they do not 
add to 100%. 

 Utilization level - selected in the Project View 
tab and displayed next to the Include check 
box by species.  TIPSY utilization is assumed 
to be 12.5 cm dbh for all species.  If you wish 
to use a different utilization level, review the 
discussion in Section 6.7 

 Included species - checked to include volume 
in harvest volume calculation.  Uncheck if you 
do not wish to utilize in harvest volume 
calculation. 

 Regen Method – Natural, Planted or Clumped.  

 Initial Density (#/ha) –Initial stocking level following reforestation. 

 Reference Height (m).  Reference height is calculated by default (shown by [ ] square 
brackets) using Sindex (internal to Woodlot).  You can override the default by typing over if 
you have better site information. 

 OAF1 and OAF2 – Operational Adjustment Factors, provided as defaults in [ ] square 
brackets.  Can be overridden by typing over the cells.  (Note: You should be prepared to 
provide a rationale is you chose to use something other than the defaults, which are usually 
OAF1 = 0.85 and OAF2 = 0.95.  Refer also to Section 6.3 or TIPSY Help for more on TIPSY 
OAFs. 

 Pre-commercial thin (Optional) – Activate by selecting the checkbox, and enter your thinned to 
density (# stems/ha).  Check the TIPSY Help if any questions on pre-commercial thinning in 
TIPSY. 

 Commercial Thin (Optional) - Activate by selecting the checkbox and entering the data.  Note: 
Commercial Thin is only available for Fd on the Coast and Pl in the Interior.  Check the TIPSY 
Help to determine applicability before you use this feature. 

 Fertilize (Optional) - Activate by selecting the checkbox and entering the data.  Check the 
TIPSY Help if you propose to use this feature. 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  55  Enfor Consultants Ltd.  

 Genetic Worth % (Optional) - Activate by selecting the checkbox, and enter data for each 
species next to the composition %.  Check the TIPSY Help if you propose to use this feature. 

NC	–	Non	Commercial	Cover	

The NC polygons will display as a light blue.  This feature is included for use for stand conversions, 
and non-commercial or damaged site conversions back into productive forest.  For conversions 
back to productive forest, ensure you activate the Reforest screen by selecting the "Clearcut 
(Reforest To) silviculture system.  You can use either TIPSY or VDYP yield predictions for the 
future forest.  Data required includes: 

 Harvest in (yr.) – the number of years from present 
that you intend to harvest the volume on the current 
stand as part of the stand conversion. 

 Net Harvest Volume (m³) – your estimate of the net 
merchantable volume you expect to recover on the 
conversion harvest. 

 Deciduous Percent (%) – the proportion of 
merchantable deciduous on the stand at the 
conversion harvest. 

 Heights (m) – average stand height, for use in 
meeting forest cover constraints of the stand. 

 Description – enter a description if any of the stand. 

 

NSR	–	Not	Satisfactorily	Restocked	

NSR polygons can be added, and will display as a light 
yellow.   

Some stands may be currently considered NSR, in which 
case you can use this feature to track them in the 
beginning of your analysis.   

 Restock in (yrs) - enter the number of years when 
you intend to fully restock the stand.  This will be 
akin to setting a regen delay, and the start of the 
new forest cycle. 

It is recommended that you activate the Reforest screen 
using the TIPSY yield type for these polygons if the new 
stand will be/was established by planting or natural regeneration and is considered managed.  If 
you will manage the stand using partial cutting, then you will need to use the VDYP yield type.
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Import txt file 

TASS	–	Tree	and	Stand	Simulator	Yields	

this is a future feature and currently not active in 
Woodlot 4.  This will display as a light blue window.   

 

 

 

 

 

 

 

 

Custom	Yield	

You can import a custom yield table for your polygons.  This is a new feature in Woodlot 4.  It does 
not require the yield to be produced in Woodlot.   

From the Yield Type drop down, click on Custom.  This will display a blank light magenta window, 
ready for importing your data or displaying the imported data. 

 

You will need a tab delimited text file with the following column headers and data to import into 
Woodlot 4.  Note: [ ] square brackets denote fields where header names are required but for which 
data is optional, as Woodlot will calculate this number from the rest of the data.  
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Only data in the required format will be imported, including: 

 Age – age increment in years (required data). 

 Volume – total net volume m3/ha.  Data for this field is optional as Woodlot will calculate the 
total volume from your species volumes and use this as the total net Volume m3/ha.  (Optional 
data). 

 Height – in meters (required data). 

 DBH – diameter at breast height in cm (required data). 

 MAI – mean annual increment, m3/ha/yr.  Data in this table field is optional as Woodlot will 
calculate the MAI from the total volume, by age.  This field must be included in table structure 
even if you do not populate it with your own data. 

 Basal Area in m2/ha (required data). 

 TPH – trees per hectare (required data). 

 Species 1 net volume m3/ha – the header name will be the VRI species code (for example, 
CW = western redcedar) and the data will be the net volume m3/ha for that species. (Required 
data). 

 Species 2 to Species 6 - similar data to Species 1 as above (required data). 

 

The following is an example of a tab delimited text file used for importing a custom yield table to 
Woodlot 4: 
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7.9.5	Convert	Dead	Stands	to	Non‐Commercial	Stands	

Following extensive natural disturbance in a woodlot, such as from Mountain Pine Beetle, you 
may wish to model the AAC implications of salvage harvest and conversion of the dead stands 
to a new forest or an advanced regeneration forest.   

If your data set contains the VRI Dead Percent attribute, you can use the Convert Dead Stands 
to Non-Commercial tool to help set up the harvest and stand conversion of the high mortality 
existing stands.  

The tool will select all stands with more than a user specified mortality level, and reclassify them 
as “non-commercial” yield type in Woodlot.  The existing forest will retain the volume and other 
attributes provided from the VRI inventory.   

When you run the AAC calculation, NC polygons that have been assigned a silviculture system 
and reforestation regime will be moved to the top priority for harvest, available at the earliest 
possible time.  Note that the polygon will not be harvested if the silviculture system has not been 
set to "harvest", and volume will not accumulate until the year the stand is reforested. 

To activate this feature, navigate to the Edit menu, 
select “Convert Dead Stands to Non-Commercial”.   

 

 

 

A “Convert to NC” dialogue window will appear.  Enter 
the minimum percent dead volume in a polygon that 
will trigger the batch updating process.  Polygons with 
more than or equal to this level of dead volume will be 
updated.  Dead percent is a standard VRI data set 
attribute. 

Following the conversion to non-commercial: 

 The stand will not grow further volume until harvest and reforestation have been carried out. 

 Current silvicultural system will be defaulted to Do Not Harvest.  The user will need to change 
this to Clearcut - Reforest To. 

 Once the Silviculture System is changed, the Live Volume will be identified as available for 
harvest at the earliest possible time (Harvest In: 0 years). If you believe that there is a feasible 
opportunity to salvage the dead volume, double click the purple NC area and edit the Net Harv 
Volume listing to include the portion of the dead volume you believe will be salvaged.   

 The user will need to provide Reforest To information for the polygon. 
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 The purple NC section will appear in the Polygon View window in place of the usual VDYP 
information, showing the harvest attributes for each polygon. 

 Icons in the navigation tree will change to the mustard brown for NC.   

 
Details and discussion follow. 

After a stand has been converted 
to Non-Commercial, the yield 
model type will change from 
VDYP to Non-Commercial.  The 
purple NC section will appear, 
replacing the usual VDYP 
information, showing the harvest 
attributes for each polygon, 
including live volume, dead 
volume, and volume to be 
harvested. 

Woodlot populate the volume and 
stand attributes from the VRI 
inventory data.   

Default harvest volume is live 
volume.  You can adjust harvest 
volume to include merchantable 
dead volume in the Yield Settings 
(see below). 

Icons in the navigation tree will 
change to mustard brown for NC until you set the silviculture system and reforestation regime 
(mustard brown = polygon will not be harvested).   

The user must enter the appropriate "Silviculture System” and “Reforest to” regime for each NC 
polygon.  This future stand description process was not automated in Woodlot because it 
requires judgments that are best made by a forest professional undertaking the analysis.   

Silviculture system will often be "Clearcut - Reforest To".  When this choice is made, Woodlot 
will copy the current stand species composition to the Reforest To window.  The user can edit 
these values as desired. 

If TIPSY is used to model future yields, the program will populate all the data fields required to 
calculate future yields.  The user should review the defaults to be sure they agree, or edit as 
required. 

If VDYP is used to model future yields, the user will have to fill in basal area, trees/ha, reference 
total age and reference height.  For yield modeling purposes, the trees/ha value should be total 
stems, including both current live and dead stems, as this total represents the growth potential of 
the site.  These numbers can be transcribed from the VRI window of information for the polygon. 
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Once you set the silviculture system, the icon will change from mustard brown to “?”.  Add a 
reforest to stand, recalculate the yield for this polygon.  The icon will change to yellow in the 
navigation tree.  Yellow represents NSR, as the stand is assumed to be NSR until it is cleared 
and reforested. 

Adding a silviculture system to the polygon will 
make the current standing live volume available 
for harvest.  To adjust the current harvest 
attributes and harvest volume of any NC 
polygon, click the purple NC screen to activate 
the polygon “Yield Settings” dialogue window.  
Harvest attributes include Harvest in (yrs), Net 
Harv. Volume (m3/ha), Deciduous Percent %, 
and target Height (m).  By default, Woodlot will 
set the net harvestable volume to the live 
volume only, which you can change. 

By default, Woodlot will set the net harvestable 
volume m3/ha to the live volume only in the 
polygon (per the VRI data) because the 
inclusion and merchantability of the dead 
volume is a judgment call.  If you believe that all 
or a portion of the dead volume will be sold at 
harvest, add the appropriate dead m3/ha to the 
live volume and enter this total m3/ha in Net 
Harv. Volume (m3/ha).  For your reference, the dead volume is displayed on the NC yield type 
on the Polygon View tab and also under the VRI view.   

When you run the AAC calculation, NC polygons that have been assigned a silviculture system 
and reforestation regime will be moved to the top priority for harvest, available at the earliest 
possible time.  Note that the polygon will not be harvested if the silviculture system has not been 
set to "harvest", and volume will not accumulate until the year the stand is reforested. 

To ensure that the polygon will be harvested and will contribute to your AAC, ensure you set up 
the harvest assumptions in the NC yield type. 

Refer also to Section 7.9.4 Yield Type and Yield Settings for more information on the silviculture 
system and the future forest regeneration scenario settings. 
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7.9.6	Yield	Curves	and	Yield	Tables	

At the bottom of the Polygon View screen is a yield curve summary for both the Existing Forest 
and the Reforest To sections.  It will display as a set of mini curves if the yields have been 
calculated and blank if no yield has been calculated.  It will display the culmination age and 
harvest age.  Complete curves and tables are available as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Yield Curve Graphs 

To view the yield curve graph, click the Plotsy 
icon (at the bottom right of the small graph 
located below the yield data table).  This will 
activate and display the graphing program 
“Plotsy” with the yield curves.  The yield curve 
graph can be saved and managed in Plotsy.   

If you have any questions about using these 
graphs, please refer to the toolbars in Plotsy 
and the Plotsy Help.  Plotsy is a powerful 
FLNROD graphing utility available in TIPSY 
and can be used to overlay multiple graphs, 
copy graphs for reports, print, etc. 
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Yield Tables 

To view tabulated yield data, click anywhere 
on the small graph section.  This will bring up 
the Yield Table window, which has a small 
toolbar, an upper header section and a lower 
table section. 

The upper header section is used to display 
issues in the data or results. 

The lower table section is used to display 
output results.  The culmination age will be 
highlighted. 

You can view and toggle between output and 
input data.  Click the toolbar item from “Output 
Data” to “Input Data” to display data that was used in creating the yield curves. 

To copy the table to memory for pasting to another application such as Excel, click “Copy Table” 
from the Toolbar. 

Click the Plotsy icon if you would like to display the Yield Curve graph. 

Information Messages and Error Messages from VDYP and TIPSY 

A red message is displayed below the Existing Forest and Reforest section if the yield curve has 
not been calculated or if there are errors in creating the yield curve.  Follow the prompts provided.   

(Note: VDYP7 and TIPSY 
each have their own set of 
error messages generated 
if there are issues 
unrelated to Woodlot.  If 
triggered, these error 
messages are displayed in 
the information message 
box below the yield 
results.  Additional 
information on the error 
message may be available 
in the Help for VDYP and 
TIPSY, or by enquiring 
with the specialists at 
Forest Analysis and 
Inventory Branch.) 
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7.10 Reforest 

The Reforest section is used to select attributes for the new forest you plan to establish after 
harvesting.  To activate the Reforest section, select Clearcut (Reforest to) in the Existing Forest 
section under Silviculture System. 

 

 

 

 

 

 

 

 

 

 

 

 

To activate the Yield Settings for the new forest, click either the + plus button or click the Yield 
type screen.  The will bring up the Yield Settings window.   

 Yield Settings - Refer to Section 7.9.3.  Yield settings work similarly in the Existing Forest and 
Reforest sections.  You can rename the Yield Name in Reforest as described below. 

 Reforest to: “Yield Name” - you can create one or many custom sets of reforestation 
parameters that can be used on similar polygons.  Type your yield name in the box and Save 
Changes.  The Yield Name will display in the Reforest to list box and this set of reforestation 
parameters can be selected for use in other polygons. 

 Site Index –enter the site index in m (breast height age 50 years) for the leading species. As a 
default the site index is copied from the Existing Forest section - this value can be manually 
overwritten. 

 Regen Delay - the default value is copied here from the Project Tab panel - this value can be 
overwritten manually. 

 Harvest Age (yrs) – The harvest age will be calculated for you by default as the age at which 
all your harvest parameters are met or culmination age, whichever is greater.  You can 
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override the harvest age by typing over this cell.  An age displayed in [ ] square brackets is the 
default harvest age, which will be used unless you manually override it. 

Note: The harvest age is used to set the earliest age the polygon can be harvested in the AAC 
calculations.  If the polygon harvest is delayed in the calculation past the harvest age, the 
calculation will use the volume from the actual, older age at harvest. 

 Yield Curves and Yield Tables – refer to section 7.9.4.  Yield curves and Yield Tables work the 
same in both Existing Forest and Reforest settings. 

 

7.11 Imported Lot File Yields 

When you import a Woodlot 3.2 lot file, the yield settings and yield results will be imported as well.  
The yields will be those you generated last in Woodlot 3.2.   

The Yield Settings window will be grayed out, and 
at the bottom will display a checkbox “Imported 
from LOT file”.  The polygon yield data and yields 
will be locked until you uncheck the box.  This 
checkbox will be displayed for each yield type that 
you import. 

At this point you can update the yield settings and 
prepare to recalculate your yields if you desire.  
You can either use your own information, or use 
the Woodlot 4 defaults.  Woodlot will 
automatically apply the default values after you 
uncheck the box, which you can choose to use or 
override.  Woodlot 4 defaults are based on 
general provincial default values.  For example, 
TIPSY OAFs will be set to 0.85 and 0.95; VDYP7 
will use default Crown closure based on 
provincial species default values. 
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Calculate Yields 

7.12 Calculating Yields 

You can calculate your yields by clicking the Calculate Yields toolbar item, once you have set up 
your existing forest and reforest parameters.  You can calculate yields from any tab in Woodlot.  
The toolbar item will display the number of polygons that require yields to be calculated (which 
should be the number of polygons represented with a “?” question symbol in the navigation 
tree.) 

Clicking Calculate Yields will bring up a black VDYP Console operation screen and then a 
TIPSY operation screen similar to earlier versions of Woodlot.  A progress bar will display at the 
bottom of the Polygon View tab window.  Once calculated, the black screens will close and 
yields will be complete.  The mini-yield curves will be displayed at the bottom of the screen. 

 

Where you have similar or identical vegetation cover types with duplicate yield types, Woodlot 
will only calculate the yield once and apply results of that yield data to similar polygons. 

If after Calculating Yields there are still some polygons with no timber yield estimates, navigate 
back to the polygons to view the data.  The “Calculate Yields” button will display the number of 
polygons with no estimates, for example (4 to do), and these polygons should still show the “?” 
in the navigation tree.  Failure to calculate yields is generally caused by missing data items.  Fill 
in the missing data and click Calculate Yields again, this should now complete your yields.   

If you have an error, it will be displayed both on the mini yield curve in red text and in the yield 
table.  Click on the mini yield curve to bring up the yield table for a report of errors. 

7.12.1	Recalculating	Yields	

Yields do not need to be updated once calculated if no stand parameters or management 
parameters change.  If parameters do change, you will wish to recalculate your yields.  The 
number of polygons that require updating will be displayed on the Calculate Yields menu item. 

Click the Calculate Yields menu item to calculate those updated polygon yields.  Only those 
polygons with new data will have timber yields recalculated. 
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7.12.2	Recalculating	Imported	Lot	File	Yields	

If you import an old lot file, the yields generated by the earlier version of Woodlot will be 
imported with the lot file 

You can continue to use these in Woodlot 4, or you may wish to refresh them based on the 
newer yield models in Woodlot and any vegetation cover updates you may have.  To do this for 
a single polygon, uncheck the “Imported from LOT file” checkbox and update the Yield settings.  
This will clear out the imported yield estimates; will indicate “no volume” in red on the Polygon 
View window next to harvest age, and will assign the harvest age of “not” for this polygon.  The 
icon next to your polygon number in the navigation tree will show as a “?”. 

You can batch uncheck imported lot file yields from the Edit menu, to save time from manually 
un-checking each one.  Select on “Remove all “Imported .LOT Yields”.  This will clear all your 
polygons and will apply the default Woodlot 4 yield settings.  You can choose to manually edit 
the yield settings for each polygon or proceed to calculate yields.   

The number of polygons that require updating will be displayed on the Calculate Yields menu 
item. 

Click the Calculate Yields menu item to calculate those updated polygon yields.  Only those with 
new data will be recalculated. 

7.12.2	Recalculating	TIPSY	Yields	with	New	Utilization	Parameters	

It is possible to change TIPSY utilization from 12.5 cm to 17.5 cm and then recalculate all 
TIPSY yields.  This is discussed in Section 6.7. 
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7.13 Stands vs Resultants 

The stand includes the existing forest and the reforest to information.  In the Polygon View tab, 
the items (shown in red below) are part of the stand details, the rest of the items are resultant 
details. 

A stand contains one or more 
resultants. 

Each resultant, stores classifier 
values and is linked to a portion of a 
stand.  The graphics and comments 
are linked to the resultant. 

The polygon list in Woodlot 4.4 
displays a list of all the resultants.  
When you click on a resultant, the 
screen displays both the resultant’s 
details and the stand details that the 
resultant is part of.  Since multiple 
resultants can be linked to a single 
stand, updating the stand details 
will affect all the resultants that link 
to that stand. 

During the harvest simulation, the 
harvest priority is defined by stands, 
not by resultants.  Constraints are 
applied by classifiers which are 
applied to resultants rather than the 
whole stand.  When Woodlot 
harvests a stand, it will harvest 
each resultant separately.  If 
harvesting a resultant would exceed 
a constraint, that resultant will be 
scheduled for harvest, independent 
of the rest of the stand.  

 

An unlink feature can be accessed by right clicking on a polygon.  The unlink feature creates a 
duplicate stand and then links the current resultant to the new stand instead. 
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8. Tabular View Tab 

The Tabular View tab can be used to view, edit and report summary forest polygon information.  
Features of this tab are similar to the Summary screen in Woodlot 3.2, with streamlined and 
new features added to Woodlot version 4.1. 

 

Data Display 

The workspace displays your woodlot data summary based on the Column Filter (field names) 
and the Row Filter (polygons) you have selected.  For example, if you want the summary to 
display all typical woodlot report attributes for all of your polygons, the Column Filter will be set 
to {Woodlot Summary} and the Row Filter will be set to {All Rows}.  

The tabular view listing displays the following information for your woodlot: 

 The polygon number is listed in the left column, with a small pointer on the row you have 
selected in Tabular View. 
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 Grey columns of data are Read-only cells.  These numbers have been calculated in the 
Polygon View tab.  They can be edited by editing the calculation in that window. 

 White columns of data are editable cells.  To edit, simply highlight the cell you wish to change 
and enter the new data.  The icon will change to a “?” if your edit results in the yields needing 
to be recalculated (see below).  Note that if you change yield types to check that you update 
all the fields and species information for those polygons. 

 The highlighted row(s) are polygon(s) you have selected in the Polygon View or Map View. 

 Icon colours are the same as used as in the Polygon View tab.  Refer to Section 7.3. 

 Square brackets [ ] represent values derived from defaults in Woodlot. 

 Column headers represent fields of data in the Woodlot wlt file. 

 Columns can be sorted from low to high by clicking on the column header. 

 

Editing Data in Tabular View 

When you edit the white cells of data in 
Tabular View, the polygon Icon(s) will 
change to a “?” if the edit will change 
the yields, and to prompt you that the 
yields need to be re-calculated for that 
polygon(s).  For example, if you 
change the site index for the polygon, 
this will likely result in a different set of yields being calculated from VDYP or TIPSY. 

Your edits will be saved in memory until you close Woodlot, when you will be asked if you wish 
to save your changes.  If you choose no, the edits you made will not be saved. 

 

Reorder Columns 

Columns can be re-ordered by clicking 
and dragging the column header either 
right or left to a new location.  This 
state will remain when you close 
Woodlot and save your changes. 
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Copying Data 

Data in the Tabular View screen can be copied.  Open the table view you are interested in from 
the Column Filter.  From the Edit menu, click on Copy Table to place data from that table view 
into memory, ready for you to paste into another application such as Excel or Word. 

The last arrangement of table views will be saved when you save your file. 

Menu Buttons 

Menu buttons are provided along the right side of the header 
for the following features: 

 Selected Only – click this button to display only those 
polygons you have selected in the Polygon View tab and Map View tab.  Useful if you only 
wish to view certain polygons. 

 Friendly Headers – click this button to switch column header names from variable names to 
user friendly names.  Useful if you are checking variables and data in a file. 

 Expand Codes – click this button to expand the columns of data on some of the tables.   

Right Click Menu 

Select on any cell in the Tabular view and right click to 
bring up the menu.  Time saving features are available 
for: 

 Fill Down – can be used in the white data cells.  
Select the top cell, change or leave as is, highlight a 
group of cells below, right click and select Fill Down.  
This will copy the data from the to the highlighted 
cells. 

 Copy Selected – highlight data in Tabular View you 
want to copy, right click and select Copy Selected to 
put data in the clipboard, ready for you to paste in 
another application such as Excel. 

 Edit Selected – used to edit data in multiple white cells of your choice. 

 Make Selected – highlight multiple cells and click Make Selected to select them in the Polygon 
View or Map View.  The icons will display as red hatch. 

 Select None – will de-select cells showing as highlighted with the red hatch icon. 
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8.1 Column Filter 

The Column Filter includes two default summary tables and allows you to create your own 
custom table from your data set.  Click on the list box to display tables you have available, and 
to create your own custom tables.   

 The two default tables include a {Woodlot Summary} 
and {VRI}, distinguished by the { } brackets.  Each has 
basic information on your woodlot. 

 Your custom tables will be displayed in plain text.  In 
the example adjacent, the project has an “Ownership 
Only” summary table. 

 -New Filter- Select this when you wish to create a 
new table view. 

 

Create a New Column Filter 

To create a new table view, navigate to the Column Filter drop down list box and click on New 
Filter.  This will bring up the “Column Filters” dialogue, which you use to create your table view: 

 

 

 

 

 

 

 

 

 

 

 

 

Under Column Filter, select on the New Filter list box and click “Create” to enter a name for the 
new filter and start configuring the filter.  Refer also to the Column filter search feature, below. 
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Add columns of data by one of the following means: 

 Selecting from Column Type drop down list box.  If you don’t know which type of data to select 
from, leave it on All. 

 Selecting from the Columns list box of data you wish to display.   

Click on Add to add the column of data, or Remove to remove the column of data.  Selected 
columns of data will be greyed out once added. 

The columns will be listed in right side Columns list box. 

 Columns can be re-ordered once in the Tabular View by clicking and dragging the column 
header to a new location. 

 Click “Done” when you are ready to view your new table format in the Tabular View tab. 

The Column Filter menu buttons include: 

 Create – for creating a new column filter. 

 Rename – rename the Column filter name selected. 

 Remove – to delete the Column filter selected. 

 Export – you can also export the wcf (woodlot column filter) format for use by another person.  
The file will be exported for saving as a .wcf file. 

 Import – you can import a .wcf format from another user with the import feature. 

Your new Column filter will be saved with your woodlot project file when you save the project. 

 

Column Filter Search Feature – New in 
Woodlot 4.3 

In the Tabular View, Woodlot 4.3 included a new 
filter in the Column Filter.  The Column Filter now 
has a new “Contains” filter in the selection 
window.   

The columns list will filter to display only column 
names that contain the exact text in the 
“Contains” text box. 
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Edit a Table View 

To edit a table view, in the Tabular View 
screen, select the view from the Column 
Filter list box and click the “Edit” button.   

This will bring up the Column Filters 
dialogue box, where you can make your 
changes. 

Items listed on the left in black text are 
available for adding to your table.  Items 
shown in grey have been added already and 
are displayed in the right list of columns.  
The right list of columns will display in the 
Tabular View. 

 

 

Empty Columns 

A checkbox was added to the Column Filter 
screen in Tabular View to “Show Empty 
Columns.”  Empty columns typically are 
fields of data in your data file that have a 
column header but the data cells below them 
are empty.  

With the checkbox on, empty columns of 
data will be displayed as red in the column 
list.  By default, the checkbox is off and 
empty red columns are not displayed in the 
Column Filters window to simplify the view. 

 

 

8.2 Row Filter 

You can filter out polygons that have specific data you are interested in with the Row Filter feature.  
The filter has no effect on the polygons participating in the final AAC calculation. 

Click on the Row Filter drop-down list box and select the attributes you wish to display polygons 
for.  Woodlot provides a preliminary list of some filters you may wish to choose. 

Otherwise, click “Edit” to create a new Row Filter and follow the instructions below. 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  74  Enfor Consultants Ltd.  

Note: Creating a Row Filter is an advanced feature, which may require you to consult with your 
GIS mapping consultant to set up your attributes. 

 

Creating a New Row Filter 

To create your own custom Row Filter, 
click “Edit” next to the list of Row Filters.   

This will display a Row Filters” dialogue 
box.  Click “Create” to create your new 
Tow Filter and enter the new filter 
name. 

 

 

 

 

Your new filter name will appear in the list box, and the 
Row Filter dialogue will appear ready for you to select the 
attributes to add. 
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Click “Add” on the right side of the Row Filters dialogue box to 
display the attributes you can add to your filter. 

 

 

Click on the attribute you are interested in to select it.   

 

 

This will bring up an Edit Row Filter dialogue box, which you can 
enter the parameters for the attributes for the polygons you wish 
to filter out.  Click “Save Filter”.  This will take you back to the 
Row Filters dialogue box and will display the filter(s) you have 
created. 

 

 

 

Add more filters in the same way as above by 
clicking “Add” and following the same 
sequence as above.  Click “Done” when you 
are finished. 

You can export and save your Row filter for 
use by another person in their file, or import a 
Row Filter using the Export and Import 
buttons. 

Rename or remove filter attributes by 
selecting the filter, and using the 
Rename and Remove buttons. 

When you are done, you will see your 
Row Filter listed in the drop-down list 
box.  Select this to filter the polygons 
in your woodlot for the attributes in 
your Row Filter. 

Your Row Filter will save with your 
woodlot project file when you save the 
file. 
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9. Map View Tab 

The Map View tab is used for viewing a map of your woodlot.  This is a new feature in Woodlot 
4 and will assist you in recognizing polygons and their spatial configuration.  If you are not 
familiar with digital maps or GIS, you may want to seek assistance from a mapping consultant or 
inventory forester when preparing files for use in Map View. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Map View displays the map of your woodlot if you have imported a VRI shp file to Woodlot 
4.  Refer to Section 3.2 for more on map file formats that may be imported.   

If you are working with a Woodlot 3.2 lot file, no map will be displayed unless you have imported 
a corresponding shp file and linked it with the polygon data. 

To select a polygon in the map view screen, hover your mouse and right-click the polygon.  The 
polygon will display as a red hatch and can be zoomed to. 
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Draw an area 
of interest box

Map View includes the following basic features: 

 Themed map of your woodlot with forest polygons and forest cover labels, with a legend. 

 To adjust label displays, use the Labels selection box in the menu.  Refer to the Map Toolbar 
description below for options. 

 The map is colour coded using colours in the Polygon View navigation tree.  Green represents 
forested polygons, yellow for NSR polygons, grey for excluded polygons (such as lakes and 
rock), red hatched for selected polygons. 

To select and highlight polygons, right click on the map polygon (hatch on).  To un-select a 
highlighted polygon, right click again (hatch off).  Hatched polygons will display in the Polygon 
View and Tabular View as hatched icons. 

Note that polygons split or added within Woodlot cannot be properly selected with the Map 
view interface. 

If any of the polygons are missing of which you know that should be visible, uncheck Hide non-
FLMB in the View menu to verify if the polygon was invisible because it is non-FLMB. 

 

9.1 Navigating the Map 

To navigate around the map: 

 Click “Zoom All” to return 
the map to the starting 
position.  Use this if you 
lose the map. 

 To zoom in, left click, 
hold and draw a box on 
your area of interest. 

 Use the scroll wheel to 
zoom in and out.  Be 
careful where you 
position the mouse as 
this will affect how the 
map will zoom in and 
out. 

 The information bar at 
the bottom of the screen 
lists the polygon number 
that your mouse cursor 
hovers over. 
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9.2 Map Toolbar 

In Woodlot 4.4, the Woodlot map buttons are now located on the toolbar in the Map View 
(above the map), with features added or enhanced. 

 

Map toolbar features and enhancements include: 

1. Zoom Selected – clicking this button scales the map so the selected polygons (shown in 
hatching) fill the map window. 

2. Zoom Current – clicking this button scales the map so the current (last selected) polygon fills 
the map window. 

3. Labels – map label options include: 

a. Automatic – Same as Woodlot 4.3.  See below. 

b. Existing Forest – A label generated from the Existing Forest settings. 

c. Future Forest – A label generated from the Future Forest settings. 

d. VRI – The multi-line label imported from VRI. 

e. Override – A custom label than can be specified on the Rename polygon screen. 
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9.3 Automatic Label Order 

The Automatic label order is as follows: 

1. Uses the “Map Label Override” from Rename Polygon (if it is not blank).  To create the map 
label override, in the Polygon tab click the polygon number to activate the Rename Polygon 
dialogue box.  In the Map Label Override box type in your new label.  This will display on the 
small map and on the main map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Otherwise, uses the VRI “Full Label” if there is VRI data for this polygon.  The Full Label 
column can be viewed in the Tabular View. 

3. Otherwise, uses the label based on the Existing Forest “FC Label” from the Woodlot Report 
b) Polygon Data table. 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  80  Enfor Consultants Ltd.  

10. Calculations Tab 

The Calculations tab is used to undertake harvest rate calculations for your woodlot, and to 
create harvest planning reports and graphs.  Features of the Calculations tab are similar to the 
Calculations screen in Woodlot 3.2, with streamlined and new features added.  The calculations 
and reports are used to support an AAC determination by the District Manager. 

In Woodlot 4, like Woodlot 3.2, a non-declining even flow (flat line) sustainable harvest rate is 
calculated over a 250-year planning horizon, which is FLNROD policy for woodlot licences in 
BC.   

An iterative harvest rate calculation is performed on polygons identified in the Harvest Order.  
Calculations use the forest polygon yield and management information shown in the Polygon 
View tab.  Forest cover constraints can be applied to simulate the impact on timber supply of 
non-timber values that do not preclude harvesting.   

The sustainable annual harvest rate (m³/year) is shown next to the Calculate button and in the 
information bar at the bottom.  The resulting harvest schedule is displayed in the table at the top 
right and can be viewed in several helpful ways by selecting on one of the radio buttons.  The 
resulting volume over time graph is displayed at the bottom right.  Reports and graphs can be 
generated from the Reports menu item.   
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The Calculations tab is split into the following functional sections, described below: 

 Harvest Priority 

 Harvest Order 

 Constraints 

 Calculate AAC 

 Harvest Schedule 

 Standing Volume/Time graph 

Click the Calculate button to calculate the sustainable harvest rate once you have identified the 
harvest priority and harvest order.  The Calculate button will show red if any data or assumptions 
have changed since the last time a harvest rate was calculated.  A new harvest schedule and 
Standing Volume/Time graph will display for your review.  You can also produce a Woodlot 
Harvest Planning Report and graphs. 

10.1 Harvest Priority 

The harvest priority section is used to identify the order in which polygons will be scheduled for 
harvest first.  The priority can be based on up to six (6) prioritizing options starting with the 
highest priority at the top.  You add these by selecting on the checkboxes.   

 

The order will be displayed in the Harvest Order section below, starting with the highest priority 
first.  The harvest schedule is then run in this sequence.  If a polygon has not met its harvest 
parameters by the time it is scheduled for harvest, it will be put in a queue and harvested once 
they are met. 

The harvest priority for the first few polygons can be forced by manually scheduling their priority 
in the Harvest Order section (see below).  Those polygons must first meet their harvest 
parameters as well before harvest.  
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The harvest priority options include: 

 Partial Cut – partial cuts take priority in the harvest sequence since they usually have timing 
constraints once they reach a harvestable age.  Woodlot will defer harvesting a polygon until 
the new minimum is reached.  Users can over-ride the default by entering their own minimum 
re-entry volume. 

 Closest to Harvest – schedules the harvest based on when polygons have met or will meet in 
the future all their harvest parameters.  Polygons that have met their harvest parameters for a 
long time will have a high availability (which will be displayed as a high “Av” number in the 
Harvest Order); conversely, polygons that require a long time before meeting their harvest 
parameters will show with a low availability or negative availability “Av” number of years.  “Av” 
refers to number of years that a polygon has met its harvest parameters for, and has been 
ready for harvest. 

 Oldest First – the classic timber supply priority that schedules harvesting based on the oldest 
polygons first, assuming they first meet their harvest parameters. 

 Site Index – schedules harvesting based on the highest site index polygons first, assuming 
they first meet their harvest parameters.  

 MAI – schedules harvesting based on polygons that have the highest mean annual increment 
first, assuming they first meet their harvest parameters. 

 Woodlot 3 Sort Order – for use with old Woodlot 3.2 lot files only.  Woodlot 4 will carry over 
and display your original AAC calculation result, and will structure the order for harvest based 
on the sort order from the lot file.  This will help you assess changes in calculation 
methodology between Woodlot 3.2 and Woodlot 4.   

 The Woodlot 3 Sort Order option will only be displayed when a lot file is imported.  New 
projects will not display this option. 

Internally in Woodlot 4, a weighting is applied to each polygon based on the priority chosen.  
The higher up the displayed list, the higher the priority weighting.  The weighting is displayed in 
the Harvest Schedule.  Partial cut polygons are given a high priority for harvest because they 
are time sensitive. 

As a reminder, Woodlot 4 will default the stand harvest age to the older of a) culmination age 
and b) the age at which all the harvest parameters are met.  The default can be overridden by 
manually entering a custom harvest age in the Polygon View tab, overriding the default [ ] 
square bracketed harvest age. 
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10.2 Harvest Order 

The harvest order section lists the order in which polygons will be harvested based on the 
harvest priorities set above, and any manual harvest order you apply in this section.  Users 
have the flexibility to schedule in blocks that they wish to harvest first.  If you manually 
sequence a polygon, it will move to the top of the priority for harvest.   

To manually sequence polygons, select the polygon from the list and use the navigation buttons 
at left to move them up or down: 

 First – sends the selected polygon to the top, first position for harvest. 

 Up and Down – sends the selected polygon up or down a position(s). 

 Next – adds the polygon you select to the next position for harvest. 

 None – removes the manually sequenced priority from the selected polygon. 

The column headers include 

 “Pri” = priority. 

 “Name” = polygon number. 

 “Av.” = number of years the polygon has been available for harvest and met the harvest 
parameters. 

 “Age” = current age of the polygon leading species. 

 “Area” = polygon area in hectares (ha). 

 

10.3 Constraints 

Timber harvesting constraints that model the impact of stewardship and non-timber resource 
management on timber supply can be applied using the Constraints feature.  This works similar 
to Constraints in Woodlot 3.2, although the feature now has expanded capability. 

 

Constraints can be applied universally to your entire woodlot, and/or to specific classifications of 
polygons created/selected in the Polygon View tab.  Constraints can be applied for % area 
netdowns, stand height constraints, stand age constraints or any combination of these. 
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Polygons will be harvested once the current inventory meets the prescribed constraint 
parameters, on a going forward basis.  Several or all constraints can be met at the same time, 
constraints are not cumulative.  Timber required to meet one constraint can also be used to 
meet other constraints. 

To activate constraints in your harvest calculation, select the check boxes for the constraints 
you have set up, and you wish to activate.  They will not activate if they are not checked. 
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Woodlot-wide 
Constraints 

Classification 
Specific 

Constraints 

10.3.1	Adding	and	Editing	Constraints	

To add a constraint, in the Constraints section click the Add button.  This will bring up the Add 
Constraint window as follows: 

 

Constraints can be applied to the entire woodlot (global) or to an individual classification only 
(classification specific) as follows: 

 Global constraints - to apply constraints globally across all polygons in your woodlot, from the 
“Where” list box, select All.  Select the type of constraint from the list box.   

 Classification specific constraints - to apply constraints to one of your classifications, from the 
“Where” list box, select the classification you wish to apply constraints to.  In the example 
above, four classifications are identified (Ownership, VQO, DWR, OGMAs) in addition to All 
(the whole woodlot).   

 

To edit a constraint, select the constraint in the 
Constraints section checklist, click the Edit button to 
bring up the Edit Constraint dialogue window and make 
your changes.   

To delete a constraint, select it in the Constraints 
section checklist, and click Delete. 
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10.3.2	Types	of	Constraints	

There are four general types of forest cover constraints that can be applied to the timber supply in 
Woodlot 4.  These can be added, edited and deleted from the Constraints section of the 
Calculations tab. 

After you have selected to Add a constraint, choose the one you wish to use and select the “Apply 
this Constraint” checkbox to apply it to the chosen polygons listed under the “Where” drop down 
list box.  Un-check if you wish to turn them off.  You can also turn constraints on or off in the 
Calculations tab by selecting the check-boxes there.  Constraints will stay listed even if they are 
not applying. 

 

Choose one or all of the following cover constraints: 

 EXCLUDE from Woodlot – this constraint is available in the event you wish to completely 
remove a classification group of polygons from the timber harvest rate.  Use this only on a 
classification, not globally.  EXCLUDE polygons will not be harvested and will not contribute to 
the forest cover constraints, and will not display in the Standing Volume/Time graph.   

This constraint could be used to test the impact of excluding private land from the timber 
supply. 

 AREA netdown – this constraint is used to apply a broad % netdown across all polygons 
contributing to the timber harvest rate.  It is in effect a scaler function, reducing the amount of 
available timber from those areas by that %.  An area netdown will reduce the timber 
management area on the woodlot by the indicated amount.  The standing and future volume 
from that area will not be available for harvest, but the forest will contribute towards forest 
cover constraints on the woodlot.  It will display as a tan section in the Standing Volume/Time 
graph.   

For example, a 2% area netdown on a 100-ha woodlot will reduce the area by 2 ha of land 
and timber from the harvest, although the area and timber will contribute to meeting forest 
cover constraints, such as ungulate winter range or visual quality objectives. 
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 Must be TALLER than – a height constraint requiring that x % of the forest cover in the 
classification the constraint applies to must be TALLER than y m.  This constraint is used 
typically to model visual quality objectives or hydrology management.   

For example, a polygon or set of polygons that are managed with a VQO of Partial Retention 
might allow up to 15% of the area to be harvested and in a non-VEG state.  The area may be 
considered VEG once it achieves 5m green-up.  To model this constraint with a forest cover 
constraint in Woodlot for Windows, the constraint might read “85% must be TALLER than 
5m”.  Woodlot for Windows will then check that 85% of the area covered by this constraint has 
trees at least 5m tall before allowing harvesting.  To test the implications of this constraint, 
uncheck the Calculate AAC Auto Harvest Rate (m3/yr.), enter in a higher AAC, recalculate the 
AAC and observe where the graph has red bars; these are periods when the constraint cannot 
be met at the higher AAC. 

 Must be OLDER than – an age constraint requiring that w % of the forest cover in the 
classification the constraint applies to must be OLDER than z yrs.  This constraint is used 
typically to model ungulate winter range or old growth management needs. 

For example, if you have a requirement to manage for ungulate winter range on 40% of the 
woodlot area.  To model this constraint with a forest cover constraint in Woodlot for Windows, 
the constraint might read “40% must be OLDER than 120 years”.  Woodlot will then check the 
area of your woodlot and ensure that at least 40% of the area has stands that are older than 
120 years of age before allowing harvesting.  To test the implications of this constraint, 
uncheck the Calculate AAC Auto Harvest Rate (m3/yr.), enter in a higher AAC, recalculate the 
AAC and observe where the graph has red bars; these are periods when the constraint cannot 
be met at the higher AAC. 

 The order for constraints in the calculations is to EXCLUDE, then AREA Netdown, then 
TALLER than, and finally OLDER than. 

You can name the descriptor for classification specific constraints by completing the “Name 
(optional)” box.  The descriptor name will display in the Constraints section of the Calculations 
tab for classification specific constraints, but not for global constraints. 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  88  Enfor Consultants Ltd.  

10.4 Calculate AAC 

To calculate the harvest rate, click the Calculate button at the bottom of the Calculation tab.  
This will generate the estimated sustainable, non-declining even flow harvest rate in cubic 
meters of timber per year over a 250-year planning horizon.  The harvest rate will be displayed 
next to the Calculate button; it will also display at the bottom of the screen in the information bar. 

 

The Harvest Schedule will update, as will the Standing Volume/Time graph.  In the graph: 

 dark green and dark brown represents volume that is available for harvest at each year, 
 light green and light brown represents volume scheduled for harvest and will become 

available once the parameters have been met, and  
 mustard brown indicates volume not scheduled for harvest over the 250-year horizon.   

For a more detailed description of the shaded areas refer to the Standing Volume/ Time Graph 
within section 10.6. 

The calculation is based on meeting the harvest priorities, the harvest order (if any specified), 
the harvest parameters and harvest ages for existing and future forests, and the harvest 
constraints you set. 
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If the harvest rate is a sustainable non-declining even flow harvest rate over the 250-year 
planning horizon, having met the harvest parameters and constraints, the annual volume should 
display the same for each year in the Harvest Schedule at the right; no issues should appear.   

The Calculate button will display red if the harvest rate needs to be calculated or recalculated, 
indicating that there has been a change in data or settings since the last calculation. 

You can choose to calculate the harvest rate either automatically or manually, as follows. 

10.4.1	Automatic	Calculations	

Three automatic setting options are available for running harvest calculations.   

 Utilize Conifer Only – this will harvest all conifer and deciduous timber, but will utilize the 
conifer volume only and will not include the deciduous component in the AAC.  This feature is 
commonly used to test the contribution of deciduous volume in the harvest rate, or to test 
excluding deciduous harvest because of limited or no current merchantability. 

 Disable Partial Cut – this will convert partial cut polygons to clearcut.  This feature is 
commonly used as a test of the implications of partial cutting on the AAC. 

 Auto – Harvest Rate (m3/yr.) – this will harvest the woodlot in the manner you have prescribed 
above.  If you have activated the Utilize Conifer Only or Disable Partial Cut, the Auto Harvest 
will simply harvest the woodlot based on meeting those options in addition to the normal 
harvest priorities, parameters and constraints you have set for the woodlot. 

The resulting harvest schedule will be displayed at the top right.  The Standing Volume/Time 
graph will display at the right, showing the available timber supply over the 250-year planning 
horizon. 

10.4.2	Manual	Calculations,	Testing	Harvest	Rates	(and	Implications)	

You may also want to undertake a manual harvest rate calculation.  This feature is a very good 
way to test the sensitivity of your woodlot timber supply to harvest parameters, constraints or to 
simply check the implications of a higher or lower harvest rate on your timber supply. 

To do this, un-check the automatic calculation checkboxes, enter your own harvest rate in the 
Calculate box and click Calculate.  You will be presented with an updated Harvest Schedule and 
Standing Volume/Time graph, with comments or denotations depicting whether the harvest rate 
is higher or lower than the sustainable level. 

Where the harvest rate is higher than a non-declining even flow harvest rate (i.e. above the 
auto-calculated rate), vertical red bars or blue bars will be displayed in the graph for the times 
when there is not enough eligible volume to harvest.  An “Issue” will be denoted in the Harvest 
Schedule Annual View Issues column describing what has not been met.   

Testing Higher Harvest Rates 

The Standing Volume/Time graph depicts the sum total of timber volume on the woodlot at any 
point in time over the 250-year planning horizon.  When a harvest calculation occurs, the 
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Not enough merch 
volume available to 

harvest. 

Constraints will not be 
met. 

sustainable harvest rate will be reported.  No vertical red or blue bars indicates that constraints 
will be met.   

Un-check the “Auto-Harvest Rate (m3/yr.)” checkbox and enter a higher harvest level than the 
one calculated.  For example, if the sustainable rate is 1,335 m3/yr., enter 2,000 m3/yr. and 
click the “Calculate” button. 

If you see red or blue bars, the harvest rate is partially achievable; but not sustainable over the 
250-year planning horizon.  Red bars indicate that there is sufficient volume but it is 
constrained, and the harvest will result in not achieving those cover constraints.  In the Harvest 
Schedule, under Issues, Woodlot will indicate “Constraints”. 

 

 

 

 

 

 

 

 

 

 

 

 

Blue bars indicate that there is simply not enough merchantable volume to make the desired 
harvest rate.  Woodlot will harvest the portion of merchantable volume that is available or, if 
none is available, will defer the harvest until there is some volume available.  In this case, 
Woodlot will indicate “Nothing to Harvest” as the issue.  It is quite likely that there is volume on 
the woodlot at these times, however this has not met merchantability limits (as denoted by the 
lighter green colour). 

In the example above, the sustainable harvest rate was 1,335 m³/yr.  The forced manual harvest 
for testing purposes is 2,000 m³/yr.  Issues are denoted by vertical red bars and vertical blue 
bars in the graph, and in the Issues column in the Harvest Schedule.  The forced cut has 
enough timber of merchantable size available to harvest through some of the constraints, but it 
will violate constraints.  Blue vertical bars appear when there is insufficient merchantable 
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volume of any kind available to harvest, with or without constraints.  In these situations, Woodlot 
will harvest all available volume but the annual harvest volume will be lower than the target.  In 
automatic mode, Woodlot would normally defer harvesting until there is sufficient volume to 
meet the constraints, resulting in a harvest of 1,335 m3/yr.   

Testing Lower Harvest Rates 

To test a lower harvest rate, uncheck the “Auto - Harvest Rate (m3/yr.) checkbox, enter your 
harvest rate in the Calculate cell and click “Calculate”.  The resulting Harvest Schedule and 
graph will typically show a building inventory of merchantable timber.  No constraints will be 
broken; you will simply be harvesting below the sustainable harvest rate.  This may be useful to 
test the implications of not harvesting at the sustainable harvest rate. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The example above demonstrates how a lower harvest will be displayed.  A sustainable harvest 
rate was calculated at 1,335 m³/yr.  A lower forced harvest of 1,000 m³/yr. is proposed.  There 
are no issues denoted in the Harvest Schedule or vertical lines on the graph, indicating that 
there is more than enough merchantable timber available to meet that harvest level.  The 
merchantable volume (dark green and dark brown) and total available volume (top of light 
green) builds over time. 

See below for more information on the Harvest Schedule and the Standing Volume/Time graph. 

Merchantable 
volume builds

Total volume 
builds
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10.4.3	LRSY	and	MAI	

The Long Run Sustained Yield (LRSY) is the theoretical Long-Run Sustained Yield for a forest 
planning area, resulting in the maximum theoretical harvest level.  In Woodlot,  

1. LRSY (m3/yr.) = Culmination Mean Annual Increment (m3/ha/yr.) of the future stand x Net 
Woodlot area (ha). 

2. Net Woodlot area (ha) = Net area (ha) x THLB inclusion factor (if any).   

The Net Woodlot Area has also been netted down to remove area listed in the “EXCLUDE 
from Woodlot” area constraints. 

Effective July 2018, the LRSY is 
displayed on the Calculate AAC 
panel, located in the lower left corner 
of the Calculations tab.   

You can set the harvest rate to use 
the LRSY annual rate by simply 
clicking on the underlined LRSY text. 

The existing forest culmination Mean Annual Increment (cMAI) has been added to the Calculate AAC 
panel. 

The Annual Increment (m3) has been added to the Advanced Annual harvest report, located on the 
Harvest Schedule panel in the Calculations Tab. 
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10.5 Harvest Schedule Panel 

The harvest schedule panel will display the calculated results of your harvest calculation.  The 
results displayed are useful for you to assess your AAC analysis. 

If your harvest rate is sustainable, meeting all the harvest parameters and constraints, the 
annual volume should display the same for each year in the Harvest Schedule, and no issues 
should appear.  This denotes a non-declining even flow harvest rate over the 250-year planning 
horizon.  In the example above, the non-declining even flow harvest rate is 1,554 m3/yr. (Refer 
also to Manual Calculations above if you have vertical red or blue bars appearing in the graph, 
or Issues identified.) 
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10.5.1	Harvest	Schedule	Reports	

View several summary reports for your harvest schedule by selecting on one of the radio 
buttons in the Harvest Schedule panel.  Results are provided in a basic mode and an advanced 
mode.  The basic mode provides typical columns of information you will want to review for your 
calculations, and will be displayed unless the Advanced checkbox is selected.   

Check on the Advanced box to display more columns 
of data for the Polygon report and the Annual report. 

The reports can be copied out of Woodlot and pasted 
into another application, such as Excel.  To do this, 
select on any report in the Harvest Schedule panel, 
then under the Edit menu item choose “Copy Harvest 
Schedule”.  This will copy the table you are viewing to 
memory ready for you to paste into your other 
application. 

Note: the software cannot wrap column header names, you will need to slide the columns wider 
to display the names.  Columns can be moved by clicking and dragging them to a new position. 

Select from the following Harvest Schedule reports: 

1. Polygon – displays your harvest calculation results on a polygon specific basis. 

 Polygon name. 

 Ownership. 

 Priority for harvest – this is a calculated number in Woodlot used to establish 
harvest sequence. 

 Rotation harvested. 

 Method – clearcut versus partial cut, including the occurrence. 

 Start – starting year for harvest. 

 End – final year for harvest. 

 Volume – total volume harvested (m³). 

 Area – total area harvested (ha 

2. Annual – displays your harvest calculation results on an annual basis.  For each year: 

 Year – harvest year. 

 Block list – list of polygons harvested in that year. 

 Area harvested (ha). 

 Issues – either: 
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o blank, meaning there was sufficient merchantable timber available to harvest and 
no issues; 

o “Nothing to Harvest”, meaning there is no merchantable timber available to 
harvest; or, 

o “Constraints”, meaning that at least one of your harvest constraints are not met. 

 Volume – total volume harvested (m³). 

 Conifer – coniferous volume harvested (m³). 

 Deciduous – deciduous volume harvested (m³). 

 Deciduous % - % of deciduous in the harvest. 

 Number of Polygons – number of polygons harvested in that year. 

 Classifier Constraints – a column for each classifier constraint will display the % of 
the forest that meets the constraint, for example: 

o Height Constraint – if there is a height constraint, this will display the % of the 
forest that meets the constraint. 

o Age Constraint – if there is an age constraint, this will display the % of the forest 
that meets the constraint. 

 
3. Info – new in Woodlot 4.4, 

provides summary information 
on the Woodlot. 

4. Area – new in Woodlot 4.4, 
provides a woodlot area 
summary. 

5. Input – new in Woodlot 4.4, 
provides input data used. 

6. Priority – new in Woodlot 4.4, provides the harvest priority you set in the Calculations 
screen. 

7. Order – new in Woodlot 4.4, provides lists the polygons you force an order on. 

8. Constraints – new in Woodlot 4.4, provides describes constraints used in your run. 

9. Volume – new in Woodlot 4.4, provides a volume summary. 

10. Issues – new in Woodlot 4.4, provides a summary of harvest issues by year and reason. 

11. Skipped – new in Woodlot 4.4, provides a listing of polygons not harvested and the 
reason why. 

12. Advanced columns provide extended data for each of the following reports when the 
Advanced box is checked on: 

 Polygon report 

 Annual report 
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10.6 Standing Volume/Time Graph 

After a calculation is run, the colour Standing Volume/Time graph will be displayed.  This is a 
graph showing the total volume of timber on the woodlot at any point in time over the 250-year 
planning horizon.  For best results, the graph should be read in conjunction with the Harvest 
Schedule. 

 

The vertical axis displays total net merchantable timber volume in (m3) after allowances for 
decay waste and breakage.  The horizontal axis shows time over a 250-year planning horizon, 
from the current year (year 0) to 250 years in the future. 

The graph is a stacked graph, showing the following volumes at any point in time.  They add 
cumulatively from the bottom to the top for each of the following segments: 

 Mustard Brown – timber of all ages that will not be harvested within the 250-year planning 
period.  This results from either the area netdowns or polygons classified as not harvestable.  
It will contribute to meeting the forest cover constraints, but will never be harvested.  This is 
shown as the lowest layer on the graph. 
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Conifer mature

Deciduous mature Deciduous immature

Total Volume

Conifer immature

Un-harvestable volume

 Dark Brown – mature deciduous timber that meets the harvest parameters set for the woodlot 
(age, diameter, vol/ha) and the minimum harvest age of each polygon.  This timber is 
available for harvest and is considered mature deciduous. 

 Dark green – conifer timber that meets the harvest parameters set for the woodlot (age, 
diameter, vol/ha) and the minimum harvest age of each polygon.  This timber is available for 
harvest and is considered mature conifer. 

 Light brown – deciduous timber that has not yet met harvest parameters or not of harvestable 
age, and will at some point become available for harvest.  Considered immature deciduous.   

 Light green – conifer timber that has not yet met harvest parameters or not of harvestable 
age, and will at some point become available for harvest.  Considered immature conifer.   

The total volume standing on the woodlot, mature and immature, at any point in time is shown 
along the top edge of the light green. 

 

You can select a polygon or group 
of polygons in the Harvest 
Schedule, these will be highlighted 
on the graph for the periods 
selected. 
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If you have forced a cut higher than the sustainable rate, vertical red bars or blue bars will be 
displayed in the graph for the times when there is not enough eligible volume to harvest.  An 
“Issue” will be denoted in the Harvest Schedule Annual View Issues column describing what has 
not been met.  This situation will normally occur if the manually forced harvest rate is higher 
than the auto-calculated harvest rate.  

Red bars represent where a constraint will not be met, but there is sufficient volume.  In this 
case, Woodlot will force the cut and indicate “Constraints” as the issue.   

Blue bars represent where there is not sufficient merchantable volume to make the desired cut.  
In this case, Woodlot will harvest the little volume that is available or, if none is available, will 
defer the harvest until there is some volume available.  In this case, Woodlot will indicate 
“Nothing to Harvest” as the issue.   

Refer also to Manual Calculations above. 
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11. Reports and Graphs 

Reports and graphics can be produced in Woodlot 4 to summarize the results of your analysis.  
Important data used in your analysis and generated in the harvest calculation is summarized in 
the woodlot report for your use and editing in MS Word.  The report-writing feature works much 
the same way as in Woodlot 3.2, although it is now activated from the Report menu.   

Graphing has been updated to utilize the FLNROD graphing program Plotsy.  Plotsy is a 
powerful plotting program that will give you added flexibility for comparing scenarios and 
creating custom graphs for your woodlot.  For more information on the use of Plotsy, please 
refer to the Plotsy Help menu or contact the FLNROD Forest Analysis and Inventory Branch. 

To generate reports and graphs, from the Report menu item select one of the options listed.  
These are described below.   

You will need to run a calculation or have a previous calculation run in order to generate a 
report.  You will need to run a calculation when you generate graphs. 
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11.1 Woodlot Report 

Select Woodlot report if you would like to generate a Woodlot Licence Harvest Planning report for 
the woodlot project you are working on.  This will launch MS Word and display the report as a rich 
text file (rtf); a copy will be saved to your working directory as “report.rtf”.  You can make edits and 
add graphics as you normally would in MS Word.  When you are finished editing, save the file as a 
.doc file. 

The Woodlot report has been updated to include a section to display polygon comments.   

The header has been updated to include project defaults. 
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11.2 Graphs 

 Age Distribution Graph – select this to generate an age class distribution graph over time for 
the woodlot project you are currently working on.  The woodlot project filename and AAC are 
displayed in the graph header.   

Graphs are generated in Plotsy and can be exported from Plotsy in several graphics file 
formats, which you can later import into a report.  It is best to maximize the Plotsy window 
before export to improve the resolution of the exported graphic. 

Age class distribution graphs are saved with your woodlot (.wlt) file. 

You can choose between two age class distribution graph templates provided in Woodlot: 

o Age Class Distribution – Over Time.  Displays the age class distribution of the forest in 50-year 
increments from current date using a multi-colour age class distribution graph.  (Current year = 0.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

o Age Class Distribution – Current Age.  Displays the age class distribution of the forest as of today 
using a single colour age class distribution graph.  (Current year = 0.) 
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 Standing Volume/Time Graph – select this to generate a graph of merchantable volume 
over time for your woodlot project.  Graphs are generated in Plotsy and can be exported from 
Plotsy in several graphics file formats, which you can later import into a report.  It is best to 
maximize the Plotsy window before export to improve the resolution of the exported graphic. 

 

 

 

 

 

 

 

 

 

 

 

 Harvest Vol/ha Graph – added in July 2018, this provides a graph of the average volume per 
hectare harvested (m3/ha) each year for your harvest calculation. 
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 Harvest Area Graph – added in July 2018, this provides a graph of the average amount of 
area harvested (ha) each year for your harvest calculation.  The area is also displayed in the 
Calculation tab Harvest Schedule. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Partial cut polygons include the area of the partial cut polygon harvested and displayed in the 
Harvest Schedule.  Clearcut polygons include the area of the clearcut polygon harvested and 
displayed in the Harvest Schedule.   
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 Harvest Age Graph – added in July 2018, this provides a graph of the average stand age 
(yrs) harvested in each year for your harvest calculation. 

 

 

 

 

 

 

 

 

 

 

 

 

 Natural vs Managed Graph – added in July 2018, this provides a graph of natural volume 
(m3) harvested versus managed volume (m3) harvested in each year of your harvest 
calculation. 
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 Harvest vs Ingrowth with LRSY Graph – added in July 2018, this provides a graph of the 
volume (m3) harvested each year (shown as dark green in this example) versus the ingrowth 
volume (m3) each year (shown as light green in this example).   

Also shown is the LRSY level (m3/yr.) (shown in cyan in this example) as a quick reference. 
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Interpreting the Standing Volume/Time Graph 

The volume over time graph displays merchantable volume (m3) on your woodlot project in the 
following sequence of layers, which add cumulatively to the total line at the top.  The volume 
attributed to each category is measured as the vertical distance drawn between each layer.  
Volumes are reported in the Calculation Screen Harvest Schedule (Annual Advanced) and also 
in Plotsy (click the View Data Source icon).  For the example below, the merchantable volumes 
are: 

 Total merchantable volume: shown by the top line as cumulative of all volumes (e.g. 539,353 m3). 

 Immature Coniferous volume: volume between the light green line and goldenrod dashed line 
(e.g. 170,462 m3). 

 Immature Deciduous volume: volume between the goldenrod dashed line and dark green line 
(e.g. 2,148 m3). 

 Mature Coniferous volume: volume between the dark green line and brown dashed line (e.g. 
364,985 m3). 

 Mature Deciduous volume: volume between brown dashed line and cyan line (e.g. 1,231 m3). 

 Un-harvestable volume: volume between the cyan line and bottom of graph (e.g. 528 m3). 

 

 

 

 

 
539,353 m3 total volume at age 80 yrs 
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12. Other Improvements to Woodlot 

Several other improvements have been added since creating Woodlot 4. 

In Woodlot 4.3: 

 A new zoom feature was added to the map. 

 Fixed column width issues on the Tabular screen. 

 Adjusted Classifiers so they are not case sensitive. 

 Improved column formatting in the Woodlot report. 

 Force the BEC to refresh on each forest polygon if the global BEC is changed in the Project 
screen. 

 Fixed the Area on FMLB Summary, section 2a in the Woodlot report. 

 Fixed Volume per Hectare (VPH) rounding. 

 

In Woodlot 4.4: 

 Woodlot now validates the project settings 
before allowing you to view a yield curve.   

A warning message will be displayed if you 
have not set your region or other project 
default parameters in the Project tab.  If you 
get this warning, please return to the Project 
tab to check and update your project defaults. 

 Stand age checking has been updated.  Entering a stand age of 0 or lower was setting 
established year to 0 not relative to the current year like 2019.   

For example, now if the age is less than -20 then the stand age will be set to 0 and an “n/a” will be 
displayed.  If the year is 2019 and -20 is entered the established year would be 2039 (2019 - -20), 
but if -21 was entered the stand age would be set to 0 and n/a would be displayed. 

 The Disable PC feature now also forces the harvest priorities to treat PC as CC. 
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13. For More Information 

We hope that you find Woodlot 4 useful.  Should you have any questions please contact one of 
the following: 

Ministry of Forests, Lands and Natural Resource Operations and Rural Development 
Forest Tenures Branch 
Victoria, BC 
V8W 9C2 Canada 
 
Website: https://www2.gov.bc.ca/gov/content/industry/forestry/forest-tenures/timber-harvesting-
rights/woodlot-licence/allowable-annual-cut-calculator-tool 
 
Ministry of Forests, Lands and Natural Resource Operations and Rural Development 
Forest Analysis and Inventory Branch 
Victoria, BC 
V8W 9C2 Canada 
 
Tel: (250) 356-5947 
 
Website:  https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-
resources/timber-supply-review-and-allowable-annual-cut 
 

Federation of BC Woodlot Associations 
Brian McNaughton, General Manager 
381 Pheasant Road 
Williams Lake, BC 
V2G 5A9 Canada 
 
Tel: 1 (866) 345-TREE (8733)  
Email: gen_manager@woodlot.bc.ca 
Website: https://woodlot.bc.ca/  
 

Woodlot licensees may contact the following for user support questions: 

Mike Bandstra, RPF 
Email: mbandstra@forsite.ca 
Tel: (250) 847-4822. 
 
Ministry staff and other users may contact the following for Woodlot timber supply analysis 
questions:  
Doug Beckett, RPF 
Forest Analysis Section,  
Ministry of Forests, Lands, Natural Resource Operations and Rural Development 
Prince George 
Email: Doug.Beckett@gov.bc.ca 
Tel: (250) 565-6265 
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Appendix 1 Silviculture Systems in Woodlot 

Woodlot 4 offers two silviculture systems for timber supply analysis, clearcut and partial cut.  
Silviculture systems can be selected by forest polygon.  In the Polygon View tab, select the 
silviculture system in the Existing Forest section.  Refer also to Section 7.9.1 of this user guide. 

 

 

 

 

 

 

 

 

 

 

The clearcut method also provides for commercial thinning of certain species in managed 
stands by way of using TIPSY when you select your yield settings. 

Clearcut 
The first harvest entry will occur at or later than the harvest age selected in Polygon View.  The 
actual harvest age will depend on the order selected in the Calculations tab and actual position 
in the queue of polygons being harvested.  (Note that the minimum volume Graphically, the 
clearcut methodology is as follows: 
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Partial Cut (Average Age Method) 
The following appendix describes the functionality of the “average age” partial cut feature, used 
in Woodlot 3.2 and carried over to Woodlot 4. 
 
How the Average-Age Partial Cut Method Works (and PCAF) 
 
Woodlot 4 uses, as one method, a simple approximation “average age” technique to predict 
future yields and measure in-growth from partially cut stands, using VDYP natural yields and a 
Partial Cut Adjustment Factor (PCAF).  This approximation technique is considered to be most 
accurate when a stand is harvested close to its culmination age.  It may be appropriate to use a 
different PCAF with adequate justification. 
 
This method is used in the absence of yield models for partially cut stands in BC and has been 
accepted by FLNROD staff for use in Woodlot.  (PrognosisBC was considered for use in 
Woodlot but has not been included due to the small number of ecosystems that it supports and 
the lack of ground cruise plots to run it.)   
 
Woodlot 4.2 defaults to require a minimum 50 m3/ha before re-entry on partial cut stands.  This 
will avoid a user accidentally specifying a re-entry % where the resulting re-entry volume is 
unreasonably low (e.g. 2 m3/ha).  Woodlot will defer harvesting a polygon until the new 
minimum is reached.  Users can over-ride the default by entering their own minimum re-entry 
volume. 
 
In Woodlot, partial cutting works in the following manner: 
 
1. In the Polygon View tab, navigate to Existing Forest.  At Silviculture System, select Partial 

Cut.  In the Reforest window, a Partial Cut feature will display.  Select Average Age, the % 
removal and re-entry period. 

 
2. Click the Calculate Yields toolbar.  Yield curves are derived, as they would be for all polygons.  Partial 

cutting uses only VDYP natural yields in Woodlot. 
 
3. The first harvest entry will occur at or later than the harvest age selected in the Polygon 

View tab.  The actual harvest age will depend on the order selected in the Calculations 
screen and actual queue in the line of polygons being harvested.  A volume of timber is 
removed which effectively reduces the stand to the same condition it would be in at an 
earlier age with the same residual volume; the stocking and growth characteristics will be 
assumed to be the same as the fully stocked younger stand unless a Partial Cut Adjustment 
Factor is used to simulate the short term retarding effect of partial cutting (see below).  
Woodlot moves the stand growth down the yield curve to this reduced volume/ha point on 
the volume-age curve where it restarts growing from. 

 
4. To measure volume removed on the first entry, Woodlot will first determine the residual 

volume to be reduced to base on the % removal.  The residual volume is the difference in 
volume at the specified harvest age, less the % removal. 

 
5. To model the in-growth and volume to be removed on subsequent entries, the residual 

volume is compared to the VDYP yield curve and assumed to grow like a similar stand in 
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stocking at the younger age that matches this residual volume.  The stand is assumed to 
grow at the same rate and stocking as the naturally occurring well-stocked stand did 
(adjusted as noted below for a PCAF) and is re-harvested at the specified re-entry period.   

 
6. To adjust for any upward or downward bias in this methodology due to regeneration lags, 

crown expansion, and other factors that may affect the recovery of a stand, a Partial Cut 
Adjustment Factor (PCAF) was introduced.  The yield generated is reduced (or can be 
increased) by this amount.  Woodlot defaults the PCAF to 0.8, which assumes a 
conservative 20% reduction on ingrowth to account for the methodology bias.   

 
A PCAF of 1 assumes that the ingrowth will not be affected by a partial cut and will produce 
yields at exactly the same rate (and shape of the yield curve) for the ingrowth period as it 
would if the stand had not been harvested at all. 
 
The PCAF can be reset in the Harvest Parameters screen.  The PCAF is applied to the in-
growth, and the net amount is used for harvest calculations (i.e. volume used for partial cut 
polygon in harvest calculations = in-growth * PCAF).   

 
7. At re-entry age, the in-growth is removed, and the stand is reduced to the younger age 

again.  The stand re grows again, until it is harvested at the next re-entry period, and the 
cycle continues.  A graphical and tabular example is provided below for the average-age 
method for partial cutting in Woodlot 4.  (Note: numbers in the graph may not agree with 
table due to changes in the way Woodlot 4 now handles partial cutting.  Tabulated numbers 
are correct; the graph is correct in concept.) 

 

 
The neat stair step with consistent harvest volume shown above is the desired partial cut yield 
scenario. 

Inappropriate combinations of (a) the interval between partial cut harvests and (b) the percent of 
stand volume removed at each harvest can lead to unintended results.  Harvesting too much/too 
soon will drive net stand volume towards zero over time, and lead to underestimation of AAC.  
Cutting too little/too infrequently will result in accumulation of unharvested volume, and lead to 
underestimation of AAC.  Review of the detailed harvest records (tell them where access to 
details it is discussed) and fine tuning of harvest parameters for stands managed under a partial 
cut regime is recommended.
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Example Item Numerical values 
 

Comment 

Current Age of stand (years) 110 years 

Does not affect calculations.  If the current 
age is > the harvest age, then the current 
age and volume at this age will be used for 
the first harvest age. 

Target Harvest Age (years) 
(existing Management = 1st 
harvest age) 

100 years User selected. 

Example actual harvest age 
(years) 

120 years 

Typical example actual harvest age used by 
Woodlot due to delayed sequence in 
Calculations or queue 

Total Volume at actual harvest 
age (m³/ha) 

420 m³/ha VDYP generated. 

% volume to be removed 15% 

User selected.  This will reduce the volume 
available to 85% of the volume at the actual 
harvest age. 

Minimum Re-entry period 
(years) 

30 years 

User selected.  This is the in-growth period.  
Volume grown over this period will be 
harvested on the next entry. 

Residual Volume (Volume to be 
harvested down to) in all partial 
cuts (m³/ha) 

420-(15%*420) = 357m³/ha 
Woodlot calculated as the residual volume 
to measure from. 

Volume removed at first 
harvest (m³/ha) 

420-357 = 63 m³/ha 
Volume that Woodlot will include in the 
harvest rate calculations for the first entry. 

Assumed stand age which in-
growth is assumed to occur 
from (years) 

Volume of 357 m³/ha occurs 
at 85 years’ age on a 
normal VDYP stand 

VDYP generated. 

Regen Delay  N/A This feature was removed in version 3.1 

Assumed stand age at next and 
subsequent harvests (years) 

85 + 30 years = 115 years Woodlot will use the volume at this age. 

Volume for a normal stand at 
115 years (m³/ha) 

410 m³/ha  

In-Growth (m³/ha) 410-357 =53 m³/ha 

Unadjusted in-growth, which will vary 
depending on the actual subsequent harvest 
age. 

PCAF 
0.8 

(Default Value) 

Partial Cut Adjustment Factor is user 
selected.  The default value assumes a 20% 
reduction in volume to account for a 
possible overestimation from fully stocked 
and full density clearcut based yield curves 
at the corresponding age. 

In-growth volume used for 
subsequent harvest calculation 

0.8*53 m³/ha = 42.4 m³/ha 
Volume that Woodlot will include in the 
subsequent harvest rate calculation. 
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Appendix 2 Managed or Natural Stands 

 
(Source: Ministry of Forests, Lands and Natural Resource Operations website http://www.for.gov.bc.ca/hre/gymodels/GY-
Model/compare.htm#ComparingandSelectingModels, July, 2013) 
 

 

Comparing and Selecting Models 

Table 1 (see following page) lists and compares a number of model characteristics and features 
that may be helpful in selecting an appropriate model for a given situation. Even though there 
are several models available, it is entirely possible that there may be situations where none of 
them are appropriate or where even the "best" one should be used with caution. There are a 
few simple, intuitive steps or questions that can help us select growth and yield models.  
 

 Keep in mind your intended application; for example, is it silviculture, inventory or 
planning?  

 What type of stand do you have and what kind of information do you currently have 
about it? You can set aside models that are not calibrated for your species and stand 
types. You can also determine if you currently have sufficient data to run a particular 
model, as some require more detailed data than others (e.g., permanent sample plot 
data versus inventory data).  

 What type of density management treatment(s) you are interested in and how much 
treatment flexibility do you require? Although all the models in the table have some 
capability for stand density management, most only support a limited number of options.  

 Finally, you will no doubt be exposed to conflicting results regarding these and other 
growth and yield models. Some differences are due to the models themselves but others 
stemming from an emphasis on biology versus economics, or different interpretations of 
the historic theory versus science. Data from reproducible experiments should always be 
the ultimate arbitrator for both scientific theories and models. "In God we trust; all 
others bring data" (K. Iles, personal communication)  

 
Please also refer to https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-
resources/forest-inventory/growth-and-yield-modelling for more information on comparing and 
selecting growth and yield models in BC (April 30, 2019). 
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Table 1. Model Comparison Table (Stearns-Smith, 1999) 
 

 Prognosis 
BC 

Mixedwood 
Growth 
Model 
(MGM) 

Variable 
Density Yield 
Prediction 
(VDYP) 

Tree and 
Stand 
Simulator 
(TASS) 

Table 
Interpolation 
Program for 
Stand Yields 
(TIPSY)

Developer USFS Intermtn 
variant adapted 
to BC by BCFS 

Steve Titus, 
U of Alberta 

BCFS Ken Mitchell, BCFS BCFS 

Distributor 
and Cost 

BC MOF 
(free) 

U of Alberta 
free (web) 

BC MOF 
(free, web) 

not distrib. 
BC MOF does 
free runs

BC MOF 
(free, web) 

Model 
Type 

Individual tree, 
distance 
independent 

Individual tree, 
distance 
independent

whole stand Individual tree, 
distance dependent 

see TASS 

Tree Input 
Data 

Tree list Tree list or 
stand description 

Species 
composition, 
crown closure

Establishment 
density & spatial 
dist.

Establishment 
density 

Site 
Productivity 
Input 

Not SI, uses BC 
BEC and 
physiography 

Site Index (SI) SI SI SI 

Species Pw, Lw, Fd, Bg, 
Hw, Cw, Pl, Se, 
Py, Hm 

Sw, At, Pl, (Sb) 32 commercial BC 
species 

Fdc, Fdi, Hwc, Hwi, 
Ss, Bg, Cw, Pl, Sw 

Fdc, Fdi, Hwc, 
Hwi, Ss, Bg, Cw, 
Pl, Sw 
(see notes below)

Stand Types single and 
mixed-spp, even 
and uneven 
aged 

mixedwood, even 
and uneven aged 

single and mixed-
spp, even aged 

single-spp, even 
aged 

single-spp, even 
aged 
(multi-spp area 
prorated)

Post-estab. 
activities 
supported 

PCT, partial 
cutting 

PCT, partial 
cutting 

 PCT, partial cutting, 
fertilization, pruning 

PCT 

Other growth 
modifiers 

root disease  Decay, waste and 
breakage and 
VAF’s

OAF’s, some pests 
and diseases 

OAFs, Lodgepole 
repression 

Output besides 
yield tables 

projected tree 
lists, diameter 
distributions 

projected tree 
lists, crop plans 

ave diameter and 
culmination MAI  

stand and tree 
visualization, wood 
characteristics, 
projected tree lists, 
etc. 

diameter 
distribution, 
lumber and logs, 
mortality and 
snags, economic 
analysis

Development 
Data Sources 

USFS CFI and 
EP plus PSP 
from BC S. 
Interior 

Alberta PSP TSP PSP & EP. BC, AB, 
WA, OR 

see TASS 

Unique Features & 
Applications 

partial cutting in 
complex stands; 
pest and habitat 
models available 

boreal mixedwood 
 
Requires EXCEL 
97 

natural stands CFI 
updating and 
timber supply 
analysis  

spatially explicit; 
crown based, 
timber supply 
analysis, 
custom runs on 
request

yields from TASS, 
timber supply 
analysis and 
economic 
analysis 
 

 
Abbreviations:  BC MOF=BC Min of Forest; USFS=US Forest Service; OMNR=Ontario Min of Nat Res; CFS=Canadian Forest 
Service; PCT=pre-commercial thinning; EP=experimental plots; PSP=permanent sample plots; TSP=temporary sample plots; 
CFI=continuous forest inventory; OAF’s=operational adjustment factors, VAF’s=volume adjustment factors; MAI=mean annual 
increment; BEC=Biogeoclimatic Ecological Classification 

 
Notes: TIPSY has been updated since the date of this publication to now include species At and Dr.  Bg is derived from HWC. 
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Managed vs. Unmanaged Stands What Model Might be used?  

(Source: Ministry of Forests, Lands and Natural Resource Operations website http://www.for.gov.bc.ca/hre/gymodels/GY-
Model/compare.htm#Managedvs.UnmanagedStandsWhatModelMightbeused? , July, 2013) 
 

The following information will help planners identify managed vs. unmanaged stands 
(polygons), for the application of appropriate yield models (curves). The distinction is important 
because managed stands tend to be more productive. A decision tree is provided to help make 
the distinction between managed and unmanaged stands and suggest yield models for various 
stand types (Nussbaum, 1998).  
 

Managed stands  

Managed stands are even-aged stands that have benefited from management activities to 
encourage their growth potential. They have known establishment conditions including species, 
density, and distribution of stems. Managed stands can be:  

 planted or natural origin but have not experienced repression or overstory competition.  
 harvested stands regenerated after 1986 that have achieved "free growing" status, as 

specified in the regional free growing guidebooks. For stands regenerated before 1987, 
silviculture records, management plans, and local knowledge are needed to determine if 
stands are managed.  

 young spaced and fertilized stands if the establishment conditions can be approximated  
 partially harvested stands, such as commercially thinned stands if they were 

unsuppressed or unrepressed during establishment, establishment conditions can be 
approximated, and removals are documented.  

 

Unmanaged Stands  

Even-aged stands have not had the benefits of management and their establishment conditions 
are unknown. Although some stands may achieve their potential, others may have inadequate 
stocking, experience overstory competition, or repression.  
Uneven-aged stands are considered unmanaged for this exercise, as the concept of 
establishment conditions holds little meaning, and a large number of stems could be 
suppressed by an overstory. These stands generally contribute to non-timber objectives where 
maximizing growth is not the primary concern. They have historically been handled as 
"naturals".  
 
Refer also to https://en.wikipedia.org/wiki/Forest_growth_models_of_Canada for more 
information on modeling managed vs unmanaged stands.   
 

What’s the Difference? 

Recall that a managed stand has had some level of stocking control provided, often a result of 
planting or spacing or some level of human effort to bring the stand to a free growing state  
While an unmanaged stand is typically a naturally established stand that has had no human 
activity influence in its establishment or to bring to a free growing state, often associated with 
naturally occurring wild stands.  A stand that results by natural regeneration after a harvest is 
not an unmanaged stand because it was initiated (cleared) as a result of human activity. 
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Models Decision Tree 

(Source: Ministry of Forests, Lands and Natural Resource Operations website http://www.for.gov.bc.ca/hre/gymodels/GY-
Model/flochart.htm , July, 2013) 

 

Forest growth and yield models have been developed for many different purposes. It is 
important to choose the proper model and understand its assumptions and limitations. Models 
can be sophisticated computer models or simple yield tables derived from appropriate data.  
 
 

 
A word of caution about models!  

(Source: Ministry of Forests, Lands and Natural Resource Operations website http://www.for.gov.bc.ca/hre/gymodels/GY-
Model/compare.htm#ModelsDecisionTree  , July, 2013) 

 
Forestry and statistically based biological experimentation are both relatively new sciences 
whose joint development is governed largely by the (slow) rate of tree growth. Seeming 
contradictions among the limited existing experiments serve to highlight our imperfect 
understanding of complex biological systems and discourage risk-laden investment decisions 
based on limited (or select) information. Decision making given imperfect information requires 
risk analyses that take into account the uncertainties regarding future biological and economic 
consequences. Models can be important tools, but we should not rely solely on them for making 
decisions. Use your professional judgment to examine your own data and assumptions before 
making the final management decision.  
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Model Application and Use  
 
(Source: Ministry of Forests, Lands and Natural Resource Operations website http://www.for.gov.bc.ca/hre/gymodels/GY-
Model/compare.htm#ModelsDecisionTree  , July, 2013) 

 
Selecting a model is only half the battle. Proper use of a model also depends on proper 
selection and preparation of the input data and proper interpretation of the model output. This is 
why most regulatory agencies avoid any open or implied sanctioning of specific models in 
favour of yield table approvals.  
 
The main uses of growth and yield predictions are to:  
 

 increment and update forest inventories  
 compare silviculture treatments by simulating treatments and predicting outcomes  
 influence stand and forest level decision making  
 provide input for forest management planning including timber supply analysis, 

Allowable Annual Cut (AAC) determinations and policy making  
 assess the impact of timber losses due to pests and fire  
 allow extrapolations for missing or inadequate data  
 explore and teach tree and stand dynamics  

 
The application of any model in silviculture decision support also requires a clear statement of 
management objectives translated into appropriate quantitative values that can be identified in 
model output. Care must be taken to understand the implications and limitations of using 
various quantitative measures as surrogates for management objectives.  
 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  118  Enfor Consultants Ltd.  

Appendix 3 VDYP vs TIPSY 

(Source: adapted from TIPSY 4.3.0 Help File, Ministry of Forests, Lands and Natural Resource Operations, May 6, 2013 and the 
VDYP7 website http://www.for.gov.bc.ca/hts/vdyp/ July, 2013) 

 

VDYP 7 

The Variable Density Yield Prediction (VDYP 7) Model is an empirical yield prediction system 
that replaces VDYP6. The new model is more sensitive to changes in stand density such as 
basal area and trees per hectare. It is intended for use in unmanaged, natural stands of pure or 
mixed species composition.  VDYP 7.0 was released on 2nd April 2007. 

The VDYP system was developed by Resources Inventory Branch (now the Forest Analysis and 
Inventory Branch of the Ministry of Forests and Range) using randomly located plots that cover 
the full range of conditions found in our forestland base.  Consequently, VDYP projects the 
average yield of naturally regenerated stands that have not been treated. The empirical yields 
from VDYP will invariably be lower than the potential yields given by TASS and TIPSY, although 
TIPSY yields can be adjusted for operational conditions.  

Density traditionally refers to any quantitative measure of crowding in stands. In TIPSY we use 
Number of Trees/ha (see Number of trees). "Residual Density" refers to the number of trees 
alive after thinning.  For more information on VDYP, please refer to:  
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/forest-
inventory/growth-and-yield-modelling/variable-density-yield-projection-vdyp  

TIPSY (TASS) 

TASS generates the yield tables in TIPSY’s database. TASS is a computer model that simulates 
the growth of individual trees and stands in three dimensions. The crowns of individual trees 
expand and contract asymmetrically as branch extension responds to internal growth 
processes, physical restrictions imposed by the crowns of competitors, environmental factors 
and silvicultural practices. The crowns add a shell of foliage each year that benefits the trees in 
diminishing amounts for several years. The volume increment produced by the foliage is 
distributed over the bole annually and accumulated to provide tree and stand statistics. 

TASS is based on growth trends observed in fully stocked research plots growing in a relatively 
pest free environment. The yields will be very close to the potential of a specific site, species 
and management regime. Research Branch maintains the system.  For more information on 
TIPSY (TASS), please refer to: https://www2.gov.bc.ca/gov/content/industry/forestry/managing-
our-forest-resources/forest-inventory/growth-and-yield-modelling/table-interpolation-program-
for-stand-yields-tipsy  

The latest version of TIPSY and VDYP is available from: 
https://www2.gov.bc.ca/gov/content/industry/forestry/managing-our-forest-resources/forest-
inventory/field-forms-and-software/software-download  
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Appendix 4 Tree Species Used in Woodlot 4 

Table 5-1 below provides a list of VRI tree species codes used in Woodlot 4, with the cross-
reference to VDYP tree species codes and TIPSY tree species codes.  For more information, 
refer to Section 6.5 and refer to the Project tab.   

 

 

 

 

 

 

 

 

This list may be updated from time to time; therefore, please refer to the Species section of the 
Project tab for the latest listing of species.   

Note: To copy the species list, navigate to the Edit menu and select Copy Species.  This will 
copy the table listed ``in the Species window.  Refer also to Section 6.6 Tree Species. 

Table 5-1 VRI Tree Species Codes 

Code Name VDYP TIPSY Deciduous 
Non-
Commercial 

A Aspen, Cottonwood or Poplar A AT Decid -- 
AC poplar AC -- Decid -- 
ACB balsam poplar ACB -- Decid -- 
ACT black cottonwood ACT -- Decid -- 
AT trembling aspen AT AT Decid -- 
AX hybrid poplars AX -- Decid -- 
B Fir (Balsam) B B -- -- 
BA amabilis fir BA BA -- -- 
BB balsam fir BB B -- -- 
BG grand fir BG -- -- -- 
BL subalpine fir BL BL -- -- 
C Cedar C CW -- -- 
CW western redcedar CW CW -- -- 
D Alder D DR Decid -- 
DR red alder DR DR Decid -- 
E Birch E -- Decid -- 
EA Alaska paper birch EA -- Decid -- 
EE European Birch EE -- Decid NC 
EP paper birch EP -- Decid -- 
ES silver birch ES -- Decid -- 
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EW water birch EW -- Decid NC 
EXP Alaska x paper birch hybrid EXP -- Decid NC 
EY Yellow Birch -- -- Decid NC
F Douglas-fir F FD -- -- 
FD Douglas-fir FD FD -- -- 
FDC coastal Douglas-fir FDC FDC -- -- 
FDI interior Douglas-fir FDI FDI -- -- 
G Dogwood G -- Decid NC 
GP Pacific dogwood GP -- Decid NC
H Hemlock H H -- -- 
HM mountain hemlock HM HM -- -- 
HW western hemlock HW HW -- -- 
HXM mountain x western hemlock hybrid HXM HM -- -- 
J Juniper J -- Decid NC
JR Rocky Mtn. juniper JR -- Decid NC
JS Seaside Juniper -- -- Decid NC
K Cascara K -- Decid NC 
KC cascara KC -- Decid NC 
L Larch L L -- -- 
LA alpine larch LA -- -- -- 
LD Dahurian larch -- -- -- NC
LS Siberian larch -- -- -- NC
LT tamarack LT L -- -- 
LW western larch LW LW -- -- 
M Maple M -- Decid -- 
MB bigleaf maple MB -- Decid -- 
MV vine maple MV -- Decid NC
P Pine P PL -- -- 
PA whitebark pine PA PL -- -- 
PF limber pine PF PL -- -- 
PJ jack pine PJ PL -- -- 
PL lodgepole pine PL PL -- -- 
PLC shore pine PLC PL -- NC
PLI lodgepole pine PLI PL -- -- 
PR red pine PR -- -- -- 
PW western white pine PW PW -- -- 
PXJ lodgepole x jack pine hybrid PXJ -- -- -- 
PY ponderosa pine PY PY -- -- 
Q Oak Q -- Decid NC 
QG Garry oak QG -- Decid NC 
S Spruce S S -- -- 
SB black spruce SB -- -- -- 
SE Engelmann spruce SE SE -- -- 
SS Sitka spruce SS SS -- -- 
SW white spruce SW SW -- -- 
SX spruce hybrid SX S -- -- 
SXL Sitka x white SXL S -- -- 
SXS Sitka x unknown hybrid SXS S -- -- 
SXW Engelmann x white SXW S -- -- 
T Yew T -- Decid NC 
TW western yew TW -- Decid NC 
UP Pacific crab apple UP -- Decid NC 
V Cherry V -- Decid NC
VB bitter cherry VB -- Decid NC
VP pin cherry VP -- Decid NC
W Willow W -- Decid NC 
WA peachleaf willow WA -- Decid NC 
WB Bebb's willow WB -- Decid NC
WD pussy willow WD -- Decid NC
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WS Scouler's willow WS -- Decid NC 
WT Sitka willow WT -- Decid NC 
Y Cypress Y YC -- -- 
YC yellow-cedar YC YC -- -- 
X unknown X -- -- -- 
XC unknown conifer XC -- -- -- 
XH unknown hardwood XH -- Decid -- 
Z other tree, not on list Z -- -- NC 
ZC other conifer ZC -- -- -- 
ZH other hardwood ZH -- Decid NC
RA Arbutus menziesii RA -- Decid NC
AD southern cottonwood AD -- Decid NC 
BC white fir BC BA -- -- 
BM Shasta red fir BM -- -- NC
BP noble fir BP -- -- -- 
ME box elder ME -- Decid NC
MN Norway maple MN -- Decid NC 
MS Sycamore maple MS -- Decid NC 
QE English oak QE -- Decid NC 
QW white oak -- -- Decid NC
UA apple UA -- Decid NC
VS sweet cherry VS -- Decid NC
YP Port Orford-cedar YP -- -- NC 
OA incense-cedar OA -- -- NC 
OB giant sequoia OB -- -- -- 
OC coast redwood OC -- -- -- 
OD European mountain-ash OD -- Decid NC
OE Siberian elm OE -- Decid NC 
OF common pear OF -- Decid NC 
OG Oregon ash OG -- Decid NC 
OH white ash -- -- Decid NC
OI shagbark hickory -- -- Decid NC
OJ Tree-of-heaven -- -- Decid NC
OK Japanese Walnut -- -- Decid NC 
PM Monterey pine PM -- Decid NC 
PS sugar pine PS -- Decid NC
SN Norway spruce SN -- Decid NC
R Arbutus R -- Decid NC
U Apple U -- Decid NC 
VV choke cherry VV -- Decid NC 
WP Pacific willow WP -- Decid NC 

 

Table 5-1 References: 

VDYP species and utilization levels were assembled in consultation with Dave Waddell, Modeling 
Forester, Strategic Initiatives Section, Forest Analysis and Inventory Branch, FLNROD and Sam Otukol, 
Team Lead Statistical & Biometrics Support, Forest Analysis and Inventory Branch, FLNROD, February to 
July, 2013 

TIPSY species were assembled based on the latest version of batch TIPSY, July 2013.   

VRI Relational Data Dictionary version 4.0 (draft), pp 73-75, Ministry of Forests, Lands and Natural 
Resource Operations, December 12, 2012. 

A Users Guide to the Vegetation Resources Inventory VRI Attribute Codes, Appendix 3, Timberline 
Forest Inventory Consultants Ltd. (Michael Sandvoss, Bruce McClymont, Craig Farnden) March 31, 2005. 
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Appendix 5 Import/Export Variables used in Woodlot 4 

The following variables are used in Woodlot 4 CSV files or when viewing data in Tabular view, 
for importing data into Woodlot or for exporting data from Woodlot.  Refer also to Appendix 8 for 
a list of VRI variables used in Woodlot 4. 

Note that the use of [ ] square brackets denote that: 

(a) for importing data to Woodlot, the variable is to use default values generated by 
Woodlot, or,  

(b) for exported files, the value in square brackets was generated from defaults generated 
by Woodlot and used in your analysis. 

Note that the Woodlot 4 variables are also listed in the “columns” in the column filter in the 
Tabular View tab. 

Woodlot Variable  Description of variable to use 

Woodlot 
Default 
Value can 

be 
generated 

Available 
in VRI 
data 

Acceptable 
codes 

Example 

UniqueID 

An optional field of unique 
polygon identifiers, used if your 
polygon mapsheet numbers have 
duplicates to distinguish between 
them. 

    
Text or 
number 

MG1 

Mapsheet  Mapsheet number.     Y 
Text or 
number 

092C095 

Polygon  Polygon number.     Y 
Text or 
number 

111 

SubPolygon 
Split polygon identifier name or 
number. 

    
Text or 
number 

a 

Delete 
Polygon will be imported but not 
displayed in Woodlot. 

     0=yes, 1=no  0 

FMLB 
Forest Management Land Base 
classifier. 

    
Yes, No 
(reason) 

No (Rock) 

Ownership 
Land ownership classifier.  You can 
use Woodlot terms or your own 
custom classification terms. 

    
Crown, 

Private, Top‐
Up, Other 

Crown 

AreaGross 
Gross area in hectares.  Accepts 0‐
4 decimals. 

   Y  Number  20 

AreaEx  Percent of area excluded.       %  100.00% 

AreaExDesc  Description of area excluded.       Text  Rock 

AreaRoads 
Area of road to be reduced, in ha 
or % of polygon. 

    
Number or 
percentage 

0.4 or 2.0% 

AreaNet 

Calculated net area after 
exclusions and reductions.  Enter [ 
] square brackets to have the net 
area calculated by Woodlot by 
default.  Accepts 0‐4 decimals. 

Y    Number  [20.0] 
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BEC 
Biogeoclimatic Ecological 
Classification Zone (BEC Zone). 

   Y 
Valid BEC 
Zone text 

CWH 

BEClong 
BEC Zone, subzone and variant     Y 

Valid BEC 
Zone text 

CWH_vh_1 

YearEstab  Year of establishment.     Y  Number  1951 

CurAge 

Current age of the polygon, years 
from establishment year.  Current 
age is related to establishment 
year, so if you import a VRI file, 
this age may be updated in 
Woodlot to your current year. 

   Y  Number  62 

Comments 

Used to provide comments in the 
Polygon View tab for each 
polygon. 

    

Text (with 
rows 

delimited by 
the |pipe 
symbol) 

This polygon was 
updated with  new 

Site Index. 

LabelOverride 

Used to provide text to override 
the polygon map label. 

    

Text (with 
rows 

delimited by 
the |pipe 
symbol) 

Blk 15 | Logged 
2010 

SiteIndex 
Site index at breast height age 50, 
meters. 

   Y  Number  20 

SISpecies 

Site index species used to calculate 
site index in the Calculate Site 
Index feature on the Polygon View 
tab. 

   Y  Text  Fd 

SIAgeBH 

Breast height age used to calculate 
site index in the Calculate Site 
Index feature on the Polygon View 
tab.  Used only if total age is not 
used. 

     Number  15 

SIAgeT 

Total age used to calculate site 
index in the Calculate Site Index 
feature on the Polygon View tab.  
Used only if a breast height age is 
not used. 

     Number  65 

SIHeight 
Height used to calculate site index 
in the Calculate Site Index feature 
on the Polygon View tab. 

     Number  22 

HarvestAge 
Age at which harvest parameters 
are met or the age at which you 
want to harvest, years. 

Y    Number  61 

c_... 

Classifier.  The field header is 
described by c_ and followed by 
the classifier name; for example 
c_VQO would create a classifier for 
VQO.  Populate data in this column 
with the VQOs for each polygon. 

     Text  Partial Retention 

Silvi  Silviculture System to use.      

"none", "CC‐
NoChange", 

"CC‐
Reforest", 

"PC" 

CC‐NoChange 
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PCPerc 
Partial Cut % removal on the first 
entry. 

     %  20% 

PCNext 
Partial Cut number of years until 
re‐entry. 

     Number  25 

PCMeth 
Choice of partial cut method. 
(Multiage is not currently 
available.) 

    

A=average 
age 

(M=multiage 
for a future 
feature) 

A 

NoHarvReas 
User defined reason for not 
harvesting. 

    
Text or 
number 

Crappy stand 

RegenDelay  Regeneration delay in years.       Number  2 

SiteIndex2 

Future forest site index in m (at 
breast height age 50), for the 
second rotation.  Type in your site 
index, or use ‐1 or 0 to bring in 
original site index. 

     Number  21.4 

HarvestAg2 

Harvest age in years for the second 
rotation. 

     Number  95 

YieldName2  "Reforest to" yield name.       Text  HighsiteFD 

YieldMeth 
Yield method ‐ VDYP, TIPSY, NC, 
NSR, TASS, Custom. 

     Text  VDYP 

SpCd1 
Species code ‐ 1st species. Use VRI 
species codes. 

   Y  Text  HW 

SpCd2 
Species code ‐ 2nd species. Use 
VRI species codes. 

   Y  Text  CW 

SpCd3 
Species code ‐ 3rd species. Use VRI 
species codes. 

   Y  Text  SS 

SpCd4 
Species code ‐ 4th species. Use VRI 
species codes. 

   Y  Text  FD 

SpCd5 
Species code ‐ 5th species. Use VRI 
species codes. 

   Y  Text  YC 

SpCd6 
Species code ‐ 6th species. Use VRI 
species codes. 

   Y  Text  DR 

SpPt1  Species percent ‐ 1st species.     Y  %  40 

SpPt2  Species percent ‐ 2nd species.     Y  %  20 

SpPt3  Species percent ‐ 3rd species.     Y  %  15 

SpPt4  Species percent ‐ 4th species.     Y  %  10 

SpPt5  Species percent ‐ 5th species.     Y  %  10 

SpPt6  Species percent ‐ 6th species.     Y  %  5 

SpIn1 
Whether species1 will be included 
and available for harvest (ie, not 
excluded). 

     Y or N  Y 

SpIn2 
Whether species2 will be included 
and available for harvest (ie, not 
excluded). 

     Y or N  Y 

SpIn3 
Whether species3 will be included 
and available for harvest (ie, not 
excluded). 

     Y or N  Y 
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SpIn4 
Whether species4 will be included 
and available for harvest (ie, not 
excluded). 

     Y or N  Y 

SpIn5 
Whether species5 will be included 
and available for harvest (ie, not 
excluded). 

     Y or N  Y 

SpIn6 
Whether species6 will be included 
and available for harvest (i.e., not 
excluded). 

     Y or N  Y 

GenWorth 
Genetic worth, yes to activate it or 
no to not activate it. 

     Y or N  N 

SpWG1  Genetic worth by species in %.       %  5.8 

SpWG2  Genetic worth by species in %.       %  5.8 

SpWG3  Genetic worth by species in %.       %  5.8 

SpWG4  Genetic worth by species in %.       %  5.8 

SpWG5  Genetic worth by species in %.       %  5.8 

SpWG6  Genetic worth by species in %.       %  5.8 

MinCutAge 

Minimum harvest age for harvest 
parameters.  Enter [ ] to use 
Woodlot defaults or enter your 
own minimum parameter. 

Y    Number  [ ] 

MinCutDBH 

Minimum dbh for harvest 
parameters.  Enter [ ] to use 
Woodlot defaults or enter your 
own minimum parameter. 

Y    Number  [ ] 

MinCutVol 

Minimum volume/ha for harvest 
parameters.  Enter [ ] to use 
Woodlot defaults or enter your 
own minimum parameter. 

Y    Number  [ ] 

VAF 
Volume adjustment factor for 
VDYP yields, from 0‐1.0 (95% = 
0.95) 

     0.0 to 1.0  0.95 

RefStemsHa 
Number of stems per ha at 
reference year, for use in VDYP7 
Console. 

   Y  Number  1235 

RefBasalA 
Basal area m2 per hectare at 
reference year, for use in VDYP7 
Console. 

   Y  Number  52.6 

RefAge 
Age at reference year, for use in 
VDYP7 Console. 

   Y  Number  34 

RefHeight 

Height in meters at reference year, 
for use in VDYP7 Console.  Enter [ ] 
to use Woodlot defaults or enter 
your own reference height. 

Y  Y  Number  [ ] 

RefDate 
Reference date, in 
day/month/year. 

   Y  Date  21/07/1987 

UtilizFile 
Utilization level ‐ OG, 2G, HG, 12.5, 
17.5. 

    
Text or 
number 

OG 

Closure  Crown Closure.     Y  %  60 
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StockClass 
Stocking Class ‐ 0, 1, 2, etc per VRI 
specs. 

   Y  Number  1 

OAF1 
Operational Adjustment Factor 1.  
15% = 0.85 

Y    %  0.85 

OAF2  Operational Adjustment Factor 2.  Y    Text or %  0.95 

Regen 
Regeneration method ‐ Natural, 
Planted, Clumped. 

    
Text ‐ N, P or 

C 
N 

Density 
Stems per hectare at 
establishment, for use in TIPSY. 

     Number  1600 

Thin 
Whether to pre‐commercial thin 
or not. 

     Y or N  Y 

Thinned 
Thin to density in stems per 
hectare, for use in TIPSY. 

     Number  1200 

ComThin 

Whether to Commercial thin or 
not.  Can only be used with Fd on 
the coast and Pl in the Interior. 
Refer to TIPSY Help for more info. 

     Y or N  Y 

CTStemha 
Commercial thin‐to density in 
stems per hectare, for use in 
TIPSY. 

     Number  600 

CTHeight 
Commercial thin‐to height in 
metres, for use in TIPSY. 

     Number  25.3 

Fert  Whether to fertilize or not.       Y or N  Y 

FertAge  Age of fertilization in years.       Number  55 

NSRRestock 
Number of years when to restock a 
NSR polygon. 

     Number  4 

NCHarvIn 
Number of years when to harvest 
a NC polygon. 

     Number  12 

NCVolHa 
Merchantable Volume m³/ha of 
the NC stand. 

     Number  120 

NCDecid 
% of the NC stand that is 
deciduous. 

     %  60 

NCHeight  Height in meters of the NC stand.       Number  15.6 

NCDesc  Descriptor of the NC stand.       Text  N 

FIPstart 
Whether to activate FIPstart if 
data is available.  Generally leave 
this as "Y". 

     Y or N  Y 

                

Notes for Woodlot 4 variables:            

[ ] Square 
brackets 

Indicates that the value has been 
generated from the defaults used in 
Woodlot.  Woodlot will generate default 
numbers and use these unless you over‐
ride them.  To over‐ride default values 
being generated and used, enter your own 
data in the cell. 

     [ ] 
use [ ] to activate 
default values 

Default 
parameters 

Some default parameters on the Project 
tab can be entered in your CSV file. 
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Region 
Region is manually entered into the Project 
Tab. 

     Region  Coast or Interior 

Yes or No 
convention 

If the first character is Y, 1, or T then the 
result is true, otherwise it is false.  
Alternately, use N, 0, or F to enter No 

        Y, 1, T or N, 0, F 

Classifiers ‐ 
C_name 

Any column with a "C_" followed by a 
name, will become a classifier.  Usually 
these are added to the end of the CSV file. 

    
C_ (text 

descriptor) 
C_VQO 
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Appendix 6 Some Basic Steps to Use Woodlot 4 

 

Getting Acquainted  
We suggest you acquaint yourself with the features of Woodlot 4 before running your first 
harvest rate calculation.  Refer to Section 4.1 and 4.2 for a description of the main functional 
areas in Woodlot 4. 

Use the following steps to guide you through a test application.  Woodlot 4 uses most features 
common to Windows based applications.  All functions are activated by “pointing and clicking” 
on screen buttons with a mouse.  Polygon data (forest inventory information for each forest 
polygon) is entered either manually on the screens or by loading in polygon data input files.  
Parameters and constraints are changed on screen as you work. 

Sample steps: 

1. Load up Woodlot 4 by double clicking on the Woodlot icon, or activate it by navigating to 
Start, then Programs, then Woodlot 4.  The About screen will appear, and then will leave 
within a few seconds automatically.  The Project screen with the five main tabs will 
appear.  

2. Load up a sample woodlot file located in C:\Program Files (x86)\Woodlot for Windows 
4\Sample.  Click on your sample woodlot file.  The filename will appear at the top of the 
screen once it is loaded in. 

3. Click through the five main tabs to view the data that has been entered, and the results 
of the last calculation.   

4. Click on the Project tab and ensure the default information is correct for your woodlot.  
Make sure you have entered whether you are Coast or Interior and your BEC zone, 
these are new defaults you will need. 

5. To check forest polygon data and yield information, click open the Polygon View tab.  
You will see all the data for each individual polygon in the list box required to determine 
the yields.  Click through several polygons to see information pertaining to each polygon. 

6. To update your yields, click on <Edit><Remove all imported .LOT Yields>.  Then on the 
menu bar, click on <Calculate Yields>.   

7. The VDYP and TIPSY calculations will start, and a black DOS screen will appear.  Allow 
several seconds for it to compile the VDYP and TIPSY yields.  The resulting yield 
information will be loaded into Woodlot automatically, and you will be returned to the 
Polygon View tab. 

8. To view timber yield information for any polygon, in the Polygon View tab, click on the 
polygon number in the navigation tree, then click on the yield type screen, usually for 
VDYP or for TIPSY.  This will open a Yield Settings window with the polygon data for 
that yield type. Click on the <Cancel> button at the bottom right to close this screen.  
Click on the mini-graph to display the yield table.  Click on the Plot Yield icon at the top 
to view the yield curves.  Close out the windows by clicking the red X. 
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9. To view a summary of basic yield information for all your forest polygons, open the 
Tabular View tab.  This will display a listing of polygons and harvest information. 

10. To run a calculation, open the Calculations tab.   

11. Forest polygons are listed in a small display box called Harvest Order.  That order is set 
based on the Harvest Priority displayed above.  By default, Woodlot 4 will set the 
Harvest Order to the same as in your last *.lot file.  The calculation will assume that the 
order for harvest is the order listed here.   

12. If you want to reset the harvest order, you will need to unselect the Woodlot 3 Sort Order 
check box.  Clicking on a polygon and using the buttons titled <First>, <Up>, <Down>, 
<Next> and <None> can change this order.   

13. Or, the order can be automatically sorted by clicking on the Harvest Priority menu items 
above. 

14. To run a calculation, click on the <Calculate> button in the lower portion of the screen and 
allow a few seconds.  The model will calculate a non-declining even flow harvest rate for 
the polygons in the order selected, using yield information derived in Polygon Data.   

15. The Standing Time/Volume Graph and summary harvest schedule will update.  The 
graph displays the available timber volume over a 250-year horizon.  In the graph, dark 
green colours indicate volume that has reached harvest age; light green colours indicate 
volume younger than harvest age.  A tan coloured line on the bottom denotes volume 
that is not contributing to the harvest rate, but which is used to meet forest cover 
constraints along with merchantable timber.  The top green line denotes the total volume 
at every year.  A line that increases over time indicates that volume is being grown faster 
than it is being harvested. 

16. Try a few revisions to test the impact of increasing the harvest rate.  Click off the check 
box in the lower left corner titled <Auto-Harvest Rate>, enter a higher harvest rate than 
calculated, say 50% higher in the next box, and click on <Calculate>.  Notice the graph; 
the blue vertical lines represent periods when no timber is available to harvest.  

17. Activate the <Constraints> feature by clicking on their check boxes, and then 
<Calculate>.  The red vertical lines represent periods when age constraints could not be 
met, or when height constraints could not be met.  In these latter cases, timber is 
available for harvest, but these constraints will not be met.   

18. To determine the harvest that will meet all constraints, click on <Auto-Harvest Rate> and 
then <Calculate>. 

19. Save your work and then return to any tab to view data, or remain in the Calculations 
tab. 

20. To review the report that can be generated, first ensure you have run a calculation, and 
then click on the Report menu and the Woodlot Report menu item.  The report will be 
displayed for you.  If you want to view, modify, or print the report, you can do so here.  
Save your report as a doc file. 

21. To review the graphs that can be generated, first ensure you have run a calculation, and 
then click on the Report menu.  Choose one of the graphs to activate Plotsy and 
generate the graph for your use.  The graph will be displayed for you.  Export the graph 
as a *.gif file for later use in a document if you wish. 
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22. To save your woodlot analysis work for another time, navigate to the File menu and click 
on <SaveAs>.   Enter your filename and save your file.  This will create a new *.wlt file 
for use next time. 

23. You can return to any one of ten last files used by selecting the file you wish from the list 
provided under <File> <Recent>. 

 

Key Features of Woodlot 
The following are some key pointers about how Woodlot works, which is described in detail in 
the User Guide: 

1. Forest 
Polygons 

Woodlot uses the data for individual forest cover “polygons” in all 
calculations.  A polygon is denoted on a FLNROD forest cover map by 
dashed lines, and typically ranges in size from 0.5 ha to 100 ha.  Each 
polygon has a reference number and forest cover code, which is 
referenced back to a database describing its attributes (e.g. F(Pl) 841-
20). 
 
You enter this data either manually or using a data entry file (CSV file) 
in the Polygon View tab. 
 
There are no limits to the number of polygons or area size that may be 
analyzed in Woodlot 4.   
 

2. Timber 
Yields 

The volume of timber is derived from either of two yield estimation 
models developed by FLNROD: 
 

 Variable Density Yield Projection (VDYP) 7 
 The Table Interpolation Program for Stand Yields (TIPSY) 4.3 

 
The volume predicted can be adjusted to match local conditions.  
Timber yields are calculated in the Polygon View tab. 
 
You may review the timber yield information (table and graphical) in 
the Polygon View tab by clicking the Yield Type or the mini-yield 
curve. 
 

3. Silviculture 
Systems 

You have two choices for silviculture systems: 
 Clearcut, which assumes 100% removal in the first pass. 
 Partial Cut, which assumes a portion is removed in the first 

pass, and you return for periodic removals of ingrowth over 
time. 

 
These are selected in the Polygon View tab. 
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4. Harvest 

Ages 
A preliminary harvest age is selected by Woodlot 4 for you based on 
the older of the culmination age (the age at which the trees are 
growing their fastest, on average), or the age at which the minimum 
harvest parameters are met.  Harvest ages that have been selected by 
Woodlot 4 are denoted with square brackets around them (e.g. [120] 
means that Woodlot selected a harvest age of 120 yrs since it has met 
both minimum harvest parameters and the culmination age.   
 
You may adjust this age yourself by typing over it.  
 

5. Harvest 
Parameters 

You can select the minimum harvest age, minimum volume per 
hectare, minimum diameter and minimum harvest age limits.  These 
establish the earliest possible age when a polygon may be harvested.  
These are set globally for your woodlot in the Project tab. 
 

6. Harvest 
Order 

You select the order in which to harvest your woodlot.  You can use 
features in the Calculation screen to adjust the harvest order and 
harvest priority. 
 

7. Constraints You can set spatial and temporal constraints to simulate the 
requirements for retaining a specified proportion of your woodlot in 
certain age or height characteristics; for example, to ensure that you 
retain enough area of old growth or winter range.  
 

8. Planning 
Period and 
Sustainable 
Harvest Rate 

The planning period is 250 years.  The sustainable harvest rate is 
calculated for a continuous harvest flow over this period (flat line or 
non-declining even flow) as required by Ministry of Forests, Lands and 
Natural Resource Operations’ policy.
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How Woodlot Calculates the Harvest Rate 
Once you have entered your forest polygons, calculated their timber yields, entered 
assumptions and constraints, and established a harvest order, an iterative calculation process is 
used by Woodlot to arrive at a sustainable harvest rate.  This iterative process simulates the 
operational harvest on a woodlot by placing priority on the harvest order you select in the first 
pass; on the second and subsequent passes, it chooses the most harvestable stand that meets 
your harvesting criteria. 

Woodlot starts with an initial harvest rate selected by the program (this value could be any 
number but Woodlot uses a set rate to streamline the process), then cycles through harvest 
calculations, adjusting it up or down until it reaches a sustainable harvest rate as noted below.  
If the harvest cannot be sustained, the rate is decreased; if it completes, the harvest rate is 
increased.  The amount of change is relative to the initial harvest calculation, and then is 
decreased or increased until a rate is met within 1 m³. 

 

 

 

 

 

 

 

 

 

 

 

Woodlot chooses a polygon to harvest in order of importance as follows: 

A. On the first rotation: 
1. Harvesting occurs in the order displayed in the Harvest Order. 
2. Polygons that are not ready to harvest (too young) will be put in a queue until 

they meet minimum harvest age criteria that you have set, then will be harvested 
at the first opportunity, and prior to other uncut polygons in the original sort order. 

 
B. On subsequent rotations: 

1. Partial cut polygons will always be re-harvested first as soon as they meet their 
re-entry requirements. 

2. Woodlot will re-harvest clearcut polygons as soon as they reach their desired 
harvest ages. 
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Summary of Basic Steps to Use Woodlot 
The following basic steps are used to calculate a harvest rate in Woodlot: 
 
1. Start up Woodlot 

Double clicking the icon or select from the Start/Programs selection pick.  The About 
screen will appear briefly, and the Project tab will appear. 

 
2. Start a new project or open an existing project file. 

To start a new project, click on File New.  Once you create a *.wlt file, you may reuse and 
update this file whenever you wish.  To use an existing project file, simply load up the file 
from the File menu, use File Open. 

 
3. Project Information 

Enter your basic project information and default forest information in the Project tab. 
 

4. Inventory Information 
Enter your timber inventory data in the Polygon View tab. 

 
5. Timber Management Assumptions 

Enter your timber management assumptions (silviculture system, planting, fertilization, 
genetic gain, etc.) in the Polygon View tab.  Set or adjust harvest ages in the Polygon 
View tab (once the yields have been compiled.) 

 
6. Timber Yields 

Calculate the timber yield information for the woodlot using the Calculate Yields menu item 
from any tab view. 

 
7. Summary information 

Check over your data in the Tabular View tab and adjust some variables if you wish. 
 
8. Harvest (AAC) Calculations 

Set your harvest order and timber management constraints in the Calculations tab.  Run 
your harvest calculations in the Calculations tab (click Calculate button.) 

 
9. Check your results. 

Use your judgment to determine if the answer seems logical and workable for your woodlot.  
As a rule of thumb, the harvest rate should be in the order of the (net area)*(average mai) 
for clearcut harvest operations. 
 
Test the harvest rate and sensitivity of assumptions by running a few alternate scenarios in 
the Calculations Screen. 

 
10. Report 

Generate a report and graphs from the Report menu.  Edit and print as required.  Any 
assumptions or explanations of how variables were selected must be included in the report 
to the district manager. 

 
11. Save your work and exit from Woodlot 

From the File menu, click Save and then Exit.  Don’t forget to save your project file! 
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Some Woodlot for Windows Tips and Tricks 
Every user has their preferred way to add, edit, and massage data for a Woodlot for Windows 
analysis.  Two suggested ways are as follows.  If you are not familiar with working with timber 
supply datasets, you may want to talk with a woodlot forester, tech, or GIS specialist. 

If you feel comfortable working with the data, the logical way to carry out a multi-polygon edit to 
information in Woodlot is to: 

1) export to CSV, 

2) load the CSV into Excel or software of your choice, 

3) edit CSV / data using logic-based selection abilities and/or copy functions, 

4) import edited info in CSV back to Woodlot using Import CSV - Update Poly function. 

VRI data files 

Please note that users should not edit or delete information from the VRI data file unless you 
know what you are doing, as this could corrupt the woodlot file and create unexpected results.  
Some less-obvious fields in the VRI file is used by VDYP7.  Users are cautioned to consult with 
the Ministry Inventory staff for more information on fields in the VRI file that affect VDYP7 
performance. 
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Appendix 7 Sample Woodlot report 

 

    Woodlot Licence Harvest Planning report 
 
 Date: April 24, 2019 - 11:27 AM 
 Woodlot File: wl44manual2019.wlt 
 Harvest Rate: 1,231 m³/year 
 Tenure: W2014 
 Company Name: WL4.1 Forest Management Ltd. 
 User Name: Harvey Kirk 
 Scenario Number: 1 
 Forest District: Nadina 
 
 Model Information 
 Woodlot Version: Release 4.4.0.0 (April 30, 2019) 
 VDYP Version: VDYP7Console 7.14b: 7, 14, 2, 61 
 TIPSY Version: BatchTIPSY: 4, 4, 2, 0 
 SIndex Version: Sindex: 1.52 
 
 Summary 
 Total Area: 633.0 ha 
 Net Area: 633.0 ha 
 THLB Area: 547.9 ha 
 LRSY: 1,835 m³/year 
 Existing Forest cMAI: 0.72 m³/ha/year 
 
 Woodlot Settings 
 Coast/Interior: Interior 
 Default VDYP Utilization: 12.5 - All Species 12.5 
 Default BEC: SBS 
 Minimum Harvest Age: 40 years 
 Minimum Harvest Diameter: 20 cm 
 Minimum Harvest Vol/ha: 150 m³/ha 
 Default TIPSY OAF1: 0.85 
 Default TIPSY OAF2: 0.95 
 P.C. Adjustment Factor: 0.80 
 P.C. Minimum Vol/Ha: 50 m³/ha 
 Planning Horizon: 250 years 
 Base Year: 2014 
 
 
 
Project Description: 
 
 

 
1.0 Introduction 
 
This section summarises information used to calculate a long term harvest rate on Woodlot Licence No. W2014.  The calculated 
harvest rate can be used to assist in determining the allowable annual cut (AAC).  It should be assessed in light of the assumptions 
used, social and economic considerations in determining the AAC. 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  136  Enfor Consultants Ltd.  

 
2.0 Summary 

 
a) Area Summary 
 
Description Area (ha) Area (ha) Volume (m³) Polygons (#) 
Total Area 633.0 151 
- Non Forest 0.0 0 
 - Non FMLB (Lake) 0.0 0 
 - Non FMLB (Swamp) 0.0 0 
 - Non FMLB (Open Range) 0.0 0 
 - Non FMLB (Cultivated) 0.0 0 
 - Non FMLB (VRI) 0.0 0 
= FMLB (forest management landbase) 633.0 65,071.0 151 
 - Reduction 0.0 0 
 - Future Roads 0.0 0 
= Net Area 633.0 65,071.0 151 
- Excluded (Constraints) 0.0 0 
= Contributing Forest 633.0 65,071.0 151 
 - Missing yield data 0.0 0 
 - Area Net down (constraint) 0.0 0 
 - Minimum Parameters Not met 48.9 2,981.0 20 
 - Silviculture System - Do Not Harvest 36.3 13 
= THLB (timber harvesting landbase) 547.9 62,090.0 118 
 
 

 
b) Polygon Data 
 

Polygon 
Gross 

Area (ha) 
Net Area 

(ha) 
Age (yrs) FC Label 

Vol/ha  
(m³/ha) 

Gross 
Volume 

(m³)

Net 
Volume 

(m³)
Ownership FC_RES Silviculture 

093E088 2622 [1.8829] [1.8829] 119 V SwPlAt 15.1 216.0 406.7 406.7 Crown - none - CC-NoChange
093E088 2620 [1.2662] [1.2662] 129 V PlSw 19.1 360.2 456.1 456.1 Crown - none - CC-NoChange
093E088 96809345 [5.7745] [5.7745] 129 V SwPlBl 14.6 87.7 506.4 506.4 Crown - none - CC-NoChange
093E088 2621 [4.064] [4.064] 89 V At(PlSw) 16.9 80.2 325.9 325.9 Crown - none - CC-NoChange
093E088 98799377 [2.9039] [2.9039] 129 Non Commercial 125.3 363.9 363.9 Crown - none - CC-Reforest
093E088 2617 [5.865] [5.865] 89 V PlSw(At) 16.6 216.2 1,268.0 1,268.0 Crown - none - CC-NoChange
093E088 2623 [1.367] [1.367] 119 V SwBl 10.8 17.7 24.2 24.2 Crown - none - CC-NoChange
093E088 2696 [4.3752] [4.3752] 88 Non Commercial 38.5 168.4 168.4 Crown - none - CC-Reforest
093E088 2678 [0.3579] [0.3579] 99 V Sw(AcPl) 17.7 215.5 77.1 77.1 Crown - none - CC-NoChange
093E088 2699 [6.6515] [6.6515] 99 V PlAtSw(Bl) 18.1 70.2 466.9 466.9 Crown - none - CC-NoChange
093E088 2634 [1.3355] [1.3355] 79 V SwAt 18.3 34.7 46.3 46.3 Crown - none - CC-NoChange
093E088 2673 [5.0553] [5.0553] 129 Non Commercial 105.0 530.8 530.8 Crown - none - CC-Reforest
093E088 2673 [2.4031] [2.4031] 129 Non Commercial 105.0 252.3 252.3 Crown WTR CC-Reforest
093E088 2657 [3.282] [3.282] 129 Non Commercial 162.7 534.0 534.0 Crown - none - CC-Reforest
093E088 2711 [2.444] [2.444] 23 V Pl 18.0 1.3 3.2 3.2 Crown - none - CC-NoChange
093E089 356 [5.3449] [5.3449] 155 V SwPl 14.0 338.1 1,807.1 1,807.1 Crown - none - CC-NoChange
093E088 15198806 [0.0042] [0.0042] 79 V AtAcSw(Pl) 15.7 25.4 0.1 0.1 Crown - none - CC-NoChange
093E088 1199394 [3.0301] [3.0301] 119 V SwPlBl 15.1 131.8 399.4 399.4 Crown - none - CC-NoChange
093E088 10438714 [3.7562] [3.7562] 159 Non Commercial 128.1 481.2 481.2 Crown - none - CC-Reforest
093E088 12098976 [12.7303] [12.7303] 129 Non Commercial 72.0 916.6 916.6 Crown - none - CC-Reforest
093E088 12259548 [3.9578] [3.9578] 94 V AtPlSw 15.3 135.5 536.3 536.3 Crown - none - CC-NoChange
093E088 6848733 [1.2371] [1.2371] 215 Non Commercial 4.0 4.9 4.9 Crown - none - CC-Reforest
093E088 4479476 [0.8726] [0.8726] n/a Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 11009130 [5.7707] [5.7707] 109 Non Commercial 62.6 361.2 361.2 Crown - none - CC-Reforest
093E088 11789038 [5.8795] [5.8795] 199 Non Commercial 91.1 535.6 535.6 Crown - none - CC-Reforest
093E088 3179368 [24.1627] [24.1627] 139 Non Commercial 136.9 3,307.9 3,307.9 Crown - none - CC-Reforest
093E088 2690 [10.032] [10.032] 119 Non Commercial 74.7 749.4 749.4 Crown - none - CC-Reforest
093E088 2627 [7.1783] [7.1783] 89 V PlBl(Sw) 17.1 398.8 2,862.7 2,862.7 Crown - none - CC-NoChange
093E088 2635 [1.9533] [1.9533] 79 V AtPlSw 16.7 114.5 223.7 223.7 Crown - none - CC-NoChange
093E088 2709 [5.6818] [5.6818] 129 V Pl 18.2 392.6 2,230.7 2,230.7 Crown - none - CC-NoChange
093E088 2709 [0.1527] [0.1527] 129 V Pl 18.2 392.6 60.0 60.0 Crown WTR CC-NoChange
093E088 2665 [1.2784] [1.2784] 119 V SwPl 15.1 141.4 180.8 180.8 Crown - none - CC-NoChange
093E088 2708 [0.0462] [0.0462] 24 V Pl 18.0 5.1 0.2 0.2 Crown - none - CC-NoChange
093E088 2708 [6.2285] [6.2285] 24 V Pl 18.0 5.1 31.8 31.8 Crown WTR CC-NoChange
093E088 2662 [1.4216] [1.4216] 129 Non Commercial 42.8 60.8 60.8 Crown - none - CC-Reforest
093E088 2662 [0.8829] [0.8829] 129 Non Commercial 42.8 37.8 37.8 Crown WTR CC-Reforest
093E088 9439593 [9.3209] [9.3209] 225 Non Commercial 24.4 227.4 227.4 Crown - none - CC-Reforest
093E088 4608394 [3.2187] [3.2187] 119 Non Commercial 16.6 53.4 53.4 Crown - none - CC-Reforest
093E088 5438586 [2.1997] [2.1997] 8 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 13389235 [14.8085] [14.8085] 97 Non Commercial 47.4 701.9 701.9 Crown - none - CC-Reforest
093E088 5679662 [1.0998] [1.0998] n/a Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 5979595 [4.1197] [4.1197] 79 V PlSw 16.3 240.4 990.4 990.4 Crown - none - CC-NoChange
093E088 2684 [5.5842] [5.5842] 125 Non Commercial 149.7 836.0 836.0 Crown - none - CC-Reforest
093E088 553 [0.0072] [0.0072] 98 V Pl 11.7 113.4 0.8 0.8 Crown - none - CC-NoChange
093E088 2644 [4.432] [4.432] 89 Non Commercial 142.6 632.0 632.0 Crown - none - CC-Reforest
093E088 2625 [2.4229] [2.4229] 89 V SwPl 16.4 212.2 514.1 514.1 Crown - none - CC-Reforest
093E088 2625 [0.06] [0.06] 89 V SwPl 16.4 212.2 12.7 12.7 Crown WTR CC-Reforest
093E088 2685 [2.1896] [2.1896] 119 Non Commercial 128.1 280.5 280.5 Crown - none - CC-Reforest
093E088 2666 [5.7709] [5.7709] 79 V AtAcSw(Pl) 15.7 25.3 146.0 146.0 Crown - none - CC-NoChange
093E088 2656 [3.7211] [3.7211] 119 Non Commercial 52.1 193.9 193.9 Crown - none - CC-Reforest
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093E088 2640 [6.3918] [6.3918] 89 V At 16.0 49.5 316.4 316.4 Crown - none - CC-NoChange
093E089 366 [0.6151] [0.6151] 155 Non Commercial 104.9 64.5 64.5 Crown - none - CC-Reforest
093E089 306 [43.454] [43.454] 95 V AtSw 16.9 162.2 7,048.2 7,048.2 Crown - none - CC-NoChange
093E088 1859438 [3.4716] [3.4716] 77 V BlSwPl 16.4 226.8 787.4 787.4 Crown - none - CC-NoChange
093E088 10189828 [4.8628] [4.8628] 149 Non Commercial 30.5 148.3 148.3 Crown - none - CC-Reforest
093E088 10189828 [0.6332] [0.6332] 149 Non Commercial 30.5 19.3 19.3 Crown WTR CC-Reforest
093E088 11139905 [0.0662] [0.0662] n/a V  0.0 0 0.0 0.0 Crown - none - CC-NoChange
093E088 11919964 [0.0051] [0.0051] 124 Non Commercial 146.4 0.7 0.7 Crown - none - CC-Reforest
093E088 8529279 [32.3704] [32.3704] 225 Non Commercial 21.6 699.2 699.2 Crown - none - CC-Reforest
093E088 2683 [4.3325] [4.3325] 119 Non Commercial 49.5 214.5 214.5 Crown - none - CC-Reforest
093E088 2683 [1.691] [1.691] 119 Non Commercial 49.5 83.7 83.7 Crown WTR CC-Reforest
093E088 2628 [6.2922] [6.2922] 169 V SwPl 13.8 273.7 1,722.2 1,722.2 Crown - none - CC-NoChange
093E088 2700 [5.8775] [5.8775] 149 V PlSw 18.9 300.9 1,768.5 1,768.5 Crown - none - CC-NoChange
093E088 2646 [4.0844] [4.0844] 89 Non Commercial 51.1 208.7 208.7 Crown - none - CC-Reforest
093E088 2712 [5.1523] [5.1523] 23 V Pl 18.0 1.3 6.7 6.7 Crown - none - CC-NoChange
093E088 517 [0.0001] [0.0001] 123 V PlAt 14.6 122.3 0.0 0.0 Crown - none - CC-NoChange
093E088 9159693 [7.3446] [7.3446] 89 V BlSwPl 15.3 251.5 1,847.2 1,847.2 Crown - none - CC-NoChange
093E088 8088734 [7.1264] [7.1264] 215 Non Commercial 0.0 0.0 0.0 Crown - none - CC-Reforest
093E088 6088571 [3.7094] [3.7094] 119 Non Commercial 62.7 232.6 232.6 Crown - none - CC-Reforest
093E088 14199159 [6.7744] [6.7744] n/a Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 7639634 [4.1376] [4.1376] 139 V PlSw(Bl) 20.3 249.3 1,031.5 1,031.5 Crown - none - CC-NoChange
093E088 3549576 [4.0244] [4.0244] 140 Non Commercial 96.3 387.5 387.5 Crown - none - CC-Reforest
093E088 5819689 [0.2633] [0.2633] n/a V  0.0 0 0.0 0.0 Crown - none - CC-NoChange
093E088 2676 [3.5523] [3.5523] 129 Non Commercial 107.2 380.8 380.8 Crown - none - CC-Reforest
093E088 2688 [22.0157] [22.0157] 156 Non Commercial 74.6 1,642.4 1,642.4 Crown - none - CC-Reforest
093E088 2655 [0.5237] [0.5237] 119 Non Commercial 0.0 0.0 0.0 Crown - none - CC-Reforest
093E089 365 [3.4589] [3.4589] 155 Non Commercial 87.3 302.0 302.0 Crown - none - CC-Reforest
093E088 11078818 [11.3428] [11.3428] 6 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 8989480 [3.4025] [3.4025] 8 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 14489107 [0.0341] [0.0341] n/a V  0.0 0 0.0 0.0 Crown - none - CC-NoChange
093E088 2692 [2.4776] [2.4776] 119 V AcSw 18.9 50.3 124.6 124.6 Crown - none - CC-NoChange
093E088 2706 [0.1472] [0.1472] 139 V SwPl 15.0 192.4 28.3 28.3 Crown - none - CC-NoChange
093E089 308 [3.2305] [3.2305] 75 V SwAt(Pl) 18.8 177.1 572.1 572.1 Crown - none - CC-NoChange
093E089 906 [0.3696] [0.3696] 36 V SwPl 16.0 0.0 0.0 0.0 Crown - none - CC-NoChange
093E089 355 [0.4057] [0.4057] 75 V AtPlSw 14.6 96.8 39.3 39.3 Crown - none - CC-NoChange
093E088 11188696 [2.1578] [2.1578] 119 V SwPl(At) 16.7 96.0 207.1 207.1 Crown - none - CC-NoChange
093E088 13039949 [0.8734] [0.8734] 130 Non Commercial 56.8 49.6 49.6 Crown - none - CC-Reforest
093E088 13039949 [0.2371] [0.2371] 130 Non Commercial 56.8 13.5 13.5 Crown WTR CC-Reforest
093E088 7709395 [2.5115] [2.5115] 159 V SwPl 14.6 321.0 806.2 806.2 Crown - none - CC-NoChange
093E088 7719537 [1.4377] [1.4377] 89 Non Commercial 77.5 111.4 111.4 Crown - none - CC-Reforest
093E088 9728858 [31.4372] [31.4372] 133 Non Commercial 63.1 1,983.7 1,983.7 Crown - none - CC-Reforest
093E088 9728858 [0.0225] [0.0225] 133 Non Commercial 63.1 1.4 1.4 Crown WTR CC-Reforest
093E088 3298859 [1.2676] [1.2676] n/a Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 3808454 [3.8192] [3.8192] 109 Non Commercial 45.5 173.8 173.8 Crown - none - CC-Reforest
093E088 3808454 [2.4139] [2.4139] 109 Non Commercial 45.5 109.8 109.8 Crown WTR CC-Reforest
093E088 5448510 [1.0959] [1.0959] 129 Non Commercial 67.9 74.4 74.4 Crown - none - CC-Reforest
093E088 6899711 [3.4893] [3.4893] 89 V BlSwPl 15.3 254.0 886.3 886.3 Crown - none - CC-NoChange
093E088 2643 [1.2462] [1.2462] 129 V PlSw 19.1 359.0 447.4 447.4 Crown - none - CC-NoChange
093E088 2631 [2.072] [2.072] 79 Non Commercial 93.4 193.5 193.5 Crown - none - CC-Reforest
093E088 2626 [2.9895] [2.9895] 129 Non Commercial 188.0 562.0 562.0 Crown - none - CC-Reforest
093E088 2702 [1.749] [1.749] 139 Non Commercial 71.0 124.2 124.2 Crown - none - CC-Reforest
093E088 2701 [3.7279] [3.7279] 139 Non Commercial 34.3 127.9 127.9 Crown - none - CC-Reforest
093E088 512 [0.0092] [0.0092] 138 V Pl 12.9 232.4 2.1 2.1 Crown - none - CC-NoChange
093E088 14099750 [0.0295] [0.0295] 103 V SPlAt 14.3 162.9 4.8 4.8 Crown - none - CC-NoChange
093E088 2710 [4.0985] [4.0985] 23 V Pl 18.0 1.3 5.3 5.3 Crown - none - CC-NoChange
093E088 2667 [1.8115] [1.8115] 39 Non Commercial 6.6 12.0 12.0 Crown - none - CC-Reforest
093E088 2653 [3.0303] [3.0303] 139 V SwPl 13.5 300.6 910.9 910.9 Crown - none - CC-NoChange
093E089 363 [3.9389] [3.9389] 75 V AtSwPl 16.6 238.1 937.9 937.9 Crown - none - CC-NoChange
093E088 9408748 [1.1722] [1.1722] 129 Non Commercial 44.8 52.5 52.5 Crown - none - CC-Reforest
093E088 9658692 [2.0824] [2.0824] 132 V SwPl 12.5 317.4 661.0 661.0 Crown - none - CC-NoChange
093E088 10480024 [0.0169] [0.0169] 158 Non Commercial 91.1 1.5 1.5 Crown - none - CC-Reforest
093E088 4828522 [2.3987] [2.3987] n/a Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 13969009 [11.1202] [11.1202] 97 Non Commercial 25.4 282.5 282.5 Crown - none - CC-Reforest
093E088 6529919 [0.0025] [0.0025] 39 V Pl(At) 19.0 22.6 0.1 0.1 Crown - none - CC-NoChange
093E088 2630 [9.4373] [9.4373] 129 Non Commercial 50.7 478.5 478.5 Crown - none - CC-Reforest
093E088 2672 [2.6321] [2.6321] 89 Non Commercial 80.2 211.1 211.1 Crown - none - CC-Reforest
093E088 2672 [0.048] [0.048] 89 Non Commercial 80.2 3.8 3.8 Crown WTR CC-Reforest
093E088 2629 [2.0417] [2.0417] 79 V PlSw 16.3 240.1 490.2 490.2 Crown - none - CC-NoChange
093E088 2705 [0.3528] [0.3528] 139 V SwPl 15.0 198.2 69.9 69.9 Crown - none - CC-NoChange
093E088 2654 [1.5823] [1.5823] 94 Non Commercial 79.9 126.4 126.4 Crown - none - CC-Reforest
093E089 46 [5.8632] [5.8632] 75 V AtPl 15.6 87.2 511.3 511.3 Crown - none - CC-NoChange
093E089 358 [0.2679] [0.2679] 155 V SwPl 14.0 338.1 90.6 90.6 Crown - none - CC-NoChange
093E088 14168835 [4.1393] [4.1393] 139 Non Commercial 57.5 238.0 238.0 Crown - none - CC-Reforest
093E088 11409830 [0.0067] [0.0067] 25 Non Commercial 0.2 0.0 0.0 Crown - none - CC-Reforest
093E088 11409830 [3.3607] [3.3607] 25 Non Commercial 0.2 0.7 0.7 Crown WTR CC-Reforest
093E088 11689915 [1.7923] [1.7923] 8 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 11689915 [0.0012] [0.0012] 8 Non Commercial 0.0 0.0 0.0 Crown WTR CC-NoChange
093E088 7969729 [1.5922] [1.5922] 8 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 7088701 [2.6405] [2.6405] 7 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 7878820 [2.1842] [2.1842] 119 Non Commercial 126.5 276.3 276.3 Crown - none - CC-Reforest
093E088 3078805 [9.5281] [9.5281] 89 V PlSw(Bl) 15.7 226.6 2,159.1 2,159.1 Crown - none - CC-NoChange
093E088 3078805 [0.0125] [0.0125] 89 V PlSw(Bl) 15.7 226.6 2.8 2.8 Crown WTR CC-NoChange
093E088 3028571 [5.8135] [5.8135] 129 Non Commercial 94.6 550.0 550.0 Crown - none - CC-Reforest
093E088 3028571 [6.3124] [6.3124] 129 Non Commercial 94.6 597.2 597.2 Crown WTR CC-Reforest
093E088 6048475 [6.1474] [6.1474] 119 Non Commercial 71.1 437.1 437.1 Crown - none - CC-Reforest
093E088 15279130 [1.3659] [1.3659] 159 Non Commercial 194.7 265.9 265.9 Crown - none - CC-Reforest
093E088 2671 [1.4011] [1.4011] 109 V SwPl(At) 16.6 303.7 425.5 425.5 Crown - none - CC-NoChange
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093E088 2671 [0.0608] [0.0608] 109 V SwPl(At) 16.6 303.7 18.5 18.5 Crown WTR CC-NoChange
093E088 97289759 [0.8926] [0.8926] 32 Non Commercial 0.0 0.0 0.0 Crown - none - CC-NoChange
093E088 2616 [3.4133] [3.4133] 89 V AtSwPl 16.0 203.0 692.9 692.9 Crown - none - CC-NoChange
093E088 2670 [0.894] [0.894] 89 V AtSw(Pl) 16.0 66.3 59.3 59.3 Crown - none - CC-NoChange
093E088 2670 [0.0112] [0.0112] 89 V AtSw(Pl) 16.0 66.3 0.7 0.7 Crown WTR CC-NoChange
093E088 2669 [5.3679] [5.3679] 129 V PlSw 17.4 188.1 1,009.7 1,009.7 Crown - none - CC-NoChange
093E088 2669 [3.959] [3.959] 129 V PlSw 17.4 188.1 744.7 744.7 Crown WTR CC-NoChange
093E088 99889349 [3.7298] [3.7298] 139 V SwPlBl 13.5 89.8 334.9 334.9 Crown - none - CC-NoChange
093E088 2624 [1.687] [1.687] 104 Non Commercial 76.1 128.4 128.4 Crown - none - CC-Reforest
093E088 2624 [1.0617] [1.0617] 104 Non Commercial 76.1 80.8 80.8 Crown WTR CC-Reforest
093E088 1638570 [5.8484] [5.8484] 89 V SwAtPl 15.6 33.6 196.5 196.5 Crown - none - CC-NoChange
093E088 1638570 [0.0597] [0.0597] 89 V SwAtPl 15.6 33.6 2.0 2.0 Crown WTR CC-NoChange
093E088 1669203 [29.9264] [29.9264] 131 Non Commercial 51.3 1,535.2 1,535.2 Crown - none - CC-Reforest
093E088 1669203 [2.0691] [2.0691] 131 Non Commercial 51.3 106.1 106.1 Crown WTR CC-Reforest
Total 632.9886 632.9886  102.8 65,071.0 65,071.0  

 
 
 
c) Priority 
 
Priority 
Partial Cut 
Closest To Harvest 

 
 
 
d) Harvest Order 
 
Order Polygon 

 
 
 
e) Constraints 
 
Constraint Polygon

 
 
 
f) Actual average Harvest with constraints and non harvest years over 250 year planning horizon: 
 
Item Gross Area (ha) Net Area (ha) Inc. Area (ha) Conifer (m³) Deciduous (m³) Total (m³) Average (m³/yr)
Ownership    
Crown 633.0 633.0 547.9 291,202 16,549 307,751 1,231.0
Total 633.0 633.0 547.9 291,202 16,549 307,751 1,231.0
FC_RES    
- none - 601.3 601.3 516.2 275,656 16,546 292,202 1,168.8
WTR 31.7 31.7 31.6 15,546 3 15,549 62.2
Total 633.0 633.0 547.9 291,202 16,549 307,751 1,231.0

 
 
 
g) Harvest Issues 
 
Years Issue 

 
 
 
h) Polygons not harvested 
 
Polygon Reason Area
093E088 96809345 Harvest Parameters not met 5.8 
093E088 2621 Harvest Parameters not met 4.1 
093E088 2623 Harvest Parameters not met 1.4 
093E088 2699 Harvest Parameters not met 6.7 
093E088 2634 Harvest Parameters not met 1.3 
093E088 15198806 Harvest Parameters not met 0.0 
093E088 4479476 NC without Reforest 0.9 
093E088 2635 Harvest Parameters not met 2.0 
093E088 5438586 NC without Reforest 2.2 
093E088 5679662 NC without Reforest 1.1 
093E088 553 Simulation completed prior To this polygon being harvested 0.0 
093E088 2666 Harvest Parameters not met 5.8 
093E088 2640 Harvest Parameters not met 6.4 
093E088 11139905 Harvest Parameters not met 0.1 
093E088 517 Harvest Parameters not met 0.0 
093E088 14199159 NC without Reforest 6.8 
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093E088 5819689 Harvest Parameters not met 0.3 
093E088 11078818 NC without Reforest 11.3 
093E088 8989480 NC without Reforest 3.4 
093E088 14489107 Harvest Parameters not met 0.0 
093E088 2692 Harvest Parameters not met 2.5 
093E088 11188696 Harvest Parameters not met 2.2 
093E088 3298859 NC without Reforest 1.3 
093E088 4828522 NC without Reforest 2.4 
093E088 11689915 NC without Reforest 1.8 
093E088 11689915 NC without Reforest 0.0 
093E088 7969729 NC without Reforest 1.6 
093E088 7088701 NC without Reforest 2.6 
093E088 97289759 NC without Reforest 0.9 
093E088 2670 Harvest Parameters not met 0.9 
093E088 2670 Harvest Parameters not met 0.0 
093E088 99889349 Harvest Parameters not met 3.7 
093E088 1638570 Harvest Parameters not met 5.8 
093E088 1638570 Harvest Parameters not met 0.1 
Total  85.1 

 
 
 
i) Polygons Comments 
 
Polygon Comment 

 
 

 
3.0 Conclusions 
 
Enter your conclusions to the user of this section on your observations about the upward or downward bias of the assumptions used 
to calculate the results. Open this report.txt file in the 'Note Pad' program or into Word for Windows to edit. 
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Appendix 8 VRI Variables Used in Woodlot 4 

The following Vegetation Resources Inventory (VRI) variables are imported by Woodlot 4.0 
(Woodlot 4.1 & 4.2)*  Refer also to Appendix for variables used in Woodlot 4 CSV files. 
 

VRI Short 
Name (used 

in Woodlot 4) 

VRI Attribute Name VRI Forestry Term VRI Description 

adjst_area adjusted_ind Adjusted indicator Indicates whether or not the polygon has been adjusted.
alpn_desig alpine_designation Alpine Designation The location of the land unit with respect to location and 

elevation. An interpretation is applied as to whether
atrib_date attribution_base_date Attribution Base Date The date that the information about this polygon is 

considered to be based on. It is currently populated,
av_lbl_ht avail_label_height Available Label Height The available height for a label, in meters for a 1:15,000 

map presentation. This is derived during the label
av_lbl_wd avail_label_width Available Label Width The available width for a label, in meters for a 1:15,000 

map presentation. This is derived during the label
bioms_bark bark_biomass_per_ha Bark Biomass this is the total whole stem biomass per hectare of all 

species based on a utilization of 4.0cm expressed as 
basal_area basal_area Basal Area at Reference Year Basal area is the total cross sectional area, at breast 

height, of all living trees visible to the photo interpreter
bclcs_lv_1 bclcs_level_1 British Columbia Land Cover 

Classification Scheme Level 1
The first level of the BC land cover classification scheme 
classifies the presence or absence of vegetation

bclcs_lv_2 bclcs_level_2 British Columbia Land Cover 
Classification Scheme Level 2 

The second level of the BC land cover classification 
scheme classifies the polygon as to the land cover 

bclcs_lv_3 bclcs_level_3 British Columbia Land Cover 
Classification Scheme Level 3

The location of the polygon relative to elevation and 
drainage, and is described as either alpine, wetland or

bclcs_lv_4 bclcs_level_4 British Columbia Land Cover 
Classification Scheme Level 4

Classifies the vegetation types and non-vegetated cover 
types (as described by the presence of distinct

bclcs_lv_5 bclcs_level_5 British Columbia Land Cover 
Classification Scheme Level 5

Classifies the vegetation density classes and Non-
Vegetated categories.

bec_phse bec_phase Biogeoclimatic Phase A code indicating the polygon's biogeoclimatic phase.
bec_szone bec_subzone Biogeoclimatic Subzone A code indicating the polygon's biogeoclimatic sub zone.
bec_var bec_variant Biogeoclimatic Variant A code indicating the polygon's biogeoclimatic variant.
bec_zone bec_zone_code Biogeoclimatic Zone The Biogeoclimatic Zone(s) that fall within the forest 

cover polygon. A Biogeoclimatic Zone is a large 
bioms_brch branch_biomass_per_ha Branch Biomass this is the total branch biomass per hectare of all species 

based on a utilization of 4.0cm expressed as 
bryoid_pct bryoid_cover_pct Bryoid Cover Percentage The percent cover of Bryoids: includes bryophytes 

(mosses, net liverworts, hornworts) and non-crustose
c_i_code coast_interior_cd Coast Interior Code A code indicating that the stand is located in the Coast or 

Interior Region of the Province. The Coast 
compartmnt compartment Inventory Compartment Inventory Compartments are a geographic subdivision of 

an Inventory Region, usually defining a watershed
comp_let compartment_letter Inventory Compartment Letter The Compartment Letter(s) that fall within the forest 

cover polygon. Compartment Letter is a geographic
cr_closure crown_closure Crown Closure Tree crown closure is the percentage of ground area 

covered by the vertically projected crowns of the tree
cc_class crown_closure_class_cd Crown Closure Class Code The class code for the ground area covered by the 

vertically projected crowns of the tree cover for each
age_dta_cd data_source_age_cd Data Source Age Code The source of data used for the interpretation of age and 

the derivation of the year of origin. 
b_a_dta_cd data_source_basal_area_cd Data Source Basal Area Code The source of data used for the interpretation of the 

basal area.
ht_data_cd data_source_height_cd Data Source Height Code The source of data used for the interpretation height.
stem_ha_cd data_src_vri_live_stem_ha_cd Data Source VRI Live Stem 

per Hectare Code 
The source of the data that was used for the 
interpretation of the vri net live stems per hectare, or 
stand 

dbh_limit dbh_limit Diameter Breast Height Limit A code indicating the minimum diameter breast height 
(DBH) for measuring trees (i.e. stems) in the field

dvltot_125 dead_stand_volume_125 Dead Stand Volume for 12.5 
cm

This is the total net dead volume per hectare of all 
species determined by percent basal area of the tree

dvltot_175 dead_stand_volume_175 Dead Stand Volume for 17.5 
cm 

This is the total net dead volume per hectare of all 
species determined by percent basal area of the tree 

dvltot_225 dead_stand_volume_225 Dead Stand Volume for 22.5 
cm

This is the total net dead volume per hectare of all 
species determined by percent basal area of the tree

dvlsp1_125 dead_vol_per_ha_spp1_125 Leading Species Dead Volume 
per Hectare at 12.5 cm

This is the net dead volume per hectare of the leading 
species determined by percent basal area of the tree

dvlsp1_175 dead_vol_per_ha_spp1_175 Leading Species Dead Volume 
per Hectare at 17.5 cm 

This is the net dead volume per hectare of the leading 
species determined by percent basal area of the tree 

dvlsp1_225 dead_vol_per_ha_spp1_225 Leading Species Dead Volume This is the net dead volume per hectare of the leading 
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per Hectare at 22.5 cm species determined by percent basal area of the tree
dvlsp2_125 dead_vol_per_ha_spp2_125 Second Species Dead Volume 

per Hectare at 12.5 cm
This is the net dead volume per hectare of the second 
species determined by percent basal area of the tree

dvlsp2_175 dead_vol_per_ha_spp2_175 Second Species Dead Volume 
per Hectare at 17.5 cm

This is the net dead volume per hectare of the second 
species determined by percent basal area of the tree

dvlsp2_225 dead_vol_per_ha_spp2_225 Second Species Dead Volume 
per Hectare at 22.5 cm

This is the net dead volume per hectare of the second 
species determined by percent basal area of the tree

dvlsp3_125 dead_vol_per_ha_spp3_125 Third Species Dead Volume 
per Hectare at 12.5 cm

This is the net dead volume per hectare of the third 
species determined by percent basal area of the tree

dvlsp3_175 dead_vol_per_ha_spp3_175 Third Species Dead Volume 
per Hectare at 17.5 cm

This is the net dead volume per hectare of the third 
species determined by percent basal area of the tree

dvlsp3_225 dead_vol_per_ha_spp3_225 Third Species Dead Volume 
per Hectare at 22.5 cm

This is the net dead volume per hectare of the third 
species determined by percent basal area of the tree

dvlsp4_125 dead_vol_per_ha_spp4_125 Fourth Species Dead Volume 
per Hectare at 12.5 cm

This is the net dead volume per hectare of the fourth 
species determined by percent basal area of the tree

dvlsp4_175 dead_vol_per_ha_spp4_175 Fourth Species Dead Volume 
per Hectare at 17.5 cm 

This is the net dead volume per hectare of the fourth 
species determined by percent basal area of the tree 

dvlsp4_225 dead_vol_per_ha_spp4_225 Fourth Species Dead Volume 
per Hectare at 22.5 cm

This is the net dead volume per hectare of the fourth 
species determined by percent basal area of the tree

dvlsp5_125 dead_vol_per_ha_spp5_125 Fifth Species Dead Volume per 
Hectare at 12.5 cm

This is the net dead volume per hectare of the fifth 
species determined by percent basal area of the tree

dvlsp5_175 dead_vol_per_ha_spp5_175 Fifth Species Dead Volume per 
Hectare at 17.5 cm 

This is the net dead volume per hectare of the fifth 
species determined by percent basal area of the tree 

dvlsp5_225 dead_vol_per_ha_spp5_225 Fifth Species Dead Volume per 
Hectare at 22.5 cm

This is the net dead volume per hectare of the fifth 
species determined by percent basal area of the tree

dvlsp6_125 dead_vol_per_ha_spp6_125 Sixth Species Dead Volume 
per Hectare at 12.5 cm

This is the net dead volume per hectare of the sixth 
species determined by percent basal area of the tree

dvlsp6_175 dead_vol_per_ha_spp6_175 Sixth Species Dead Volume 
per Hectare at 17.5 cm 

This is the net dead volume per hectare of the sixth 
species determined by percent basal area of the tree 

dvlsp6_225 dead_vol_per_ha_spp6_225 Sixth Species Dead Volume 
per Hectare at 22.5 cm

This is the net dead volume per hectare of the sixth 
species determined by percent basal area of the tree

n_log_date earliest_nonlogging_dist_date Earliest non logging 
disturbance date

Represents the polygons earliest non-logging 
disturbance date.

n_log_dist earliest_nonlogging_dist_type Earliest non logging 
disturbance type

Represents the polygons earliest non-logging 
disturbance type.

eco_src_cd ecosys_class_data_src_cd Ecosystem Class Data Source 
Code

The source of the data used in the interpretation of the 
ecological attributes (Surface expression, modifying

cov_pct_2 est_coverage_pct_2 Land Cover Component 
Percentage 2

The amount the polygon occupied by the second most 
dominate Land Cover Component. The sub-division

cov_pct_3 est_coverage_pct_3 Land Cover Component 
Percentage 3

The amount the polygon occupied by the third most 
dominate Land Cover Component. The sub-division of

cov_pct_1 est_coverage_pct_1 Land Cover Component 
Percentage 1

The amount the polygon occupied by the predominate 
Land Cover Component. The sub-division of a

est_si est_site_index Estimated Site Index Estimated site index is an interpreter estimated site index 
for tree layers with a leading species age less 

si_data_cd est_site_index_source_cd Estimates site index source 
code

Describes the process used to determine the estimated 
site index prediction. for tree layers with a leading

est_si_spc est_site_index_species_cd Estimated Site Index Species 
Code

Estimated site index species is the tree species from 
which the site index for the polygon has been 

feat_skey feature_class_skey Feature Class Skey Unique identifier for a feature class. 
feature_id feature_id Feature Identity Provincially unique identifier for an instance of a spatial 

feature
fiz_cd fiz_cd Forest Inventory Zone The Forest Inventory Zone(s) (FIZ) that fall within the 

forest cover polygon. FIZ zones were developed to
bioms_fol folliage_biomass_per_ha Foliage Biomass this is the total bark biomass per hectare of all species 

based on a utilization of 4.0cm expressed as 
rank_cd for_cover_rank_cd Forest Cover Rank Code - 

Rank or Importance of Layer
A numeric designation of the relative importance of the 
layer component in the stand as determined by the

fmlb for_mgmt_land_base_ind Forest Management Land 
Base 

An indicator placing the polygon in the Forest 
management Land Base. This is the equivalent to THLB 
(as a

ftg_ind free_to_grow_ind Free to grow indicator Indicates whether or not the polygon represents a Free 
To Grow opening, a point where the basic 

full_label full_label Full Label The full Vegetation Map label. It contains the polygon id, 
opening number, species composition, projected

geometry geometry Geometry A spatial polygon feature used to store the map 
component of the Vegetation Cover area. 

harv_date harvest_date Harvest Date The date in which the polygon was last harvested.
herb_cover herb_cover_pattern Herb Cover Pattern Herb cover pattern is a code that describes the spatial 

distribution of the herbaceous species within the
herb_pct herb_cover_pct Herb Cover Percentage Herb cover percent is the percentage of ground area 

covered by herbaceous cover visible to the photo 
herb_type herb_cover_type Herb Cover Type This set of attributes describes the portion of herb cover 

that is no obscured by the vertical projection of the
input_date input_date Input Date The date the forest cover information was entered into 

the Provincial Data Base. 
intrp_date interpretation_date Interpretation Date The date on which the polygon estimates were photo 
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interpreted.
interp_cd interpreted_data_src_cd Interpreted Data Source Code The source of the data that contributed to the 

determination of the classification description. All values
interpretr interpreter Interpreter The name of the person who provided the estimates for 

the data associated with each polygon. 
inv_region inventory_region Inventory Region Inventory Regions are an administrative and planning 

level boundary used to subdivide the Province into 88
inv_std_cd inventory_standard_cd Inventory Standard Code Code indicating under which inventory standard the data 

was collected. Values are: "V:" for Vegetation 
lbl_ctr_x label_centre_x Label Centre X The x co-ordinate of the suggested centre of the label. 
lbl_ctr_y label_centre_y Label Centre Y The y co-ordinate of the suggested centre of the label.
lbl_ht label_height Label Height The height of the full label for a 1:15,000 map 

presentation in meters. It is calculated as 30 times the
lbl_width label_width Label Width The width of the full label for a 1:15,000 map 

presentation in meters. It is calculated as 18 times the
land_cd_2 land_cover_class_cd_2 Land Cover Class Code 2 The Land Cover component Code_2 describes the 

second most dominate land cover type by percent area
land_cd_3 land_cover_class_cd_3 Land Cover Class Code 3 The Land Cover component Code_3 describes the third 

most dominate land cover type by percent area 
land_cd_1 land_cover_class_cd_1 Land Cover Class Code 1 The Land Cover component Code_1 describes the first 

most dominate land cover type by percent area
layer_id layer_id Layer Identity The unique business identification of a layer, or 

horizontal stratum, in a stand. Each layer is normally
lbl_opn_no line_1_opening_number Label Line 1 Opening Number Indicates combination of layers and tree class to be 

summarized for volume. 
lbl_opn_cd line_1_opening_symbol_cd Label Line 1 Opening Symbol 

Code
The opening symbol code is represented as on of the 
following characters: 'x', '

lbl_polyid line_2_polygon_id Label Line 2 Polygon Identity The polygon ID for which this is the label. This is followed 
by /L (a multi-layered stand) or /S (a separate

lbl_specis line_3_tree_species Label Line 3 Tree Species A list of major species (minor species), ordered by 
percentage. The species symbols are F (Douglas fir), C

lbl_cls_in line_4_classes_indexes Label Line 4 Index Classes Line 4 is made up of 4 numerical characters followed by 
a hyphen, the site index, a slash, and the 

lbl_vegcov line_5_vegetation_cover Label Line 5 Vegetation Cover A listing of the non-vegetated descriptors or the non tree 
vegetative cover types ordered from most to least

lbl_hist line_6_site_prep_history Label Line 6 Site Preparation 
History

The site preparation history represented by a list of 
abbreviations for the techniques used, followed by the

lbl_distur line_7_activity_hist_symbol Label Line 7 Activity History 
Symbol

A symbol representing what techniques were used in the 
labelled area. The symbol is a circle with 0 to 4

lbl_his_sy line_7A_stand_tending_history Label Line 7A Stand Tending 
History

Symbols representing tending history 

lbl_tend line_7B_disturbance_history Label Line 7B Disturbance 
History 

The disturbance history described as a list of 
abbreviations for the techniques along with the years 
each

lbl_plant line_8_planting_history Label Line 8 Planting History The planting (or regeneration) history described as a list 
of years during which artificial plantings was 

lvltot_125 live_stand_volume_125 Live Stand Volume for 12.5cm This is the total net live volume per hectare of all species 
determined by percent basal area of the tree layer

lvltot_175 live_stand_volume_175 Live Stand Volume for 17.5cm This is the total net live volume per hectare of all species 
determined by percent basal area of the tree layer

lvltot_225 live_stand_volume_225 Live Stand Volume for 22.5cm This is the total net live volume per hectare of all species 
determined by percent basal area of the tree layer

lvlsp1_125 live_vol_per_ha_spp1_125 Leading Species Live Volume 
per Hectare at 12.5 cm

This is the net live volume per hectare of the leading 
species determined by percent basal area of the tree

lvlsp1_175 live_vol_per_ha_spp1_175 Leading Species Live Volume 
per Hectare at 17.5 cm

This is the net live volume per hectare of the leading 
species determined by percent basal area of the tree

lvlsp1_225 live_vol_per_ha_spp1_225 Leading Species Live Volume 
per Hectare at 22.5 cm

This is the net live volume per hectare of the leading 
species determined by percent basal area of the tree

lvlsp2_125 live_vol_per_ha_spp2_125 Second Species Live Volume 
per Hectare at 12.5 cm 

This is the net live volume per hectare of the second 
species determined by percent basal area of the tree 

lvlsp2_175 live_vol_per_ha_spp2_175 Second Species Live Volume 
per Hectare at 17.5 cm

This is the net live volume per hectare of the second 
species determined by percent basal area of the tree

lvlsp2_225 live_vol_per_ha_spp2_225 Second Species Live Volume 
per Hectare at 22.5 cm

This is the net live volume per hectare of the second 
species determined by percent basal area of the tree

lvlsp3_125 live_vol_per_ha_spp3_125 Third Species Live Volume per 
Hectare at 12.5 cm 

This is the net live volume per hectare of the third 
species determined by percent basal area of the tree 

lvlsp3_175 live_vol_per_ha_spp3_175 Third Species Live Volume per 
Hectare at 17.5 cm

This is the net live volume per hectare of the third 
species determined by percent basal area of the tree

lvlsp3_225 live_vol_per_ha_spp3_225 Third Species Live Volume per 
Hectare at 22.5 cm

This is the net live volume per hectare of the third 
species determined by percent basal area of the tree

lvlsp4_125 live_vol_per_ha_spp4_125 Fourth Species Live Volume 
per Hectare at 12.5 cm 

This is the net live volume per hectare of the fourth 
species determined by percent basal area of the tree 

lvlsp4_175 live_vol_per_ha_spp4_175 Fourth Species Live Volume 
per Hectare at 17.5 cm

This is the net live volume per hectare of the fourth 
species determined by percent basal area of the tree

lvlsp4_225 live_vol_per_ha_spp4_225 Fourth Species Live Volume 
per Hectare at 22.5 cm

This is the net live volume per hectare of the fourth 
species determined by percent basal area of the tree

lvlsp5_125 live_vol_per_ha_spp5_125 Fifth Species Live Volume per This is the net live volume per hectare of the fifth species 
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Hectare at 12.5 cm determined by percent basal area of the tree layer
lvlsp5_175 live_vol_per_ha_spp5_175 Fifth Species Live Volume per 

Hectare at 17.5 cm
This is the net live volume per hectare of the fifth species 
determined by percent basal area of the tree layer

lvlsp5_225 live_vol_per_ha_spp5_225 Fifth Species Live Volume per 
Hectare at 22.5 cm

This is the net live volume per hectare of the fifth species 
determined by percent basal area of the tree layer

lvlsp6_125 live_vol_per_ha_spp6_125 Sixth Species Live Volume per 
Hectare at 12.5 cm

This is the net live volume per hectare of the sixth 
species determined by percent basal area of the tree

lvlsp6_175 live_vol_per_ha_spp6_175 Sixth Species Live Volume per 
Hectare at 17.5 cm

This is the net live volume per hectare of the sixth 
species determined by percent basal area of the tree

lvlsp6_225 live_vol_per_ha_spp6_225 Sixth Species Live Volume per 
Hectare at 22.5 cm

This is the net live volume per hectare of the sixth 
species determined by percent basal area of the tree

map_id map_id Forest Cover Map Number Identifies the Vegetation Cover Map corresponding to the 
VRI file

mod_proces modifying_process Modifying Process A natural mechanism of weathering, erosion and soil 
material deposition that result in the modification of

nfor_desc non_forest_descriptor Non Forest Descriptor A classification code indicating that the forest cover type 
is not currently forested, but is capable of 

np_code non_productive_cd Non Productive Code A unique numeric code that references the classes or 
type of non-productive areas or land that is incapable

np_desc non_productive_descriptor_cd Non Productive Descriptor 
Code

A unique code that references the classes or type of non-
productive areas. This is a FIP classification 

nveg_cov_1 non_veg_cover_pattern_1 Non Vegetation Cover Pattern 
One 

Non-vegetated cover pattern_1 describes the spatial 
distribution of the predominate non-vegetated cover 

nveg_cov_2 non_veg_cover_pattern_2 Non Vegetation Cover Pattern 
2

Non-vegetated cover pattern_2 describes the spatial 
distribution of the predominate non-vegetated cover

nveg_cov_3 non_veg_cover_pattern_3 Non Vegetation Cover Pattern 
3

Non-vegetated cover pattern_3 describes the spatial 
distribution of the predominate non-vegetated cover

nveg_pct_1 non_veg_cover_pct_1 Non Vegetation Cover 
Percentage One 

The area the predominate non-vegetated portion covers 
expressed as a percentage of the entire polygons 

nveg_pct_2 non_veg_cover_pct_2 Non Vegetation Cover 
Percentage Two

The area the second most prevalent non-vegetated 
portion covers expressed as a percentage of the entire

nveg_pct_3 non_veg_cover_pct_3 Non Vegetation Cover 
Percentage 3

The area the third most prevalent non-vegetated portion 
covers expressed as a percentage of the entire

nveg_typ_1 non_veg_cover_type_1 Non Vegetation Cover Type 
One

Non-vegetated cover type_1 is the designation for the 
predominate observable non-vegetated land cover

nveg_typ_2 non_veg_cover_type_2 Non Vegetation Cover Type 
Two

Non-vegetated cover type_2 is the designation for the 
second most prevalent observable non-vegetated

nveg_typ_3 non_veg_cover_type_3 Non Vegetation Cover Type 
Three

Non-vegetated cover type_3 is the designation for the 
third most prevalent observable non-vegetated land

objectid objectid Object Identity
open_id open_id Opening Indicator System generated value uniquely identifying the opening 

in the FLNROD Forest Tenures Administration
open_ind opening_ind Opening Indicator Indicates whether or not the polygon represents a 

silviculture opening
open_num opening_number Opening Number A unique number assigned to each opening in the forest 

caused by a disturbance (e.g. fire, logging, etc.) for
open_src opening_source Opening Source Defines whether the opening came from ISIS or MLSIS 

This field is not populated in the current data model.
orgunit_cd org_unit_code Organisation Unit Code Forest District Codes, 3-character description 
orgunit_no org_unit_no Organisation Unit Number Number from Org Unit code table representing the 

organization that collected the data. 
poly_area polygon_area Forest Polygon Area The area of a polygon; usually derived from geographic 

information system processing software. The total 
poly_id polygon_id Forest Cover Polygon Number The polygon number is a reference number ( non-unique) 

assigned to each Vegetated or Non-Vegetated
printable printable_ind Printable "Y" means print the label. "N" means do not print the 

label.
proj_age_1 proj_age_1 Projected Age for Leading 

Species
Projected age for leading species 

proj_age_2 proj_age_2 Projected Age for Second 
Species

Projected age for secondary species 

p_age_cas1 proj_age_class_cd_1 Projected age class code 
stand age 1

The age class projected to the current year for species 1. 

p_age_cas2 proj_age_class_cd_2 Projected age class code 
stand age 2

The age class projected to the current year for species 1. 

proj_ht_1 proj_height_1 Projected Height for Leading 
Species

Projected height for leading species 

proj_ht_2 proj_height_2 Projected Height for Second 
Species

projected height for second species 

p_ht_cas1 proj_height_class_cd_1 Projected height class code 1 The height class projected to the current year for species 
1.

p_ht_cas2 proj_height_class_cd_2 Projected height class code 2 The height class projected to the current year for species 
2.

project_id project Project The business assigned name of the project. The name 
typically reflects a Timber Supply Area, an initiating 

proj_date projected_date Projected Date The date to which time dependent stand information is 
projected. Used to determine the date to which time
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q_diam_125 quad_diam_125 Quadratic Diamter at 12.5 cm The quadratic mean stand diameter (breast height), at 
the projection date, based on the 12.5 cm utilization 

q_diam_175 quad_diam_175 Quadratic Diamter at 17.5 cm The quadratic mean stand diameter (breast height), at 
the projection date, based on the 17.5 cm utilization

q_diam_225 quad_diam_225 Quadratic Diamter at 22.5 cm The quadratic mean stand diameter (breast height), at 
the projection date, based on the 22.5 cm utilization

ref_date reference_date Reference Date The date of the source data on which the interpretation is 
based. Known as the 'Reference Year' in the VIF 

ref_yr_id reference_year Reference Year The year of the source data on which the interpretation is 
based. Known as the 'Reference Year' in the VIF

shrb_patt shrub_cover_pattern Shrub Cover Pattern Shrub cover pattern is a code that describes the spatial 
distribution of the shrubs within the polygon. Shrub

shrb_cc shrub_crown_closure Shrub Crown Closure Shrub crown closure is the percentage of ground area 
covered by the vertically projected crowns of the 

shrb_ht shrub_height Shrub Height The average height of the shrubs contained in the 
polygon as interpreted from medium scale photography.

site_index site_index Site Index Site index is an estimate of site productivity for tree 
growth (height in metres at breast height age of 50

site_meso site_position_meso Site Position Meso A code denoting the relative position of the sampling site 
within a catchment area with the intent to be 

sm_label small_label Small Label The two-line (or format 3) version of the label. This label 
contains, at most, 2 lines build from the line 1 and

soil_mst_2 soil_moisture_regime_2 Soil Moisture Regime 2 The average amount of soil water annually available for 
evapotranspiration by vascular plants averaged

soil_mst_3 soil_moisture_regime_3 Soil Moisture Regime 3 The average amount of soil water annually available for 
evapotranspiration by vascular plants averaged

soil_mst_1 soil_moisture_regime_1 Soil Moisture Regime 1 The average amount of soil water annually available for 
evapotranspiration by vascular plants averaged over

soil_nutr soil_nutrient_regime Soil Nutrient Regime A code to denote, on a relative scale, the available 
nutrient supply for plant growth. The soil's nutrient

cruise_no special_cruise_number Special Cruise Number The numeric code of the Public Sustained Yield Unit(s) 
(PSYU) that fall within the forest cover polygon.

cruise_cd special_cruise_number_cd Special Cruise Number Code The numbers of the Public Sustained Yield Unit (PSYU) 
Block(s) that fall within the forest cover polygon.

spec_cd_1 species_cd_1 Species Composition Code - 
Leading Species 

A code describing the leading commercial species or 
brush species in the layer. The species with the 

spec_cd_2 species_cd_2 Species Composition Code - 
Second Species

A code describing the leading commercial species or 
brush species in the layer. The species with the

spec_cd_3 species_cd_3 Species Composition Code - 
Third Species

A code describing the leading commercial species or 
brush species in the layer. The species with the

spec_cd_4 species_cd_4 Species Composition Code - 
Fourth Species 

A code describing the leading commercial species or 
brush species in the layer. The species with the 

spec_cd_5 species_cd_5 Species Composition Code - 
Fifth Species

A code describing the leading commercial species or 
brush species in the layer. The species with the

spec_cd_6 species_cd_6 Species Composition Code - 
Sixth Species

A code describing the leading commercial species or 
brush species in the layer. The species with the

spec_pct_1 species_pct_1 Leading Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

spec_pct_2 species_pct_2 Second Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

spec_pct_3 species_pct_3 Third Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

spec_pct_4 species_pct_4 Fourth Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

spec_pct_5 species_pct_5 Fifth Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

spec_pct_6 species_pct_6 Sixth Species Percentage Percentages of the layer that each tree species occupies. 
For older stands, tree species percentage is 

dead_pct stand_percentage_dead Stand Percentage Dead Represents the percent of the stand that has had an 
epidemic loss.

surf_exp surface_expression Surface Expression The form of surficial material apparent on the medium 
scale photography. A simplified attribution is used

tree_patrn tree_cover_pattern Tree Cover Pattern A numeric code that identifies the spatial distribution of 
the tree layer in the polygon. Examples include 

vert_compl vertical_complexity Vertical Complexity The subjective classification that describes the form of 
each tree layer as indicated by the relative 

dead_stems vri_dead_stems_per_ha VRI Dead Stems per Hectare The number of standing dead trees visible to the photo 
interpreter in the dominant, codominant and high

live_stems vri_live_stems_per_ha VRI Live Stems per Hectare The average number of living trees visible to the photo 
interpreter in the dominant, co-dominant and high 

bioms_ws whole_stem_biomass_per_ha Whole Stem Biomass this is the total whole stem biomass per hectare of all 
species on a utilization of 4.0cm expressed as

 
*Source: 
Ministry of Forests, Lands and Natural Resource Operations “VRI Relational Data Dictionary (version 4.0) – Draft”  
http://www.for.gov.bc.ca/hts/vridata/standards/datadictionary/vegcomp_poly_rank1_data_dictionary_draft4.0.pdf Downloaded from 
Internet July 10, 2014 
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Appendix 9 Woodlot for Windows What’s New ? 

Woodlot 4.1 Updates 

Woodlot for Windows (Woodlot) is timber supply software used on woodlots and small woodlands in BC.  
An update was completed in March 2014, to Version 4.1, to provide efficiency enhancements.  No changes were made to 
methodology or modelling.  Updates are listed below. 

 
Tabular View 

 Cells now editable – read only (VRI and results) cells are greyed 

 Added Friendly variable names for Column Headers 

 Column Filter (sets which columns are displayed in the tabular view) 
o Select columns and assigned a name 
o Sort columns (by dragging the tables column headers) will be saved in the filter 
o Column filters are saved to the WLT file 
o WLT remembers which Column Filter is being used. 
o Columns widths will be saved in the registry (not by filter). 
o Filters can be exported and imported to transfer between WLT files. 

 Row Filter (sets which rows are displayed in the tabular view) 
o Add logic rules to filter out certain rows 
o Row Filters are saved in the WLT 
o WLT remembers which Row Filter is being used. 
o Filters can be exported and imported to transfer between WLT files. 

 Display options added to header and saved in WLT file 
 
Shape File Importing 

 Imports *.shp file 
o Imports VRI and Woodlot columns 
o Import multiple files over top if needed 
o Import graphics file into a lot file 

 New dialogue created to guide shp file importing and choose best importing settings 

 Import more VRI columns. 
o live and dead volumes 12.5 / 17.5 
o live and dead volumes by species 12.5 / 17.5 
o dead percent 
o dead stems 
o BEC subzone and variant 
o Full label - stored in VRI database now 
o Added LBL_CTR_X, LBL_CTR_Y 
o Added NVEG_TYP_3, NVEG_PCT_3 

 
Polygon View 

 Added Comments section 

 Added Calculate Site Index feature to yield curve sections 

 Updated VRI data screen with more columns of pertinent data 

 Interface enhancements 
o Expanded interface workspace 
o Save last screen position 
o Classifiers box widened (interface box) 
o Arrow key down function completed 
o Enhancements made for speed of use 
o Expanded BEC items to report full BEC and subzone if available 

 Reports additional TIPSY and VDYP error messages not available before 

 Rename Polygon – added label override dialogue to update polygon name on maps 

 Added map label to small map 

 Added View items to toolbar 
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General Efficiency Enhancements and Fixes 
o Performance improved especially for large files 
o Rewrote sorting routine 
o Canadian date format fix 
o Scientific notation issue with mapsheets 
o Blank species issue on VDYP and TIPSY fixed 
o DWB OAF fix 
o OAF2 now is defaulted to 0.95 instead of DWB.  DWB in TIPSY uses VDYP routines that may not be accurate for 

managed stands (per M. DiLucca) 
o Blank constraints crashed program fix 

 
Map View 

 Added small legend to map 

 Started proof of concept on theming for future - 2 incomplete draft sample themes (Easter Egg only), for Enfor testing 
only (not a deliverable under version 4.1) 

 
Menus 
 

File Menu 

 Added Import Shp (replaces Import VRI) 

 Re-ordered features 
 
Edit Menu 

 Added Select None – to deselect map polygons 

 Added convert dead stands to NC 
 
View Menu 

 Moved screen specific View menu items to applicable screens 

 Added Hide non-FMLB 
 
About Screen 

 Updated versioning and dates 
 
Information Message Log (activated from lower left corner) 

 Added more information to help with issue identification 
 
Project Screen 

 Added new Unique Row/ID/Row # to help with importing shp files 
 
Calculations and Yield Curves 

 No changes 
 
Reports 

 No changes 
 
Installation 

 New installation MSI 

 Files are forward compatible but not backward compatible to older versions of Woodlot 4. 
 
More Information 
 
For more information on the updated software, please contact: 

 Peter Graff, BC Ministry of Forests, Lands and Resource Operations, or  

 Tom Bradley, Federation of BC Woodlot Associations. 

 Download from: https://www.for.gov.bc.ca/hth/timber-tenures/woodlots/woodlot-for-windows.htm 
 
For user support, please contact Mike Bandstra, Smithers, Federation contractor. 
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Woodlot 4.2 Updates 

Woodlot for Windows (Woodlot) is a timber supply software program used to calculate harvest rates on Woodlot Licences in 
BC’s Woodlot Licence Program.  Woodlot version 4.2 (released April 2016) replaces Woodlot 4.1 (July 2014) and includes the 
following updates: 

 

 

 

 

 

 

 

 

 

Age Class Distribution Graph 

 Age class distribution graphing updated.  When you create a woodlot report and check the Age Class Graph, you can 
now choose between two age class distribution graph templates: 

o Age Class Distribution – Over Time.  Displays the 
age class distribution of the forest in 50 year 
increments from current date.  Current year = 0. 

o Age Class Distribution – Current Age.  Displays 
the age class distribution of the forest as of today.  
Current year = 0. 

 Age class distribution graphs now saved with your woodlot 
(.wlt) file. 

Classifier Field names 

 Upper case and lower case classifier names can now be 
used for easier use by GIS users.  Also corrected the 
feature to delete classifiers. 

GIS New File Import 

 Implemented a new GIS inventory shapefile import feature and updated the File menu.  Use File Import (shp) to import 
any shapefile and follow the prompts. 

Tabular View 

 Corrected the Tabular view to improve the column click-and-drag rearranging 
feature. 

 Tabular view Polygon status icon(s) will update to “?” if changes are made in the 
Tabular view that require you to update Yields for polygons. 

Minimum Volume Limits on Polygons 

 Partial cut - Woodlot now defaults to require a minimum 50 m3/ha before re-entry on partial cut stands.  This will avoid 
a user accidentally specifying a re-entry % where the resulting re-entry volume is unreasonably low (e.g. 2 m3/ha).  
Woodlot will defer harvesting a polygon until the new minimum is reached.  Users can over-ride the default by entering 
their own minimum re-entry volume. 

 Clearcut – Min volume to harvest set to 0m3/ha to avoid crashing (if accidentally set to blank). 



Woodlot for Windows 4.4 User Guide  

 
April 30, 2019  148  Enfor Consultants Ltd.  

Highlighting Fields in Column Filters 

 A new checkbox was added to the Column Filter screen in Tabular View to “Show Empty Columns”; empty columns of 
data will be displayed as red in the list with the checkbox on.  By default, the checkbox is off and empty columns are 
not displayed in the Column Filters window. 

 (Note that columns displayed on the left side of the Column Filter screen are from your data file; columns listed on the 
right are those displayed in the Tabular View in Woodlot.) 

Latest TIPSY and VDYP7 

 TIPSY - updated to BatchTIPSY 4.3.2.  TIPSY has minor updates by the Ministry for the TIPSY database, Sindex, and 
Plotsy. 

 VDYP7 - updated to VDYP7 Console 7.10.3.41.  This is the latest released version of VDYP7 available from the 
Ministry.  (Please note that the Ministry is continuing to work on VDYP7 with an update ETA later in 2016.) 

 Yields in Woodlot are not expected to change significantly as a result of these updates. 

Other Updates 

Several minor updates have been provided to improve usability in Woodlot 4.2, such as: 

 Map labels - method and positioning improved, added to small map. 

 Woodlot filename and AAC now sent to Plotsy header for graphs. 

 

Implementation - Where to Get Woodlot 4.2 

Woodlot 4.2 is available as a self-installing download from the Ministry Woodlot for Windows AAC Program webpage, located at 
https://www.for.gov.bc.ca/hth/timber-tenures/woodlots/woodlot-for-windows.htm 

 

Ministry staff are asked to install Woodlot 4.2 to their local computer.  For Ministry staff, the Woodlot Citrix server is phased out.  
Please contact your IT department if any questions. 

 

Questions 

If any questions, please contact the Ministry of Forests, Lands 
and Natural Resource Operations, Geoff Klassen 
Geoffrey.Klassen@gov.bc.ca or Emma Neill 
Emma.Neill@gov.bc.ca. 

Thank you for using Woodlot for Windows, we wish you 
success. 
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Woodlot 4.3 Updates 

 

Introduction 

Woodlot for Windows (Woodlot) is timber supply software used to 
calculate harvest rates on Woodlot Licences in BC’s Woodlot Licence 
Program.   

Woodlot version 4.3 (released July 2018) replaced Woodlot 4.2 (Apr 
2016) and included the following updates. 

 

 

 

Update Growth and Yield Models 

Growth and Yield models were update in Woodlot 4.3.  This includes: 

1. Adding the latest version of TIPSY v4.4.2.0  This 
enhancement provides the following additional functionality: 

 Allows blending between Conifer and Deciduous. 

 New BTP file includes all VRI species codes. 

 Updated TIPSY Species list in Woodlot. 

 Updated VRI species list with Latin and defined common species. 

 Removed DWB feature from Woodlot as no longer part of TIPSY. 

 TIPSY 4.3 was giving overly optimistic results for White Spruce (Sw) and was corrected in TIPSY 4.4.  The correction in 
TIPSY may result in future AAC calculation reductions. 

2. Adding the latest official version of VDYP (VDYP7Console 7.14b; 7, 14, 2, 61.) 

3. Updating Woodlot, VDYP and TIPSY to use Sindex version 1.52. 

 

 

 

Column Filter Search Feature 

In the Tabular View, Woodlot 4.3 included a new filter in the 
Column Filter.  The Column Filter now has a new “Contains” 
filter in the selection window.   

The columns list will filter to display only column names that 
contain the exact text in the “Contains” text box. 
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LRSY and MAI 

LRSY is the theoretical Long-Run Sustained Yield, resulting in the maximum theoretical harvest level.  In Woodlot, LRSY is based 
on: 

1. Culmination MAI of the future stand x Net Woodlot area. 

2. Net Woodlot area = Net area x THLB inclusion factor (if any). 

3. Net Woodlot Area is also netted down to remove area listed in the “EXCLUDE from Woodlot” area constraints. 

The LRSY is now displayed at on the Calculate AAC panel, located in the 
lower left corner of the Calculations tab.   

You can set the harvest rate to use the LRSY annual rate by simply 
clicking on the underlined LRSY text. 

The existing forest culmination MAI has been added to the Calculate 
AAC panel. 

The Annual Increment has been added to the Advanced Annual harvest report. 

 

Project Default Parameters (for BEC, Coast/Interior, Base Year) 

Woodlot users now need to set the project default parameters before importing files, editing forest or calculating yields.  Woodlot 
no longer always defaults to the Coast.  Instead, Woodlot now defaults to a blank region until you set your region.   

To do this, create your woodlot default parameters in the Project tab.  To save your default parameters, from the main “File” menu, 
select “Save Project Defaults”.  (Project defaults will be saved to the registry file.)   

 

Graphs 

Several new Graphs were added to the Reports menu.  Click on the Reports 
menu to select one of the many graphs now available in Woodlot.   

Note that the graphing utility “Plotsy” is used in Woodlot.  Plotsy is developed as 
part of the TIPSY suite of tools for the Ministry.  Refer also to the Plotsy Help 
menu for a user guide if you wish to undertake more complex graphing. 

 

Report 

The Woodlot report was updated to include a section to display polygon 
comments.   

The header was updated to include project defaults. 

 

Zoom selected polygons 

A new zoom feature was added to the map. 
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Other Improvements 

 Fixed column width issues on the Tabular screen. 

 Adjusted Classifiers so they are not case sensitive. 

 Improved column formatting in the Woodlot report. 

 Force the BEC to refresh on each forest polygon if the global BEC is changed in the Project screen. 

 Fixed the Area on FMLB Summary, section 2a in the Woodlot report. 

 Fixed Volume per Hectare (VPH) rounding. 

 

Implementation - Where to Get Woodlot 4.3 

Woodlot 4.3 is available as a self-installing download from the Ministry Woodlot for Windows AAC Program webpage, located at:  
https://www2.gov.bc.ca/gov/content/industry/forestry/forest-tenures/timber-harvesting-rights/woodlot-licence/allowable-annual-cut-
calculator-tool 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ministry staff are asked to install Woodlot 4.3 to their local computer.  For Ministry staff, the Woodlot Citrix server will be phased 
out.  Please contact your IT department if any questions. 

Questions 

If any questions, please contact the Ministry of Forests, Lands and Natural Resource Operations, Geoff Klassen 
Geoffrey.Klassen@gov.bc.ca or Emma Neill Emma.Neill@gov.bc.ca. 

Thank you for using Woodlot for Windows, we wish you success. 
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Woodlot 4.4 Updates 

 

Introduction 

Woodlot for Windows (Woodlot) is timber supply software used to 
calculate harvest rates on Woodlot Licences in BC’s Woodlot 
Licence Program.   

Woodlot version 4.4 (released April 2019) replaces   Woodlot 4.3 
(July 2018) and includes the following updates. 

 

 

 

 

 

 

 

 

Harvest Schedule Reports 

More summary reports have been added to the Harvest Schedule heading on the Calculation screen.  The reports are based on 
your current run and match the same reporting sections in the Woodlot Report.  You will need to run a harvest calculation to 
update the Harvest Schedule reports displayed.  Summary reports include: 

1. Info – summary information on the Woodlot. 

2. Area – woodlot area summary. 

3. Input – input data used. 

4. Priority – the harvest priority you set in the 
Calculations screen. 

5. Order – lists the polygons you force an 
order on. 

6. Constraints – describes constraints used 
in your run. 

7. Volume – volume summary. 

8. Issues – summary of harvest issues by 
year and reason. 

9. Skipped – listing of polygons not 
harvested and the reason why. 

 

Shapefile Import Updates 

When importing polygons from a shapefile, Classifiers can now be used to uniquely identify sub polygons.  Please see the updated 
User Guide for more details. 

Shapefiles with duplicate stand identifiers (usually splinters from geo processing) will now be combined into a single resultant, in 
previous versions each duplicate shape replaced the previous one.
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Map Toolbar 

The Woodlot map buttons have been moved to a separate toolbar in the Map View (above the map) and new features added or 
enhanced. 

 
New Map toolbar features and enhancements include: 

4. Zoom Selected – clicking this button scales the map so the selected polygons (shown in hatching) fill the map window. 

5. Zoom Current – clicking this button scales the map so the current (last selected) polygon fills the map window. 

6. Labels – more map label options have been added including: 

f. Automatic – Same as Woodlot 4.3. 

g. Existing Forest – A label generated from the Existing Forest settings. 

h. Future Forest – A label generated from the Future Forest settings. 

i. VRI – The multi-line label imported from VRI. 

j. Override – A custom label than can be specified on the Rename polygon screen. 

Note:  as a reminder, to select a polygon in the map view screen, hover your mouse and right-click the polygon.  The 
polygon will display as a red hatch and can be zoomed to.   

The Automatic label order is as follows: 

4. Uses the “Map Label Override” from Rename Polygon (if it is not blank).  To create the map label override, in the 
Polygon tab click the polygon number to activate the Rename Polygon dialogue box.  In the Map Label Override box 
type in your new label.  This will display on the small map and on the main map.  Otherwise,  

 

 

 

 

 

 

 

 

 

5. Use the VRI “Full Label” if there is VRI 
data for this polygon.  The Full Label column can be viewed in the Tabular 
View.  Otherwise,  

6. Uses the label based on the Existing Forest “FC Label” from the Woodlot 
Report b) Polygon Data table. 
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Stands with more than one Resultant 

A stand can be made up of more than one resultant.  The stand is linked to the 
existing forest, harvesting and future forest information.  The resultants contain the 
Classifiers and are linked back to the stand.   

The polygon list now shows the resultants as follows: 

 A resultant that is only part of the stand will be displayed with a half-gray 
bar, and 

 There will either be a sub polygon identifier or a “(piece #)” suffix. 

The small map has also been updated to display the other resultants linked to this 
stand in gray. 

Please refer to the User Guide for a description of this feature.   

 

Right clicking on a polygon will bring up a context menu that allows you to unlink a 
resultant from the stand so it can be edited independently. 

 

 

 

Other Improvements 

Some other improvements in Woodlot 4.4 include: 

 Woodlot now validates the project settings before allowing you 
to view a yield curve.  A warning message will be displayed if 
you have not set your region or other project default 
parameters in the Project tab.  If you get this warning, please 
return to the Project tab to check and update your project 
defaults. 

 Stand age checking has been updated.  Entering a stand age of 0 or lower was setting established year to 0 not relative 
to the current year like 2019.  For example, now if the age is less than -20 then the stand age will be set to 0 and an “n/a” 
will be displayed.  If the year is 2019 and -20 is entered the established year would be 2039 (2019 - -20), but if -21 was 
entered the stand age would be set to 0 and n/a would be displayed. 

 The Disable PC feature now also forces the harvest priorities to treat PC as CC. 
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Implementation - Where to Get Woodlot 4.4 

Woodlot 4.4 is available as a self-installing download from the Ministry Woodlot for Windows AAC Program webpage, located at:  
https://www2.gov.bc.ca/gov/content/industry/forestry/forest-tenures/timber-harvesting-rights/woodlot-licence/allowable-annual-cut-
calculator-tool 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ministry staff are asked to install Woodlot 4.4 to their local computer.  Please contact your IT department if any questions. 

Questions 

If any questions, please contact the Ministry of Forests, Lands, Natural Resource Operations and Rural Development, 
Emma Neill Emma.Neill@gov.bc.ca. 

Thank you for using Woodlot for Windows, we wish you success. 

 

 

 


